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11  Introduction 
 

Thank you very much for purchasing our product.  

Olympus Dictation Management System is a Dictation/Transcription system that supports assignments of 

various sizes, from individual users to multiple users. 

 

Olympus Dictation Management System Outline 

Licenses 

Devices Connectable to Dictation Module 

Supported File Formats 

Dictation Module Capabilities 

 

Check the details about the system requirements. 

 

http://olads.olympus-imaging.com/RSS/odms_requirements/index.htm
http://olads.olympus-imaging.com/RSS/odms_requirements/index.htm
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1.1 Olympus Dictation Management System Outline 
 

Olympus Dictation Management System R6 (ODMS R6) is a Dictation/Transcription system that supports 

assignments of various sizes, from individual users to multiple users. It can be used to capture audio data 

highly compressed with an Olympus digital voice recorder (hereinafter referred to as "the recorder"), and 

allows for real-time playback, editing, and insertion of index information. 

 

ODMS R6 and the recorder support the playback of DSS, an international standard for audio recording, 

Microsoft-promoted WMA, and MP3. 

With peripheral devices connected, such as a DirectRec or foot switch, it provides a variety of additional 

functions, including audio streaming recording and remote control playback. 

 

The Workgroup System supports Citrix XenApp/XenDesktop, and some other virtual environments. 

It also supports Terminal Services provided by Windows Server products, allowing this product to be used via 

the Terminal Services Client Virtual Driver. 

 

 
DSS support in Citrix XenApp/XenDesktop environment 

DSS supports “Published Desktop” and “Published Application” from 
the Citrix XenApp, but doesn’t support “Web Interface.” 

 

In addition to DSSPlayer Pro R5 features, ODMS R6 offers the following: 

x Enhanced compatibility with Nuance Dragon NaturallySpeaking 

x Enhanced direct recording functions using Olympus Directrec devices 

x Citrix XenDesktop and VMware View support 

x Addition of new applications specialized for downloading dictation files 

x System management functions that enable sharing with DSSPlayer Pro R5 

 

System Configurations of ODMS R6 

Modules and Tools 
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1.1.1 System Configurations of ODMS R6 

 

ODMS R6 offers two system variants with different administrative configurations: 

x Standalone System 
With this configuration, an individual user enters the supplied license ID (for a single license), installs 

the software on the system, and configures applications. User profiles (various settings for each user) 

are located on local PCs and managed by individual users. 

 

 
 

 

 
About silent installation with a multi-license ID 
Silent installation with a multi-license ID can standardize the settings of 
multiple users. For information on how to achieve this, refer to 
"Installation Guide." 
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x Workgroup System 
With this system configuration, an Administrator installs and configures the modules for each user, 

and centrally manages and operates them under a multi-license. 

This system requires License Manager to be installed to manage the multi-license.  

User profiles are placed in a shared folder on the file server. The Administrator uses the System 

Configuration Program to assist each user in the configurations and installations. A significant part of 

the user profile settings can be configured and locked with the System Configuration Program. 

 

 

 

 
About Workgroup System installation 
For information on how to set up the Workgroup System, refer to 
"Installation Guide." 
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1.1.2 Modules and Tools 
 

x Dictation Module 
This is an application for an Author. It is mainly used to download a dictation file recorded with a DVR 

(Digital Voice Recorder), or to record a dictation file directly onto a PC. It can automatically send a 

downloaded or directly recorded dictation file via email or FTP. It also has the ability to automatically 

receive a transcribed document file and manage it with a link to the corresponding dictation File. 

 

x Transcription Module 
This is an application for a Transcriptionist. The application can notify the Transcriptionist of the arrival 

of a new dictation file and switch to a smaller window at the onset for easy transcription. It 

automatically receives and captures dictation files, via email or FTP, for transcribing. It has document 

management capability that can automatically start your word processor software before transcribing, 

and can manage a document with a link to the corresponding dictation file. This document 

management function can automatically start your word processor software when the Transcription 

Module is started up, and can manage a document with a link to the corresponding dictation file. In 

addition, if the original dictation file was received via email or FTP, the application can automatically 

send a document file to a specified destination immediately after the transcription has been 

completed. 

 

x File Downloader 
File Downloader is an application that enables easy downloading of a DVR-recorded dictation file to a 

PC. The application starts up automatically whenever the PC is started, and resides in the system tray. 

When connection to a DVR is detected, the application automatically downloads its files and stores 

them in a specified location. The application offers a simple, efficient method of download for users. 

File Downloader can be installed on a computer that has the Dictation Module and/or the Transcription 

Module installed, so that any one of the applications can be used as required by the job at hand. 

 

x System Configuration Program (Workgroup System Only) 
System Configuration Program is an application for administrators, which is used when structuring a 

Workgroup System. It facilitates the installation and updates of applications for end users (Dictation 

Module and Transcription Module), manages application settings for end users (Author and 

Transcriptionist), and updates firmware management. 

Installing the System Configuration Program will also install the Device Customization Program. 

The Device Customization Program can customize, import, and export device settings. 

 

x License Manager (Workgroup System Only) 
This application is used to manage licenses. It manages the licenses and accounts of Dictation Module 

and Transcription Module in a Workgroup system. 

The application can change each license account by grouping multiple single licenses into one 

multi-license. 
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x Client Virtual Driver (Workgroup system only) 
Client Virtual Driver is installed on a client PC when running the Dictation Module and/or Transcription 

module under a Citrix XenApp and Windows Server Terminal Services. It supports communication 

between the client PC and server, which makes it possible to use all of the Dictation Module and 

Transcription Module functions under a virtual environment. 

A Citrix XenApp driver and Windows Terminal Services driver are provided for each virtual 

environment platform. 

 

x Repository Service (Workgroup system only) 
For a Workgroup System, you need to create a data store, called a “repository”. 

A repository is a location on a network where shared files are placed in order to share data between 

System Configuration Program and the Dictation Module and/or Transcription Module. Various types 

of Dictation Module/Transcription Module setting information (user profiles), the Dictation 

Module/Transcription Module and other applications, and firmware update programs are stored in the 

repository. 
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1.2 Licenses 
 
A license is required to use ODMS R6. ODMS R6 is provided under the following types of licenses: 

x Single License 
This is a license ID, issued with a recorder or foot switch, which allows single licensing of ODMS. A 

recorder license allows the Dictation Module to be installed on a PC. A foot switch license allows only 

Transcription Module to be installed on a PC. 

x Multi-license 
This is a combined license ID that groups several single licenses into one license ID for both Dictation 

Module and Transcription Module. A multi-license is managed as a floating license. 

x Decoder License 
This is a license for redistribution of DSS and DSS Pro decoders. A redistribution contract allows 

acquisition of a decoder license ID and redistribution of the decoder. To enable the decoder, the license 

ID needs to be registered when installing it. 

 

 
About the multi-license key 
With License Manager, only the multi-license key can be registered. The 
single license and other licenses are not available. 

 

Purchasing an Initial or Additional Multi-license 

In exchange for a corresponding number of single licenses, a multi-license is available free of charge.  

Please contact our support team for details. 

 

Other License Keys 

ODMS R6 license keys vary depending on the system.  

Use the appropriate license for each system.  

Please contact our support team for information on re-issuance or replacement of a license. 

The following table shows the licensing scheme for ODMS R6 system configurations. 

 

System Name Required License License Server 

Standalone System Dictation Module single license 
Transcription Module single license 

Not required 

 Multi-license*1  
Workgroup System Dictation Module multi-license 

Transcription Module multi-license 
License Manager 

 
*1 : If not using centralized user management with System Configuration Program and sharing data 

only, a Standalone system can be configured under a multi-license. 
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1.3 Devices Connectable to Dictation Module 
 
Dictation Module supports the following Olympus devices: 

 
Device Types Models 

DVR 
(Mass storage recorder) 

x DS-7000 
x DS-5000/5000iD 
x DS-3500 
x DS-3400 
x DS-2800 
x DS-2500 
x DS-2400 
--- 
A model other than those listed above is treated as a 
[General Device], so only dictation file downloading 
and some option settings are supported. 

DirectRec 
(Digital microphone for 
dictation) 

x DR-2300 
x DR-2200 
x DR-2100 
x DR-2000 
x DR-1200 
x DR-1000 

Foot switch x RS-31 
x RS-28 
x RS-27 

Hand controller x RS-32 
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1.4 Supported File Formats 
 

Dictation Files 

The following table lists the file types supported by each function: 

 

Functions Supported File Types (Extensions) 

Playback, import,  
and export 

Non-encrypted file: DS2, DSS, WAV, WMA, and MP3 
Encrypted file: DS2, $DSS, $WAV, $WMA, and $MP3 
In addition to the above, if a codec that works with Microsoft® DirectShow® 
Filter has been installed, an imported file can be played, but we do not 
guarantee proper operations. 

New recording and 
editing 

Non-encrypted file: DS2, DSS, WAV, and WMA 
Encrypted file: DS2, $DSS, $WAV, and $WMA 
When making a new recording, the recorded file is encrypted if the folder where 
the file was saved with exit recording status is an encrypted folder. 

File splitting/joining Non-encrypted file: DS2, DSS, WAV, and WMA 
Encrypted file: DS2, $DSS, $WAV, and $WMA 

 

Document Files 

The following file formats can be handled under the default setup. 

x Text file (XXX.TXT) 

x Rich Text Format file (XXX.RTF) 

x Microsoft Word format (XXX.DOC/.DOCX) 

To use another file format, registration is required. 

 

 
Configure document type as an optional setting by selecting Folder Design and then 
Attributes.  
=> [Folder Design]-Attributes 
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1.5 Dictation Module Capabilities 
 

Dictation Module provides the following functions: 

 

x Ideas can be verbally transferred to the recorder and later downloaded to your PC. You can then 
organize and save the files (Direct Recording Window). 

 

x Reports and meeting summaries can be created (Playback Control Window). 
 

x Memos and ideas can be organized (Direct Recording Window). 
 

x Recordings can be automatically downloaded from the recorder and backed up on the PC (Backup). 
 

x Recordings can be automatically distributed to Transcriptionists or other users via email or FTP. 
 

x Prepared documents can be automatically retrieved via email or FTP, and linked to the corresponding 
recording. 

 

x Downloaded dictation files can be automatically converted to text using voice recognition. 
 

x Settings on your recorder can be managed and modified. 
 

x Recordings can be played and edited on your PC. 
 

x With the recorder connected to the PC, Direct Recording can be performed on the PC. 

 

x Voice recognition can be performed simultaneously during DirectRecording, and voice recognition 
results can be displayed and checked in real time 

 

x Voice recognition results can be corrected with the location of the corrections fed back to the voice 
recognition engine. 
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22  Fundamentals of Olympus Dictation Management 
System 

 
This chapter describes the fundamentals of Olympus Dictation Management System (ODMS R6) 

 
Dictation File Name and Author ID 

Process and Status 

How Folders Work 

Worktypes and Option Items 

Direct Recording 

Ownership Attribute 

Local Mode and Network Mode 

Clean 

Voice Comments 

Storage Mode and Composite Mode 

Backing Up 

Debugging Option 
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2.1 Dictation File Name and Author ID 
 

Dictation File Name 

A dictation file created with an Olympus recorder is automatically named with eight characters in the format 

below. A file directly recorded with the Dictation Module also follows the same naming process. 

Author ID (leading four characters) + Job No. (a four-digit number beginning with 1) 

 

Author ID 

The Author ID, which is registered as part of the file name, represents the Author of the file. The Dictation 

Module can register up to ten Author IDs and transfer them to the recorder. If no Author ID is registered, the 

logon ID for Windows is used as the Author ID. 

 

Job No. 

The Job No. is automatically set when a recording is made. Each time a dictation file is created, a new 

number is provided for it. The Job No., which is an essential number for file management, cannot be reset by 

the user. Removing batteries from or formatting the memory card of the recorder will not reset the Job No. 
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2.2 Process and Status 
 
This section provides the workflow from the creation of a dictation file up to final transcription and deletion 

of the dictation file in an ODMS R6 Standalone system and Workgroup System. 

 

Sending a dictation file via email or FTP to an external site where it is transcribed: 

 

 

 

Sharing a dictation file on the network and transcribing it: 
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ODMS R6 manages a workflow with the following combinations of processes and statuses: 

: Supported : Not supported 

 

 
Process Status 

Dictation File 
Editing 

Transcription / 
Voice Recognition 

Location of Dictation File 

[1] Record Running -   
  Pending   In the Recording Folder 
  Finished    
[2] Send Waiting   In the Outbox 
  Failed    
  Finished   In the Sent Items 
[3] Transcription Running  -  
  Pending    
  Finished    
[4] Voice 

Recognition 
Waiting   In the Voice Recognition queue 

  Running  -  
  Pending    
  Finished    
[5] Delete Finished   The Recycle Box is cleared 

automatically after a certain 
length of time (Settings can 
also be configured for 
immediate deletion upon 
completion.) 

 

Operations after Deletion 

By default, transcribed dictation files are automatically moved to the Recycle Box and then deleted 

permanently after a certain length of time. Files in the Recycle Box can be restored with the Restore function, 

but once deleted permanently, they cannot be recovered. Make sure that the configuration matches your 

requirements. 
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2.3 How Folders Work 
 
In the Dictation Module, dictation files and document files are managed in the Dictation Tray and the 

Document Tray, respectively. Files are managed in different folders based on which process is being 

performed. Properties for each folder can be configured and centrally managed by an Administrator. 

 

There are two types of these folders: shortcut folders and virtual folders. 

Shortcut folders appear to be actual folders, but are really only shortcuts pointing to specified folder paths. 

The shortcuts are automatically created and managed by the Dictation Module. Users cannot modify them. 

The user can rename a shortcut folder, but doing so just renames the folder. The actual path cannot be 

changed. When a shortcut folder represents a path in a local PC, it is displayed as  (normal color). If the 

path is over the network, it is displayed as  (green). 

 

A virtual folder does not represent a physical path. It serves as a container of multiple shortcuts and is called 

a "Tray". 

 

 

 
As for folders managed with Transcription Module, their current settings can be verified 
and modified in the Folder Design dialog box. 

 

Folder Descriptions 

Folder Functions 

 

2.3.1 Folder Descriptions 
 
This section describes how each folder works. 

 
Folder Name Description 

Dictation Tray This is a virtual folder, provided as a root folder, for managing dictation 
files. It serves as a management container and has no specific function.

 Download Tray 

Folder A - Folder 
G 

These are shortcut folders used to download and manage dictation files 
from the recorder. 
Dictation files in the recorder folders are downloaded into the 
corresponding Download folders. Each Download folder can be configured 
for a selected path. 

 Custom Folder 

Subfolder 

This user-defined shortcut folder manages dictation files. It is used as a 
download destination folder and has functions similar to the Download 
folders. Different custom folders can be specified for each Author ID. 

 Recording Folder  This shortcut folder manages dictation files in the process of recording 
(Pending status). In Pending status, the Recording tray path can only be 
a local PC folder. A network folder cannot be specified. 
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 Outbox 

( E-mail, FTP) 

This shortcut folder is the first destination for dictation files sent via email 
or FTP. 
Outbox consists of two separately managed shortcut folders: E-mail and 
FTP. Items distributed to Outbox are automatically sent when the 
automatic sending option is selected. With the manual sending option 
selected, they remain in this folder until the user manually sends them. 
The sending method is configured with the option settings for email and 
FTP. 
If items in the E-mail or FTP folder are deleted, their sending operations 
are canceled. Since these are not virtual items, their deletion affects the 
actual dictation files. 

 Sent Items This shortcut folder manages items sent via email and FTP. 
When a dictation file has been sent, the item is then moved into the Sent 
Items folder. Process/Status of the transferred Dictation File changes to 
Sending/Finished. Sent Items has a Clean attribute that can be 
configured to specify time elapsed after sending. This makes it possible to 
clean up old files. Sent Items is a shortcut folder. Files in this folder can be 
moved to other folders. 

 Finished This shortcut folder manages dictation files that have completed 
transcription and voice recognition. This folder is provided with a Clean 
attribute to save disk space. A dictation file for which a transcription has 
been complete is deleted after a prescribed length of time elapses. It 
cleans up old dictation files after a specified length of time. The automatic 
collection option for a workflow is configured to automatically move the 
dictation files that have completed transcription or voice recognition into 
this folder. 

 Backup This shortcut folder backs up dictation files when downloaded or 
imported. If a downloaded or imported Dictation File is lost, it can be 
restored from the Backup folder. Since repeated backups can consume 
too much disk space, the folder has the Clean attribute for deletion of old 
backup files. 

 Recycle Box This shortcut folder temporarily stores old or unnecessary dictation files. 
Its function is similar to that of the Recycle Bin in Windows. Deleting 
dictation files in this folder eliminates them permanently and makes their 
restoration impossible. With the General option for a workflow, you can 
select whether the dictation files in folders are deleted permanently or 
moved to the Recycle Box folder. Dictation files in the Recycle Box folder 
can be restored to their original location with the Restore command. This 
folder has the Clean attribute so that old dictation files can be 
automatically deleted. 

 Adaptation Data 
 
 

This is a short cut folder for managing information about revisions done 
by the user to text after voice recognition. 
If information about revisions to text is included in document files 
received by e-mail or FTP, it is saved in this folder and used to update the 
dictionary file for voice recognition. The folder is set up with purge 
attributes so it is possible to delete information about revisions in old 
text. 

Document Tray This virtual folder manages document files. Registered document files can 
be managed in the My Documents folder with their extensions registered 
using an attribute of the folder. Since this is a virtual folder, document 
files cannot be dropped into it. 

  My Documents This shortcut folder manages document files. A document file received via 
email or FTP is stored in this folder. An existing document file from the 
outside can also be dropped into this folder. A document file in this folder 
can easily be associated with a dictation file. Double-clicking a dictation 
file associated with a document file opens the document file. 

 

 

2.3.2 Folder Functions 
 
This section describes each folder’s capabilities and limitations. 
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: Supported : Not supported 

 

Folder Name Renaming 
Subfolder 
Creation 

Adding 
Encryption 
Attribute 

Adding 
Ownership 
Attribute 

File 
Dropping 

Dictation Tray      
 Download Tray 

Folder A - Folder 
G 

     

 Custom Folder 

Subfolder 
     

 Recording Folder     *1 
 Outbox 

( E-mail, FTP) 
    *2 

 Sent Items     *1 
 Finished      
 Backup     *1 
 Recycle Box      
 Adaptation Data      

Document Tray      
  My Documents      

 
*1 Files can be removed from the folder, but cannot be dropped into the folder from the outside. 

*2 When a file is dropped into the Outbox, a dialog box will appear to configure settings for sending 

via E-mail / FTP. 
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2.4 Worktypes and Option Items 
 
Worktypes and Option Items are IDs, like an Author ID, used to classify recorded files. 

A Worktype is defined as a string, including a department name or the category name of a recorded file. 

Option Items are used to further embed detailed information in a Worktype. 

 

Each recorded file is assigned a pre-defined Worktype.  

For example, with a Worktype associated with a document file template, the template can be opened and a 

document is automatically created in the appropriate format before Dictation File transcription begins. 

 

The Dictation Module can register up to twenty Worktypes. Each Worktype can have up to ten Option Items 

registered. 

 

The following diagram shows the relationship between Worktypes and Option Items. In this diagram, a 

Worktype FAX is associated with two Option Items labeled TO and TITLE. 

 

 

 

An Option Item consists of input data and its label. Once a label has been registered, its value can be entered. 

An Option Item is usually input with a bar code. 

 

 
Whether to input multiple labels at once with a single bar code scanning or to input them 
separately with a series of bar code scannings can be configured in the Worktype 
Property dialog box.  

=> [Workflow] - Worktype 
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2.5 Direct Recording 
 

Direct Recording is for recording directly onto the hard disk drive of a PC using a connected recorder or 

DirectRec as a microphone. 

 

In Direct Recording, the recording state is managed in two statuses, Pending and Complete, both of which 

are required to finish a recording. 

A dictation file with Pending status is saved in the Recording folder, where it can be selected and edited to 

resume recording. Since the files stored in the Recording folder are on the local PC, a Transcriptionist cannot 

open them. 

A dictation file with Complete status can always be transcribed. Once a transcription has begun, it cannot be 

edited. A dictation file with Complete status can be edited until transcription begins. 

 
Creating a Dictation File 

Editing a Dictation File 

 
Direct Recording settings are configured with the option settings.  

=>[Workflow] –Direct Recording 

 

The following settings can be configured: 

x Recording format 

x File naming rule for a new dictation 

x Job data settings 

x Voice comment settings 

x Start window changes 

x REV button settings 

x VCVA function settings 
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2.6 Ownership Attribute 
 

The Transcription Module is initially configured to automatically move a transcribed Dictation File to the 

Finished folder in the module. This clarifies how many dictation files remain for transcription. However, once 

a dictation file has been moved to the Finished folder in Transcription Module, it is invisible to the Dictation 

Module and may be inconvenient for the Author. For this reason, the folder has an attribute, based on Author 

privileges, to prevent a dictation file from moving to the Finished folder in the Transcription Module after 

transcribing. This attribute is called the Ownership attribute. The Ownership attribute simply prevents a 

dictation file from being automatically moved to the Finished folder in the Transcription Module once the 

transcription has been completed. Transcriptionist or Author can move the transcribed file to another folder. 

=>[Folder Design] – Attributes - Ownership 
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2.7 Local Mode and Network Mode 
 
A shortcut folder can be modified for any path. 

When a shortcut folder represents a path in a local PC, it is displayed as  (normal color). If the path is 

over the network, it is displayed as  (green).  

With access to the network, files in a shortcut folder assigned a path over the network can be listed. Such a 

configuration is called the network mode. 

If the download destination is a folder on the network, when a server crashes or when no network access is 

available, audio and document files cannot be downloaded. 

 

To avoid this inconvenience, if assigned a network path that is temporarily inaccessible, the destination 

folder is automatically switched to a local path, allowing file downloading. This is called the local mode. 

If a file was downloaded in the local mode, and the system switches back to the network mode, the folders 

for the network and local modes are both displayed, and the file downloaded in the local mode is 

automatically moved to the folder associated with the network mode. 

A file temporarily placed in the local mode can be identified by its icon. The icon changes back to normal 

when the file moves to the network mode. 
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2.8 Clean 
 
Clean is a folder attribute that deletes files. Old files can be deleted through one of two methods: by directly 

deleting them, or by moving them to the Recycle Box and then deleting them with the Recycle Box delete 

option. 

Folders with the Clean attribute are listed below. These folders may contain transcribed dictation files. They 

have the Clean attribute to clean up old dictation files. 

 

� Folders that can be cleaned 

Folder Dictation Module Transcription Module 

Download Tray 

Folder A - Folder G   

Custom Folder 

Subfolder 
  

Sent Items  --- 

Finished   

Forwarded ---  
---… Unsupported function 

… Cleanable 
… Uncleanable 
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2.9 Voice Comments 
 
There are two types of voice comments recorded by an Author with the Dictation Module: instruction 

comments and verbal comments. 

 

� Instruction Comments 

Instruction comments can be created only with Direct Recording and cannot be composed when making a 

recording with a stand-alone recorder. Instruction comments are maintained as files separate from a 

dictation file and provide a Transcriptionist with overall instruction. A  mark in  column indicates there 

are Instruction comments. 

 

� Verbal Comments 

Verbal comments are voice comments embedded in a dictation file. Verbal comments can be recorded with 

supported recorders. Unlike instruction comments, verbal comments are provided for transcription of audio 

data immediately following the commentary. For this purpose, verbal comments can be recorded at any 

position in a dictation file.  

 

Instruction comments and verbal comments cannot have index marks inserted. 
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2.10 Storage Mode and Composite Mode 
 
Olympus recorders implement some or all of three standard USB classes of storage, audio, and HID. To 

provide stable operation, they switch between the following two modes in accordance with the current 

application: Storage mode (storage class only) and Composite mode (auto and HID class composite device). 

With the Dictation Module, Storage class is used for dictation file downloading, while Audio+HID class is used 

for Direct Recording. 

 
The modules listed below, which are fully supported by the Dictation Module, are three-class composite 

devices (Storage + Audio + HID) when operating in Composite mode. With these models, specifying 

Composite mode enables dictation data download, Direct Recording, and all other operations without mode 

switching. 

x DS-7000 

x DS-5000/5000iD 

x DS-3500 

x DS-3400 

x DS-2800 

x DS-2500 

x DS-2400 
 
In the case of models other than those listed above, some models do not have a Storage class in Composite 

mode. When such a model is connected, users need to switch to Storage mode during dictation file 

downloading, while users need to switch to Composite mode for Direct Recording. With the Dictation Module, 

Composite mode is entered automatically whenever the Direct Recording window is displayed. When ODMS 

R6 returns to the Main window after a recording has been completed, the recorder is automatically switched 

back to Storage mode. Storage and Composite modes can also be switched manually. 
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2.11 Backing Up 
 
After a folder's backup settings are configured, any file dropped into the folder will be automatically backed 

up to the other specified folder. 
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2.12 Debugging Option 
 

The Dictation Module provides a Log Tool, which is a function to log information that enables analyses of 

problems that only occur in certain PC environments. By sending the log data of problematic areas to your 

dealer or distributor, you can receive advice to facilitate a resolution to the problem in a timely manner. 

Log Tool is provided as ODMSLogTool.exe in the Dictation Module program folder. It allows for per-module 

configuration of log outputs. Configuring all items to be logged generates a large amount of log information, 

resulting in slower operations of Dictation Module. When configuring logging, it is recommended to check 

only the items in question. 

 

For more information on how to use Log Tool, refer to "Collecting Information with Log Tool." 
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33  Basic Operations 
 
This chapter describes the basic operations of Dictation Module. 

 

Starting and Exiting Dictation Module 

Downloading a Dictation File 

Importing a File 

Copying or Moving a Dictation File 

Playing a Dictation File 

Creating a Dictation File 

Editing a Dictation File 

Sending a Dictation File via E-mail 

Sending a Dictation File via FTP 

Managing Document Files 

Receiving a Document File via E-mail 

Receiving a Document File via FTP 

Voice Recognition  
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3.1 Starting and Exiting Dictation Module 
 
To start and exit Dictation Module, perform the following procedures: 

 

Starting 

Auto-starting 

Exiting 

 

 
Dictation Module, Transcription Module and File Downloader cannot be started 
simultaneously on the same PC. 

 

Starting 

To start the Dictation Module, perform the following steps: 

 Procedure A 

1. From the Windows [Start] menu, 

select [All Programs] - [Olympus Dictation Management System] - [Dictation 

Module]. 

 Dictation Module will start and the Main window will appear. 

 Procedure B 

1. Double-click a DSS or DSS Pro file through the Windows Explorer. 

 Dictation Module will start and the Playback Control window will appear. 
 

Auto-starting 

 Procedure 

1. Start the resident Device Detector4 and check Dictation Module. 

2. Connect the supported device to the USB port of the PC. 

 Dictation Module will automatically start and the Main or Playback Control window will appear. 
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Exiting  

If in the Playback Control or Direct Recording window, return to the Main window and then exit Dictation 

Module. 

 Procedure 

1. Select [Exit] from the File menu on the Main window. 

Or click  in the upper right corner of the Main window. 

 Dictation Module will close. 
 
 

 
 



37 / 253 

3.2 Downloading a Dictation File 
 

Downloading refers to copying a file from a device and transferring it to the Dictation Module. To download 

a file, follow the procedures described below. Downloaded files are stored in the Download tray. 

 

 
Download settings are configured in the Workflow dialog box. 

=>[Workflow] - Download 

 

Downloading All Files 

Downloading Files into a Specified Folder 

Downloading Specified Files 

 

3.2.1 Downloading All Files 
 
To download all files from a device, perform the following steps: 

 

 
When using a model with the Music folder, executing [Download All] cannot download 
files in the Music folder. 

 

 Procedure 

1. Connect a supported device to a USB port on the PC. 

2. Switch on the device. 

 The Main window will automatically open. 
The Device Tree View will display the model of the recorder and file information. 

 

 
When connecting or disconnecting the device while the Main window is open, device 
information will be updated in the Device Tree View. 

 

3. Verify that the device is in Storage mode. 

If it is in Audio mode, select [Change Device Mode] from the [Device] menu. 

4. Select the device in the Device Tree View and click . 

Or right-click the device and select [Download All] from the context menu. 
 All files in every folder in the device are downloaded (copied) into the corresponding folders 
A-G in the Download tray. 
The file name format is "Recorder user ID (leading four characters) + four-digit number." 

 

 

� If multiple devices are connected, the Device Selection dialog box will appear by 
clicking [Download All] on the Device menu. Select the device and click [OK]. 

� Files in a device can also be deleted when they are downloaded. 
=>[Workflow] - Download 
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� Downloading can be automatically started when the device is detected. 
=>[Folder Design] - Auto Download 

 

3.2.2 Downloading Files into a Specified Folder 
 
To download all files into a specified folder at the same time, perform the following steps: 

 

 Procedure 

1. Connect a supported device to a USB port on the PC. 

2. Switch on the device. 

 The Main window will automatically open. 

3. Right-click a folder of the device and select [Download Folder] on the context menu. 

 Files in the specified folder are downloaded into the corresponding folder in the Download tray. 
The file name format is "Recorder user ID (leading four characters) + four-digit number." 

 

 
If multiple devices are connected, the Device Selection dialog box will appear when 
[Download Folder A (or B-G)] is selected from the Device menu. Select the device and 
click [OK]. 

 
 

3.2.3 Downloading Specified Files 
 
To download one or more specified files, perform the following steps: 

 

 Procedure 

1. Connect a supported device to a USB port on the PC. 

2. Switch on the device. 

 The Main window will automatically open. 

3. Select a folder from the Device Tree View. 

 Files in the folder will be listed in the Content List View. 

4. Select a file in the Content List View and select [Download Selected Files] from the 

[Device] menu. 

 The selected files are downloaded into the corresponding folder (for example, folder A to folder 
A) in the Download Tray of the Dictation Tree View. When the corresponding folder is disabled, 
the files cannot be downloaded. 

 



39 / 253 

3.3 Importing a File 
 

Importing is for capturing an external Dictation File not managed by Dictation Module so that Dictation 

Module can manage it. 

Supported Dictation File formats are listed below. These files can also be dragged and dropped with a tool 

such as Explorer. 

 

Dictation File DS2 (DSS Pro), DSS, WMA, WAV, MP3 
Encrypted File DS2 (DSS Pro), $DSS, $WMA, $WAV, $MP3 

 

Specifying a file with a format other than the ones above causes a warning message to appear. However,  

if a codec that can work with Microsoft® DirectShow® Filter has been installed, dictation files with other 

formats can also be imported. Once a file format has been imported, it can be re-captured by dragging and 

dropping it every subsequent time. 

 

 Procedure 

1. Click  on the toolbar. 

Or select [Import Dictation] from the File menu. 
 The Import File dialog box will appear. 

 

  

2. Select in the file location list the folder of the file to import. 

Set the import destination folder using [Change]. 
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3. Select a file from the list and click [Open]. 

 The specified file will be copied or moved to the folder selected in “Destination”. 
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3.4 Copying or Moving a Dictation File 
 
To copy or move a dictation file, perform the procedures described below. 

 

Copying a File in the Dictation Tree View 

Moving a File in the Dictation Tree View 

Copying a File to a Specified Location  

Uploading a Dictation File to the Device 

Exporting a File 

 

3.4.1 Copying a File in the Dictation Tree View 
 
To copy a file in the Dictation Tree View, perform the following steps: 

 

 Procedure 

1. Select a file in the Content List View. 

Selecting [Select All] from the Edit menu selects all files in the List View. 

2. Click  on the toolbar. 

Or select [Copy to Folder] from the Edit menu. 
 The Copy to Folder dialog box will appear. 

3. Select a destination folder and click [OK]. 

 The selected file will be copied to the specified folder. 
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3.4.2 Moving a File in the Dictation Tree View 
 
To move a file in the Dictation Tree View, perform the following steps: 

 

 Procedure 

1. Select a file in the Content List View. 

Selecting [Select All] from the Edit menu selects all files in the List View. 

2. Click  on the toolbar. 

Or select [Move to Folder] from the Edit menu. 
 The Move to Folder dialog box will appear. 

3. Select a destination folder and click [OK]. 

 The selected file will be moved to the specified folder. 
 

3.4.3 Copying a File to a Specified Location 
 
To copy a file to a specified location, perform the following steps: 

 

 Procedure 

1. Select a file in the Content List View. 

Selecting [Select All] from the Edit menu selects all files in the Content List View. 

2. Click  on the toolbar. 

Or select [Copy] from the Edit menu. 
 The specified file will be copied to the clipboard. 

3. Select a destination folder in the Dictation Tree View or specify a folder with the 

Windows Explorer. 

4. Click  on the toolbar. 

Or select [Paste] from the Edit menu. 
 The file will be pasted into the specified folder. 

 

3.4.4 Uploading a Dictation File to the Device 
 
Uploading is copying a file in the Content List View and transferring it to a connected device. 
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File types not supported by the device cannot be uploaded. 

 

 Procedure 

1. Select a dictation file in the Content List View and click  on the Device Tree View. 

Or select [Upload Selected Files] from the Device menu. 
 The Upload dialog box will appear. 

2. Select a destination folder and click [OK]. 

 The selected file will be copied to the specified folder. 
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3.4.5 Exporting a File 
 
This function can export audio and management files to external media. 

Management files are files for storing important dictation information for dictation files. 

 

 Procedure 

1. Select a file in the Content List View. 

Selecting [Select All] from the Edit menu selects all files in the List View. 

2. Click  on the toolbar. 

Or select [Export Dictation] from the File menu. 
 The Export dialog box will appear.  

 

 

 
By checking the deletion option check box in the Options field, the original file is deleted 
after exporting has been completed. 

3. Select a destination folder and click [OK]. 

 The selected audio and management files will be exported to the specified folder. 
 

 
The export function only supports copying to an external location. Specifying a path 
managed by Dictation Module results in an error. 
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3.5 Playing a Dictation File 
 
This section describes how to play a dictation file. 

 

 

� Selecting [Switch to Playback Control Window] from the View menu hides the Main 
window and opens the Playback Control window. 

� Clicking a DSS file with the Windows Explorer directly opens the Playback Control 
window and starts playing the file. 

 
Starting and Stopping Playback 

Shifting the Playback Position 

Adjusting Playback Conditions  

Intro-Scanning 

 

3.5.1 Starting and Stopping Playback 
 
Typical tape recorder operations such as playback, stop, fast-forwarding, and rewinding are available.  

The Playback Control bar on the Main window and Playback Control window offer the same operations during 

playback. 

 

 Procedure 

1. Double-click a file to play from the Content List View. 

Or select [Play] from the context menu. 

Or select the file and click . 
Or select the file and select [Play/Stop] from the Play menu. 

 Playback of the file will begin. The Position control (▽) indicates the current playback position. 

 shows the total length of time in white and the current position in blue. 

2. Click  during playback. 

Or select [Play/Stop] from the Play menu. 
 Playback of the file will stop. 

 

 

� Selecting [Switch to Playback Control Window] from the View menu displays the 
Playback Control window. 

� Clicking  again after stopping playback restarts playing from a previous 
position set by a length of time specified with Auto-backspace on the Playback 
Control. 
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3.5.2 Shifting the Playback Position 
 
This section describes how to play a file from a specified position. 

 

Moving to a Desired Position 

Skipping to an Index Mark or Verbal Comment Position 

Moving the Position Control with the Keyboard 

 

Moving to a Desired Position 

 Procedure 

1. Click on a desired position on the Play bar or drag the Position control there. 

 The Position control will move to the specified position. 
 

Skipping to an Index Mark or Verbal Comment Position 

On the Play bar, a red mark ( ) represents an index mark and a light blue bar represents a verbal 

comment. 

 Procedure A 

1. Click  or . 

Or select [Next/Previous Index Mark/Verbal Comment] from the Play menu. 
 The Position control will move to an index mark or to the edge of a verbal comment before or 
after the current position. 

 

 Procedure B 

1. Click  on the toolbar. 

Or select [View All Index Mark] from the Play menu. 
 The [View All Index Mark] dialog box will appear. 
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2. Select an index mark and click [Skip]. 

 

Moving the Position Control with the Keyboard 

If the Play bar is highlighted (surrounded by a dotted line), the Position control can be moved with the 

keyboard. 

 

Keyboard Operations Position Control Behavior 

 Moves to the left 

 Moves to the right 
Home Moves to the beginning of a file 
End Moves to the end of a file 

 
 

3.5.3 Adjusting Playback Conditions 
 
Dictation Module can provide better sound quality of recorded sound. Functions can be selected from the 

Playback Control bar on the Main window or from the Playback Control window. 

 

 
The following controls except for Volume Adjustment Control are hidden 
initially. Modify the initial settings to display them. 

=>[User Setting] – Playback Control – Control Indicators 

Depending on administrative settings, some menus will be hidden. 

 

Adjusting Volume 

Adjusting Speed 

Suppressing Noise 

Adjusting Tone 
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Adjusting Volume 

This function is used to adjust the playback volume. 

 Procedure 

1. Drag the slider on the Volume Adjustment control. 

Or select [Up] or [Down] for Volume from the Play menu. 
 The playback volume will adjust. 

 

Adjusting Speed 

Playback speed adjustment allows for slower playback of demanding sound parts and faster playback for less 

demanding parts. 

 Procedure 

1. Click  or , or drag the slider on the Speed Adjustment control. 

Or select [Up] or [Down] for Speed from the Play menu. 
 The playback speed can be adjusted to nine levels between 50% and 200% without changing 
the voice pitch (sound pitch). 

 

Suppressing Noise 

Noise cancellation is useful for easier listening of noisy recordings. 

 Procedure 

1. Click  or , or drag the slider on the Noise Cancellation control. 

Or select [OFF], [1], [2], or [3] for Noise Cancellation from the Play menu. 
 The noise cancellation effect can be adjusted to the following four levels: OFF, 1, 2, and 3. 

 

 
In some recording environments, noise cancellation may not work effectively. In certain 
noise cancellation levels (1-3), the volume level may be too low or the sound quality 
may change. 

 

Adjusting Tone 

Move the slider to the [-] side to emphasize bass sounds and to the [+] side to emphasize higher sounds. 

The [+] side is generally more suitable for easy listening. 

 Procedure 

1. Click  or , or drag the slider on the Tone Adjustment control. 
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Or select [Up] or [Down] for Tone from the Play menu. 

 The tone can be adjusted in increments of 1% from 100% on the [-] side to 100% on the [+] 
side. 

 
 
 



50 / 253 

3.5.4 Intro-Scanning 
 
This function sequentially plays only the first five seconds of the files displayed or selected in the Content List 

View. When all the files have been intro-scanned, a beeping sound is produced. A file with a recording time 

of less than five seconds is played through before the next file is played. A file being played back is 

highlighted in the Content List View. 

 Procedure 

1. Click  on the toolbar in the Main window. 

Or select [Intro Scan] from the [Play] menu. 
 Files displayed in the Content List View will be intro-scanned sequentially from a selected file. 
If no file is selected, intro-scanning will begin with the first file on the list. 

2. Click . 

Or select [Play/Stop] from the Play menu. 
 Intro-scanning will stop. 
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3.6 Creating a Dictation File 
 
This section describes how to create and edit a dictation file. 

 

Making a New Recording 

Adding a Recording to a File 

Partially Deleting a File  

Inserting an Index Mark 

Exiting the Recording Window 

 

3.6.1 Making a New Recording 
 
This function can be used to perform Direct Recording (create a new file) in the Direct Recording window 

using a digital voice recorder or DirectRec as a microphone. 

 

 
The volume, status, and user ID of recorded sound are displayed on the status bar 
during recording. 

 
The recording quality should be configured in advance.  

=>[Workflow] –Direct Recording 

 

 Procedure 

1. Connect Directrec or a supported digital voice recorder to a USB port on the PC. 

2. Click  on the toolbar. 

Or select [New Dictation] from the File menu. 
 

 The Direct Recording window will open. 
 

When creating a new file, the folder name is “Recording folder," and the file name format 
is "the leading four characters of the user ID + four-digit sequential number.extension". 

3. Select the Microphone Sensitivity. 

Select Conference mode  or Dictation mode . 
 

 
Some Olympus recorder models do not support selection of Microphone Sensitivity on 
the 3Direct Recording window. With these models, use the Sound and Audio Devices 
setting on the OS Control Panel to adjust the microphone input level. 
Supported recorders listed under “Devices Connectible to Dictation Module” and 
Directrec support all Microphone Sensitivity adjustments. 

4. Click . 

 Recording will begin. It can be operated via DirectRec, used as a microphone, or via the buttons 
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on the digital voice recorder. 
 

 
 is the button for recording verbal comments. Use  for normal recording.  

=>Recording a Verbal Comment 
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5. Click . 

 Recording will stop. 

6. Exit the Recording window. 

 

3.6.2 Adding a Recording to a File 
 
This function adds a recording to an existing file. When repeatedly starting and stopping recordings, each 

recorded segment will be appended to the file to create a single continuous recording. 

Starting recording after shifting the Position control to a previously-recorded position results in either an 

overwrite recording or an insert recording. 

Additionally recorded files are saved in the Dictation tray. 

 

 Procedure 

1. Connect the Directrec or a supported digital voice recorder to a USB port on the PC. 

2. Right-click the file to be configured and select [Edit Dictation] from the context 

menu. 

Or select the file and click  on the toolbar. 
Or select the file and select [Edit Dictation] from the File menu. 

 The Direct Recording Window will open. 

3. Move the Position control to the intended recording position. 

4. Select the recording mode. 

Select  for insert recordings or select  for overwrite recordings. 

5. Select the Microphone Sensitivity. 

Select Conference mode  or Dictation mode . 

6. Click  to start recording. 

7. Click . 

 Recording will stop. 

8. Exit the Recording window. 
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3.6.3 Partially Deleting a File 
 
To partially delete a recorded file, perform the following steps. Partially deleted files are saved in the 

Dictation tray. 

 Procedure 

1. In the Direct Recording Window, move the Position control to the desired deletion 

starting point and click . 

Clicking  again will unlock the starting point. 

2. Move the Position control to the desired deletion end point and click . 

 The Confirmation dialog box for deletion will appear. 

3. Click [OK]. 

 The specified range will be deleted. 

4. Exit the Recording window. 

 
 

3.6.4 Inserting an Index Mark 
 
An index mark can be inserted and deleted in the Main Window or Direct Recording Window 

 

 
Index marks cannot be inserted into instruction comments. 

 
 

Inserting an Index Mark 

To insert an index mark, perform the following steps: 

 Procedure 

1. Select a file in the Content List View. 

 The file will be displayed on the Playback Control bar. 

2. Move the Position control and click  on the toolbar. 

Or select [Insert Index Mark] from the Play menu. 
 An index mark will be inserted at the Position control location. 
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The maximum number of settable index marks is 16 for a DSS file and 32 for a DSS Pro 
file. 

 

Deleting an Index Mark 

To delete an index mark, perform the following steps: 

 Procedure A 

1. Move the Position control to the index mark to be deleted by clicking  or 

. 

2. Click  on the toolbar. 

Or select [Delete Index Mark] from the Play menu. 
 The index mark will be deleted. 

 Procedure B 

1. Select [View All Index Mark] from the Play menu. 

 The [View All Index Mark] dialog box will appear. Index marks are displayed in the format of 
HH:MM:SS. 

 

  

2. Select an index mark and click [Delete]. 

 The index mark will be deleted. Multiple index marks can be deleted at once. 
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3.6.5 Exiting the Recording Window 
 
To finish recording operations, perform the following steps: 

 

 Procedure 

1. From the Direct Recording Window, click [Finished] after recording and editing a file. 

 The Dictation Finished dialog box will appear. Clicking [Pending] finishes recording operations 
in the Pending status of recording. 

 

  
 
 

Items Description 

Filename Enter the file name. 
Folder to Save From the list, select the folder in 

which the file is to be saved. 
Send the Dictation If the folder for saving is configured 

with the automatic E-mail/FTP 
sending option, select whether or 
not to send the file. 

Background Voice 
Recognition 

Selects whether or not to register to 
the Recognition Queue. 

 

2. Click [OK]. 

 The file will be saved with Complete status. 
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3.7 Editing a Dictation File 
 

DSS files, DSS Pro files, or WMA files recorded with an Olympus recorder can be edited. 

 

 
Edited files are always saved as new files. 
MP3, WAV, and general WMA files cannot be edited. 

 
The following functions are available. 

 
Converting the File Format 

Splitting a Dictation File into Two Files 

Joining Multiple Dictation Files into One  

Recording a Verbal Comment 

Recording an Instruction Comment 

Changing the Status of a Dictation File 

 

3.7.1 Converting the File Format 
 
This function converts a dictation file in the Content List View into a specified file format. With multiple files 

selected, it converts all of the files into the specified format. 

 

 
When Format Conversion is enabled in the folder property settings, files in the folder are 
automatically converted into the specified format according to the settings.  

=>[Folder Design] - Actions - Format Conversion 
 

 Procedure 

1. Right-click a dictation file in the Content List View, and select [Convert Dictation 

Setting] from the context menu. 

Or select the file and click  on the toolbar. 
Or select [Convert Dictation] from the File menu. 

 The Convert Dictation Settings Dialog Box will appear. 

2. Select a format and attributes and click [OK]. 

The resulting file will be saved in the same folder. Select whether or not to delete the 
original file after conversion. 

 The file will be converted to and saved as a file with another format, and the original file will be 
deleted based on the folder property settings. 

 

Format and Attributes of the Resulting File 
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Format and Attributes of the Resulting File 

 

The following tables list the formats and attributes that can be assigned to the resulting file in the Convert 

Dictation dialog box. 

 
Attributes 

Format 
Codec 

Sampling 
Frequency 

Quantization Bit 
Rate 

Channel 
(Recording Mode) 

WAV PCM 44.10 kHz 16 bit stereo 
 PCM 32.00 kHz 16 bit stereo 
 PCM  22.05 kHz 16 bit stereo 
 PCM 16.00 kHz 16 bit stereo 
 PCM 44.10 kHz 16 bit mono 
 PCM 22.05 kHz 16 bit mono 
 PCM 12.00 kHz 16 bit mono 
 PCM  8.00 kHz 16 bit mono 

 
Attributes 

Format 
Codec Bit Rate 

Sampling 
Frequency 

Channel 
(Recording Mode) 

DSS DSS 13.7 kbps 12 kHz mono (SP) 
DSS Pro DSS 13.7 kbps 12 kHz mono (SP) 

 DSS 28 kbps 16 kHz mono (QP) 

 
Attributes 

Format 
Codec Bit Rate 

Sampling 
Frequency 

Channel Constant 
/ Variable Bit Rate 

WMA WMA 8 kbps   8.00 kHz mono CBR 
 WMA  16 kbps 22.05 kHz mono CBR 
 WMA  32 kbps 44.10 kHz mono CBR 
 WMA  48 kbps 44.10 kHz mono CBR 
 WMA  12 kbps  8.00 kHz stereo CBR 
 WMA  32 kbps 22.05 kHz stereo CBR 
 WMA  64 kbps 44.10 kHz stereo CBR 
 WMA 128 kbps 44.10 kHz stereo CBR 
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3.7.2 Splitting a Dictation File into Two Files 
 
With this function, a Dictation file in the Content List View can be split into and saved as two files. 

DSS, DSS Pro, WAV, and WMA files can be split. The resulting file format can be selected. 

 

 Procedure 

1. Select a file in the Content List View and click  on the toolbar. 

Or select [Split] from the File menu. 
 The Split File dialog box will appear. 

 

  
 

Items Description 

Input file name The name and time length of the file 
to be split are displayed. 

First half Type in a name for the first half of the 
resulting file. 

Last half Type in a name for the last half of the 
resulting file. 

Split position With the slider, specify the point of 
separation in the original file. 

  
With these buttons, playback of the 
file can be started, stopped, and 
verified. 

Display for 20 
seconds 

Checking this option zooms in on a 
20-second range centered on the 
slider, allowing for fine-tuning at the 
point of separation. 
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File type 
Format 

Specify the file format of the resulting 
file. 

File type 
Attributes 

Specify the attribute of the resulting 
file. 

2. Type in the names of the two resulting files that will represent the first and last 

halves of the original file, respectively. 

3. Specify the split position with the slider. 

4. Click [Split]. 

 The file will be split at the Position control point, and the first and last halves will be saved with 
their specified names in the original folder. 
The default naming format of the two resulting files is "the original file name + _A or 
_B.extension." The original file will remain intact. 

 

 

� File status after splitting is [Recording Finished]. 
� If files to be joined each have instruction comments, the newly combined file will retain 

all of the instruction comments from the original files. 

 

3.7.3 Joining Multiple Dictation Files into One 
 
Multiple files selected in the Content List View can be joined into and saved as a single file in the same folder. 

DSS, DSS Pro, WAV, and WMA files can be joined. 

 

 
Joining two split files again may result in noise at the point of attachment. 

 

� File status after joining is [Recording Finished]. 
� If files to be joined each have instruction comments, the newly combined file will retain 

all of the instruction comments from the original files. 

 

 

 Procedure 

1. Select the files to be joined in the Content List View and click  on the toolbar. 

Or select [Join] from the File menu. 
 The Join Files dialog box will appear. 

With  and , playback of the files can be started, stopped, and verified. 
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2. Specify the sequence of the files to be joined using [Up] and [Down]. 

3. Type in the desired name of the resulting combined file in the [Output file name] 

field. 

As the default setting, the resulting file name is the original file name with the addition of 
“C.” 

4. Click [Join]. 

 The joined file with the specified file name will be saved in the same folder. 
The default naming format of a joined file is "the original file name + _C.extension." The original 
files will remain intact. 

 

3.7.4 Recording a Verbal Comment 
 
Verbal comments are recorded at any position in a dictation file based on the need for instructions. A 

Transcriptionist will transcribe a dictation file according to the verbal comments recorded in the file. Verbal 

comments can be recorded with Dictation Module as well as any recorder that supports Verbal Comment. 

With a recorder, they can be recorded only while the verbal comment recording button is being pressed 

during Dictation File recording. With Dictation Module, whenever the verbal comment recording button is 

being pressed, a verbal comment can be recorded, even when a dictation file is not being recorded. 

Verbal comments cannot have index marks inserted. 

Verbal comments are displayed in light blue on the Play bar. They can be recorded as insert recordings or 

overwrite recordings. 

To delete a verbal comment, use the partial deletion function for a recorded file.  

=>Partially Deleting a File 
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Verbal comment recording can be disabled. 

=>[Workflow] – Direct Recording - Voice comments 

 

 Procedure 

1. In the Direct Recording Window, move the Position control to a point for verbal 

comment insertion. 

2. Select the recording mode. 

Select  for insert recordings or select  for overwrite recordings. 

3. Select the Microphone Sensitivity. 

Select Conference mode  or Dictation mode . 
 

 
Some Olympus recorder models do not support selection of Microphone Sensitivity on 
the 3Direct Recording window. With these models, the microphone input level is set via 
[Property of Sound and Audio Device] on the Control Panel of the OS. 

Supported recorders listed under “Devices Connectible to Dictation Module” and 
Directrec support all Microphone Sensitivity adjustments. 

4. Verbal comments can only be recorded while pressing . 

During the recording of a dictation file, a verbal comment can still be recorded while 
pressing the button. Releasing the button allows normal recording to resume. 

Verbal comments are displayed in light blue. With  or , the Position control 
can be moved to an index mark or to the edge of a verbal comment before or after the 
current position. 

5. Exit the Recording window. 

 

3.7.5 Recording an Instruction Comment 
 
An instruction comment can be created only with Direct Recording and cannot be prepared when making a 

recording with a stand-alone recorder. An instruction comment is maintained as a file separate from a 

dictation file and provides the Transcriptionist with instruction. A  mark in  column indicates there are 

Instruction comments. 

 

 
Instruction comment recording can be disabled. 

=>[Workflow] – Direct Recording - Voice comments 

 

Attaching an Instruction Comment 

 Procedure 

1. Click  in the Direct Recording Window. 
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 The Play bar will be surrounded by an orange line. 

2. Select the Microphone Sensitivity. 

Select Conference mode  or Dictation mode . 
 

 
Some Olympus recorder models do not support selection of Microphone Sensitivity on 
the 3Direct Recording window. With these models, the microphone input level is set via 
[Property of Sound and Audio Device] on the Control Panel of the OS. 

Supported recorders listed under “Devices Connectible to Dictation Module” and 
Directrec support all Microphone Sensitivity adjustments. 

3. Click  to start recording an instruction comment. 

4. Click  to stop recording. 

5. Exit the Recording window. 

 

Deleting an Instruction Comment 

 
To delete an instruction comment, perform the following steps: 

 Procedure 

1. Click  on the toolbar in the Direct Recording Window. 

 The instruction comment will be deleted. 

 

3.7.6 Changing the Status of a Dictation File 
 
This function changes the status of the currently selected Dictation File. 

 Procedure 

1. Select a file in the Content List View and click  on the toolbar. 

Or select [Change Status] from the File menu. 
 The Change Status dialog box will appear. 
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The following statuses can be selected: 
 

Item Functions 

Recording.Pending Set to the pending status of recording. 
Recording.Finished Recording has been completed. 
Transcription.Finished Transcription has been completed. 
Voice Recognition.Pending Voice recognition is underway. 
Voice Recognition.Finished Voice recognition has been completed. 

 

2. Select the status and click [OK]. 

 This will change the status of the selected file. 
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3.8 Sending a Dictation File via E-mail 
 

The E-mailing function offers manual transmission via the menu and automatic transmission with periodic 

confirmation. 

 

 
To send a file via email, an email profile needs to be configured in advance. 

=>[E-mail / FTP] - E-mail 

 
The following two methods are available to send a file via email. 

 

Automatic Transmission via E-mail 

Manual Transmission via E-mail 

Registering an E-mail Address 

 

3.8.1 Automatic Transmission via E-mail 
 
If a folder is configured for auto send of e-mail, any files stored in the folder are stored in Outbox, and sent 

to a specified addressee at a specified time. 

 

 
To automatically send an email, the folder needs to be pre-configured for automatic 
sending. 

=>[Folder Design] – Actions – Send via E-mail 
 

Automatically Switching E-mail Profiles 

When configuring automatic transmission, it is beneficial to set an alternative profile at the same time so 

that if an email cannot be automatically sent with the [Auto Send via E-mail] setting, the profile switches and 

the email can then be automatically sent with the [Auto Send via E-mail (Alternate)] setting. 

=>[Folder Design] – Actions – Send via E-mail (Alternate Profile) 

3.8.2 Manual Transmission via E-mail 
 
To specify and send a file via email, perform the following steps. 

 

 
� To send a file via email, an email profile needs to be configured in advance.  

=>[E-mail / FTP] - E-mail 
� For information on how to register an address, refer to Registering an E-mail Address. 

 

 Procedure 

1. Select a file. 

2. Click  on the toolbar, and select a mail profile to be used. 
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Or select a mail profile with [Send Via E-mail] on the Tool menu. 
 The “Set E-mail Destinations” dialog box will appear. 

 

  

3. Click [To], [CC], and/or [BCC]. 

 The POP/SMTP Address dialog box will appear. 
 

  
 
 

 
Use the [New Contact] button to register a new address.  

=> Registering an E-mail Address 

 

4. Select addresses from the Address Book and click [To:=>], [CC:=>], and/or 

[BCC:=>]. 
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5. After completing configuration, click [OK]. 

 The selected addresses will be displayed in the “Set E-mail Destination” dialog box. 
 

  

6. Type in the “Subject” and the “Message”. 

Enter the mail body to the “Message”.  

7. Click [Send]. 

 The email will be saved in the Outbox folder. 

8. Select the files configured for sending in the Content List View and click  in the 

Information View. 

 The Information View will display the mail body. 

9. Click  at the right of  of the tool bar, then select [Send] or [Send and 

Receive]. 

Or select [Send and Receive], then [Send] or [Send and Receive] from the Tool menu. 
 The emails in the Outbox folder will be sent. 
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3.8.3 Registering an E-mail Address 
 
To register an email address, perform the following steps: 

 Procedure 

1. Click [New Contact] in the POP/SMTP Address dialog box. 

 

  
 

 The New Contact dialog box will appear. 
 

  

2. Type in a contact name and its email address in the “Display Name” and “E-mail 

Address” fields, respectively, and then click [OK]. 

 The address will be registered in the POP/SMTP Address dialog box. 
Selecting the registered address and clicking [Properties] enables editing of the address. 
Clicking [Delete] will remove the registered address. 
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3.9 Sending a Dictation File via FTP 
 

The FTP sending function offers manual transmission via the menu and automatic transmission with periodic 

confirmation. 

To send a dictation file via FTP, perform the following steps. Automatic and manual transmission are 

available. 

 

 
To send a file via FTP, an FTP profile needs to be configured in advance.  

=>[E-mail / FTP] - FTP 

 
Automatic Transmission via FTP 

Manual Transmission via FTP  

 

3.9.1 Automatic Transmission via FTP 
 
With a folder configured for automatic FTP transmission, files in the folder are automatically sent to a 

pre-determined destination at regular intervals. 

 

 
To automatically send a file via FTP, the folder needs to be pre-configured for automatic 
FTP transmission.  

=>[Folder Design] - Actions – Send via FTP 
 

Automatically Switching FTP Profiles 

When configuring automatic transmission, it is beneficial to set an alternative profile at the same time so 

that if a file cannot be automatically sent via FTP with the “Auto Send via FTP” setting, the profile switches 

and the file can then be automatically sent via FTP with the “Auto Send via FTP (Alternate)” setting.  

=>[Folder Design] – Actions – Send via FTP (Alternate Profile) 

 
 

3.9.2 Manual Transmission via FTP 
 
To manually send a file via FTP, perform the following steps: 

 

 
To send a file via FTP, an FTP profile needs to be configured in advance.  

=>[E-mail / FTP] - FTP 

 

 Procedure 

1. Select a file. 

2. Click  on the toolbar. 
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 The Set “FTP Destinations” dialog box will appear. 
 

  

3. Click [To]. 

 The FTP Profiles dialog box will appear. 
 

  

4. Select an FTP profile and click [Select]. 

 The FTP address will be displayed in the Set FTP Destination dialog box. 

  

5. Click [Send]. 

 The file will be stored in the Outbox folder. 

6. Click  at the right of  of the tool bar, then select [Send] or [Send and Receive] 

Or select [Send and Receive], then [Send] or [Send and Receive] from the [Tool] menu．

 The files in the Outbox folder will be sent. 
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3.10 Managing Document Files 
 

Document files are managed in the Document Tray. They can easily be registered by dragging and dropping 

them with a tool such as Explorer. 

File name extension registration must be performed on the Folder Settings dialog box to enable 

management with Document tray. Document Tray cannot manage any document file whose file name 

extension is not registered. 

 

Adding a Managed Document File Type 

Associating a Document File with a Dictation File 

Dissociating a Document File from a Dictation File 

 

3.10.1 Adding a Managed Document File Type 
 
To add a new type of document file, perform the following steps. The following is an example of adding a 

document file with the ".WRI" extension to the Document tray. 

 Procedure 

1. Click  in the Dictation Tree View. 

 The Folder Design dialog box will appear. 

2. Click [Document Tray] in the Folder Tree. 

3. Select [Support Document Type] from the Folder Property and click . 

 The Supported Document Type dialog box will appear. 

4. Type in the extension to be added and click [Add]. 

5. Click [OK]. 

 Files with the added extension (XXX.WRI) will be displayed in the Document tray. 
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3.10.2 Associating a Document File with a Dictation File 
 
To associate a document file with a dictation file, perform the following steps: 

 

 Procedure 

1. Select a dictation file in the Content List View and click [Associate with Document] on 

the File menu. 

Or select a dictation file in the Content List View and click  on the toolbar. 
 The Open dialog box will appear. 

2. Select a document file and click [OK]. 

 The document file name of the associated document file will be displayed in the Document 
column of the Content List View. Selecting a dictation file in the Content List View highlights the 
associated document file in the Document List. 

 

 
Selecting a dictation file and clicking [Open Document] on the File menu causes the 
associated document file to be opened with its associated application. 

 

3.10.3 Dissociating a Document File from a Dictation File 
 
To dissociate a document file from a Dictation file, perform the following steps: 

 Procedure 

1. Select a dictation file in the 3Content List View and click [Remove Association with 

Document] on the File menu. 

Or select a dictation file in the Content List View and click  on the toolbar. 
 The file will be dissociated from the document file and the document file name will be removed 
from the Document column. 
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3.11 Receiving a Document File via E-mail 
 

To receive a document file via E-mail, manual reception via the menu and automatic reception with periodic 

confirmation are provided. 

A received document file is stored in the Document tray or My Documents folder. 

 

 
• The receive file settings must be configured before a document file can be received. 

=>[Workflow] - Receive 

 

The following two methods are available for receiving a document file. 

 

Automatic Reception via E-mail 

Manual Reception via E-mail 

 

3.11.1 Automatic Reception via E-mail 
 
With automatic reception pre-configured, E-mails with document files are automatically received at regular 

intervals, and the received documents are stored in the Document Tray. 

 

 
� To receive a file via email, an email profile needs to be configured in advance.  

=>[E-mail / FTP] - E-mail 
� To automatically receive a document file, pre-configuration is required.  

=>[E-mail / FTP] - Send / Receive  
 

3.11.2 Manual Reception via E-mail 
 
To manually receive a document file via email, perform the following steps: 

 Procedure 

1. Select [Receive] or [Send and Receive] by clicking  on the right side of  on 

the toolbar. 

Or select [Receive] or [Send and Receive] from [Send and Receive] in the Tool menu. 
 Document files will be received manually and stored in the Document tray. 

2. Right click the document file then select [Open Document] from the Context menu. 

Or select [Open Document] from the [File] menu. 
The associated application with the document file opens the document. 
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3.12 Receiving a Document File via FTP 
 

To receive a document file via FTP, manual reception via the menu and automatic reception with periodic 

confirmation are provided. 

Received document files are stored in the Document tray. 

 

 
• The receive file settings must be configured before a document file can be received. 

=>[Workflow] - Receive 

 

The following two methods are available for receiving a document file. 

 

Automatic Reception via FTP 

Manual Reception via FTP 

 

3.12.1 Automatic Reception via FTP 

With automatic reception pre-configured, document files are automatically received via FTP at regular 

intervals, and the received documents are stored in the Document Tray. 

 

 
� To receive a file via FTP, an FTP profile needs to be configured in advance.  

=>[E-mail / FTP] - FTP 
� To automatically receive a document file, pre-configuration is required.  

=>[E-mail / FTP] - Send / Receive  
 

3.12.2 Manual Reception via FTP 

To manually receive a document file via FTP, perform the following steps: 

1. Select [Receive] or [Send and Receive] by clicking  on the right side of  on 

the toolbar. 

Or select [Receive] or [Send and Receive] from [Send and Receive] in the Tool menu. 
 Document files will be received manually and stored in the Document tray. 

2. Select the document file and select [Open Document] from the Context menu. 

Or select [Open Document] from the [File] menu. 
 The document file will open with its associated application. 
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3.13 Voice Recognition 
 

A recorded dictation file can be converted to text automatically using voice recognition software. 

ODMS R6 comes with a collection of voice recognition functions that have been dramatically improved and 

enhanced. Also, the Adaptation function learns from user corrections made to text output by voice 

recognition software and applies what it learns to the next voice recognition session. 

The Dictation Module provides the following functions. 

x Automatic voice recognition of dictation files downloaded from a device 

x Simultaneous voice recognition during direct recording with a microphone 

x Correction of voice recognition results using a special text editor (Voice Recognition Editor) 

x Request transcriptionist to correct results of voice recognition 

x Feedback of voice recognition result corrections to the voice recognition engine for improved voice 
recognition accuracy 

 

Getting Ready for Voice Recognition 

Settings to Share Adaptations 

Performing Real-time Voice Recognition 

Performing Background Voice Recognition 

Correcting Voice Recognition Results (Corrected by Voice Recognition Editor) 

Correcting Voice Recognition Results (Corrected by Transcriptionist) 

Correction Feedback 

 

3.13.1 Getting Ready for Voice Recognition 
 
The Dictation Module itself does not have voice recognition functions built-in. Supported voice recognition 

software must be installed separately. 

 

Installing Voice Recognition Software 

First, install supported voice recognition software. Refer to the installation guide that comes with your voice 

recognition software for information about how to install it. 
 

ODMS R6 supports Dragon NaturallySpeaking voice recognition software. 
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Enabling Voice Recognition Functions 

In order to use voice recognition with the Dictation Module, the [Workflow] – Voice Recognition on the Option 

Settings dialog box must be used to configure voice recognition settings. 

 Procedure 

1. On the menu bar, select [Tools] – [Options..] to display the Option Settings dialog 

box. 

2. Select the [Workflow] tab, which will cause [Voice Recognition] – [General] to 

appear in the tree view. 

3. Select the “Enable Voice Recognition” check box. 

 This will enable use of voice recognition function with the Dictation Module. You can display a 
voice recognition screen in the information view. 

4. Select “Do adaptation” to apply corrections to voice recognition to a DNS user profile 

in Dragon NaturallySpeaking. 

 The Adaptation function is enabled in the Dictation Module. 

 

 
• The transcriptionist must enable the “Do adaptation” option also to share voice recognition 

results and corrections in the adaptation data folders with other transcriptions. 
Refer to Help for the Transcription Module for details. 

 

Dragon NaturallySpeaking User Profiles 

With Dragon NaturallySpeaking, there is a separate profile file (referred to here as a “DNS user profile”) that 

records personal settings for each voice recognition user. Set one fixed DNS user profile for use when 

performing voice recognition with the Dictation Module. Other users can also share a DNS user profile by 

using the roaming setting. 

For details about DNS user profile options, refer to “Voice recognition – Dragon NaturallySpeaking”. 

 Procedure 

1. On the menu bar, select [Tools] – [Options..] to display the Option Settings dialog 

box. 

2. Select the [Workflow] tab, which will cause [Voice Recognition] – [Dragon 

NaturallySpeaking] to appear in the tree view. 

This will access the Dragon NaturallySpeaking engine and obtain DNS user profile information 
kept by the Dragon NaturallySpeaking engine. 

3. The [Dragon NaturallySpeaking] screen will appear. It will show the information 

obtained from the Dragon NaturallySpeaking engine. 

4. Select the “User Profile Location” setting. 
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x If you are not sharing the DNS user profile with another user, select “Use Local Profile”. 

x If you are sharing the DNS user profile with another user, select “Use Dragon Roaming”. 
 

 
• The “User Profile Location” setting links with Dragon NaturallySpeaking engine 

settings. Because of this, even if you do not click [OK] or [Apply] on the Option 
Settings dialog box, when the selection destination is moved the setup for Dictation 
Module is checked and reflected by the Dragon NaturallySpeaking Engine. 

5. If you selected “Use Dragon Roaming” in step 4, the user Roaming User Wizard for 

the user profile will appear on the display. After configuring the roaming destination 

shared location in accordance with the Wizard, select the DNS user profile to be 

managed in the shared location from the DNS user profiles present on the local PC. 

This will copy the DNS user profile created on the local PC to the specified shared location. Now 
whenever the Dragon NaturallySpeaking engine accesses the DNS user profile, settings will be 
changed as if the shared location was referenced and not the local PC. 

 

 
• If the Roaming User Wizard is canceled part way through, the “User Profile Location” 

setting is also canceled and the “Use Local Profile” is re-enabled. 

6. Use the “Active User Profile” option to configure the DNS user profile to be used when 

implementing voice recognition with the Dictation Module. Select the user profile to 

be used from the [User Name] list. The user profiles present at the location whose 

setting were configured in steps 4 and 5 are automatically displayed in and can be 

selected from the [User Name] list. 

 
x Voice recognition cannot be implemented unless a user profile is selected in the 

[User Name] box. 
x The settings of other options besides the [User Name] selection are configured in 

accordance with how voice recognition is actually being used. For details about the 
meaning of each option, refer to “Voice recognition – Dragon NaturallySpeaking”. 
Configuring settings appropriately will improve voice recognition efficiency. 

7. Perform training for the selected user profile. 

8. On the Option Settings dialog box, click [OK]. 

This will check the DNS user profile to be used by the Dictation Module. It also will enable start 
of voice recognition. 
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3.13.2 Settings to Share Adaptations 

These settings allow corrections to voice recognition to be shared by the Dictation Module (author side) and 

Transcription Module (transcriptionist side) and are required to use the author's DNS user profile to do 

adaptations. 

These settings are not particularly needed to do voice recognition, to correct results of voice recognition, or 

to do adaptation with just the Dictation Module. 

 

Set either a shared folder, e-mail, or FTP as shown below to share the results and corrections to voice 

recognition with the Dictation Module and Transcription Module. 

 

 Shared Folder Setup Procedure 

1. Set up a shared folder on a network that both the author and transcriptionist can see 

and confirm that both of them can access it. 

2. Click on the [Folder Design] tab in option settings and select it as the adaptation data 

folder. 

3. The author specifies a shared address for the path of the attributes. 

 The shared address appears for the path. If an error occurs, check the address of the path and 
the access rights. 

 The transcriptionist sets the same shared address as the author set in Option settings 
[Workflow]-[Voice Recognition] for the General Rule List. 

 

 
Refer to Transcription Module Help regarding the option settings for the transcriptionist. 
 

 

 E-mail/FTP Setup Procedure 

1. Select E-mail/FTP from Option settings and register the required profiles as the 

addresses of authors and transcriptionists. 

 
• Refer to 
=>[E-mail / FTP ] - E-mail 
=>[E-mail / FTP ] - FTP 
for details, about the e-mail/FTP profile. 
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3.13.3 Performing Real-time Voice Recognition 
 

Real-time voice recognition is a function that lets you use a special voice recognition editor screen (Voice 

Recognition Editor) to perform voice recognition while recording dictation, and perform real-time monitoring 

of voice recognition results. When there is a mistake in the voice recognition results, you can use the Voice 

Recognition Editor to correct the text. 
 

To improve the real-time voice recognition rate, you need to train the DNS user profile using the same 

microphone device that you will use for actual real-time voice recognition. 

 
Instruction Comment and Verbal Comment cannot be recorded with real-time voice 
recognition. Also, index marks cannot be added. 

 

 Procedure 

1. Configure real-time voice recognition options. 

For details, refer to “Voice recognition – Real-time Voice Recognition”. 

2. Connect the microphone device that you will use for real-time voice recognition to 

the PC. 

 
x With real-time voice recognition, the microphone device, used when the DNS profile 

being used was trained, is automatically selected and used. 

3. On the toolbar, click . 

Alternatively, click [Do Real-time Voice Recognition] on the [Voice Recognition] menu. 

 This will open the Voice Recognition Editor. 

4. On the Voice Recognition Editor toolbar, click the “Record”( ) button. 

 “Recording...” will appear in the status bar to indicate that dictation recording and voice 
recognition has started. 

 

 
x You can stop and restart recording, playback, and perform other operations using the 

toolbar's playback control buttons. 
x If you are using Olympus Directrec or an Olympus recorder as the microphone 

device, you can also stop and start recording, playback, and perform other 
operations using button operations on the Directrec device or recorder. 

x When performing Directrec device or recorder button operations, you can configure 
option settings for each model and [PC Link] – [Programmable Buttons] – [Voice 
Recognition] settings are enabled. For details, refer to the explanations for 
configuring the settings of each device. 

x The [User Settings] – [Keyboard] – [Voice Recognition] settings of the Option 
Settings dialog box are valid on the Voice Recognition Editor. For details, refer to 
“Keyboard ”. 

x Voice commands are supported for inserting line breaks and spaces verbally when 
recording dictation. For details about voice commands, refer to the Dragon 
NaturallySpeaking user documentation. 
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5. After dictation recording is complete, click the “Record” ( ) again or click the 

“Stop” ( ) button. 

 This will exit dictation recording and voice recognition. 
 

 
There may be some time lag between dictation recording and voice recognition 
result output. Because of this, it may take some time before voice recognition stops 
entirely after the Stop button is pressed. 

6. Correct the voice recognition result as required. 

For information about how to make corrections, refer to “Correcting Voice Recognition 
Results”. 

7. Exit real-time voice recognition. 

Perform the menu operations below to perform the operation you want on a recorded 
dictation file. 
 

Menu Button Description 

[File] – [Send for Correction]  

Select this item to quit dictation recording 
and request voice recognition result 
correction by another user. The status of the 
dictation file becomes 
VoiceRecognition.Finished, and the recorded 
dictation file is output as a .WAV format file. 
You must specify the storage destination 
folder of the file. 

[File] – [Finished]  

Select this item to quit dictation recording 
and voice recognition. The status of the 
dictation file becomes Transcription.Finished, 
and add-on dictation recording and voice 
recognition result correction are disabled. 
You must specify the file output destination 
folder and the file format for document 
export. 

[File] – [Pending]  

Select this item when performing additional 
dictation recording later. The status of the 
dictation file becomes 
VoiceRecognition.Pending, and the dictation 
file is stored in the Recording Folder as a .dra 

format file. You can use Edit Dictation ( ) 
to perform add-on recording and voice 
recognition. 
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3.13.4 Performing Background Voice Recognition 
 

Background voice recognition lets you queue recorded dictation files and sequentially perform voice 

recognition on them. Background voice recognition can be performed in parallel with other Dictation Module 

processes. This means voice recognition can be performed at the same time other dictation and transcription 

tasks are being performed. 
 

To improve the background voice recognition rate, you need to train the DNS user profile using the same 

recorder that you will use for actual dictation recording. For details, refer to the Dragon NaturallySpeaking 

user documentation. 
 

The following procedure explains the operational procedure using dictation file download as an example. 

 Procedure 

1. Configure background voice recognition option settings so dictation files are 

automatically added to the voice recognition queue when files are downloaded. 

For details, refer to “Voice recognition – Background Voice Recognition”. 
 

 
x In order to register files automatically in the voice recognition queue when a file is 

downloaded or imported, you need to enable the “Add to recognition queue after 
downloading, importing and direct recording” option. 

x Data is not added to the voice recognition waiting list when it is downloaded even if 
“Add to recognition queue after downloading, importing and direct recording” is 
enabled, if voice recognition is off, even for recorders that can be specified to run 
voice recognition. 

x When the “Add to recognition queue after downloading, importing and direct 
recording” option is disabled, a file can be added to the voice recognition queue using 
drag and drop after the file is downloaded. 

2. Open the information view on the Dictation Module main screen. 

3. Open the Voice Recognition Waiting List in the information view. 

4. Connect the recorder used to record the dictation file to the PC and download the 

dictation file. 

5. At the same time the files are downloaded, all downloaded dictation files are 

registered to the Voice Recognition Waiting List. 

 
x You can skip voice recognition processing by un-selecting the check box after a 

dictation file is registered to the voice recognition waiting list. 

6. On the menu bar, select [Voice Recognition] – [Start Recognition Queue]. Voice 

recognition of the dictation files in the voice recognition queue is performed in the 

sequence they appear in the voice recognition queue. 

 A progress bar appears on the display to show the progress of the voice recognition process. 
When a voice recognition process is complete, the dictation file is moved from the voice 
recognition queue to the voice recognition result list, so you can keep track of voice recognition 
process results. 
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x If you enabled the “Start recognition queue automatically when new files are added 

to the queue” option in step1, the voice recognition process is started automatically 
when a file is added to the voice recognition queue, even if you do not select [Start 
Recognition Queue]. 

x You can stop an ongoing voice recognition process by selecting [Voice Recognition] - 
[Stop Recognition Queue]. 
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3.13.5 Correcting Voice Recognition Results (Corrected by Voice 
Recognition Editor) 
 

You can use the Voice Recognition Editor to correct the voice recognition results of a dictation file that has 

been processed with real-time voice recognition or background voice recognition. 

Text can be corrected using the Voice Recognition Editor while playing back the recorded dictation in the 

editor. When playing back the recorded dictation, the range of text that corresponds to the location being 

played can be highlighted, so corrections can be made to match the voice recognition result and the location 

being played. 
 

Operation of the Voice Recognition Editor depends on the status of the dictation file. The following are the 

voice recognition correction operation procedures for each type of file status condition. 
 

Incomplete Voice Recognition 

This section explains the procedure when a new dictation file is being recorded with real-time voice 

recognition or when performing add-on recording and voice recognition of a file whose status is 

VoiceRecognition.pending. 

In this case the voice recognition process must be performed with the Voice Recognition Editor, so the 

Dragon NaturallySpeaking engine should be started up and linked for operation. Contents edited in the Voice 

Recognition Editor are also discerned by the Dragon NaturallySpeaking ending, and synchronization with 

DNS is necessary. Because of this, the Dragon NaturallySpeaking editing function is used to correct text 

before voice recognition is complete. 
 

If you find an error within voice recognition result text, select the range of error text and then select “Show 

Correction Dialog” ( ) or “Show Spell Dialog” ( ). This will make it possible to use text correction 

functions provided by Dragon NaturallySpeaking to update text data on screen while maintaining 

consistency with Dragon NaturallySpeaking internal data. 
 

Of course, you can use keyboard operations to input text strings and delete text with the Voice Recognition 

Editor, the same as with standard text editor operations. Note, however, that deleting text using keyboard 

operations will also delete the corresponding dictation data. This is an unavoidable functional limitation of 

Dragon NaturallySpeaking. It is recommended that “Show Correction Dialog” or “Show Spell Dialog” be used 

whenever possible to edit text. 
 

 
x For the menu configuration when handling a dictation file for which voice recognition is 

incomplete, refer to “Menu List (Voice Recognition Editor/Real-time Voice Recognition)”. 
x When corrections to voice recognition results are finished, the file is moved to the adaptation 

data folder. 
For details refer to Correction Feedback after the data is moved to the Adaptation Data folder. 

 

Voice Recognition Complete Files 

Further add-on recording and/or voice recognition cannot be performed on a file that has been processed 
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with background voice recognition, or on a file that has been finished or sent for correction with real-time 

voice recognition. Because of this, the Voice Recognition Editor starts up alone, without linking with Dragon 

NaturallySpeaking. 
 

As with a file for which voice recognition is incomplete, the recorded dictation can be played back with the 

Voice Recognition Editor with the position of the text being played back highlighted on the screen. When 

correcting text, correct voice recognition results directly using keyboard operations. Using keyboard 

operations to delete text when voice recognition is complete will delete the dictation data that corresponds 

to the deleted text data, but the dictation data will not be deleted when text is deleted after voice recognition 

is complete. 

However, since there is no linking with Dragon NaturallySpeaking, use of the “Spell Dialog” and other editing 

functions provided by Dragon NaturallySpeaking is not supported. 
 

 
x For the menu configuration when handling a dictation file for which voice recognition is 

complete, refer to “Menu List (Voice Recognition Editor/Text Correction)”. 
x When corrections to voice recognition results are finished, the file is moved to the adaptation 

data folder. 
For details refer to Correction Feedback after the data is moved to the Adaptation Data folder. 
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3.13.6 Correcting Voice Recognition Results (Corrected by 
Transcriptionist) 
 

The author sends voice recognition results from real-time voice recognition and background voice 

recognition to the transcriptionist and the transcriptionist corrects it and feeds it back to the author, then the 

author adapts it and updates the DNS profile. 

The exchange for these corrections is done via the Adaptation Data folder of the Dictation Module and the 

Transcription Module. 

You must set either a shared folder, e-mail, or FTP as shown below to share corrections to voice recognition 

results. 

 

 Voice Recognition Results Sending Procedure 

1. The dictation files and voice recognition results files are stored in the Adaptation 

Data folder. 

 After they are stored, they are sent using the same method as normal dictation files. 

 

Item Description 

For Shared Folder The voice recognition results files are transferred via the path 
of the shared folder. 

For e-mail The voice recognition results files are transferred to the 
OutBox\E-mail folder. 

For FTP The voice recognition results files are transferred to the 
OutBox\FTP folder. 

 

 
The corrections to the voice recognition results stored in the OutBoxes are sent 
according to the transmission method stipulated for either e-mail or ftp. The standard 
sending procedure is used for sending. Refer to the following to change the settings for 
sending and receiving. 
=>[E-mail / FTP] - Send / Receive 

 

2. The transcriptionist manually edits the voice recognition results and sends the 

corrected file to the author. 

 The corrections are stored in the author's Adaptation Data folder. 

3.13.7 Correction Feedback 
 

The corrections to the voice recognition results that are stored in the Adaptation Data folder are applied to 

the Dragon Naturally Speaking dictionary. 
 
The Dictation Module supports two-step adaptation. 
 

x Vocabulary Adaptation 
Vocabulary adaptation learns the sentence structures of the author, terms that are not known by 

the Dragon NaturallySpeaking engine, etc. 

Vocabulary adaptation processing can be completed within a relatively short time. 
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x Acoustic Adaptation 
Acoustic adaptation analyzes and allows learning of acoustic characteristics such as the noise level 

of the input sound, microphone characteristics, author voice characteristics, etc. 

Acoustic adaptation processing takes a relatively longer time than vocabulary adaptation. 
 

Configuring option settings to execute adaptation will cause dictation files to be added to an adaptation 

queue when voice recognition and text correction is complete. This applies to both background voice 

recognition and real-time voice recognition (when [Finished] is executed). 
 

The Dictation Module must execute the two types of adaptation in the sequence above. Acoustic adaptation 

cannot be performed on a dictation file unless vocabulary adaptation has been performed. 
 

The following procedure explains execution of adaptation following background voice recognition. 

 Procedure 

1. In the Adaptation Data folder, select a file on which to run adaptation, right click it 

and select [Add to Adaptation Waiting List]. 

 The selected file is registered to the adaptation waiting list. 

2. When corrections for all the dictation files are finished, select [Voice Recognition] - 

[Adapt All Files] from the menu. 

 First perform vocabulary adaption and then acoustic adaptation on all of the dictation files in 
the adaptation queue. If any dictation file already has had vocabulary adaptation performed, 
perform acoustic adaptation only for that file. 
A progress bar will appear above the adaptation queue to indicate the progress of the process. 

 

 
x To perform vocabulary adaptation only, perform [Do Vocabulary Adaptation]. 

This will perform vocabulary adaptation only on the dictation file selected in the 
adaptation queue. 

x To perform acoustic adaptation only, perform [Do Acoustic Adaptation]. This will 
perform acoustic adaptation only on the dictation file selected in the adaptation 
queue. 

3. If the Dragon NaturallySpeaking engine encounters an unknown term during 

vocabulary adaptation, a term registration dialog box will appear when vocabulary 

adaptation of all target files is complete. 

 Select the check boxes next to the terms you want the Dragon NaturallySpeaking engine to 
learn. 
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 [Written] shows the output when the term specified by [Spoken] is encountered during voice 
recognition. For example, when “mister” is specified for [Spoken] and “Mr.” for [Written], “Mr.” 
will be output in the voice recognition results when the word “mister” is spoken. To edit 
[Spoken] and [Written] entries, click Edit on the term registration dialog box and then use the 
term editing dialog box that appears for editing. 

 

 
x The same as when [Do Vocabulary Adaptation] is performed, if a term that is 

unknown to Dragon NaturallySpeaking is encountered during vocabulary adaptation, 
a term registration dialog box will appear when vocabulary adaptation of all target 
files is complete. 

 

4. Following vocabulary adaptation, perform acoustic adaptation on all of the target 

files. 

 A progress bar will appear above the adaptation queue to indicate the progress of the process. 
Files are deleted from the adaptation queue as both vocabulary adaptation and acoustic 
adaptation are complete. A file will remain in the adaptation queue whenever either type of 
adaptation fails for some reason. 
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44  Managing Files and Folders 
 
Folders in the Dictation Tree View and the Device Tree View can be edited for each application. 

 
The following functions are available. 

 

Editing a Folder in the Dictation Tray 

Editing the Properties of Audio and Document Files 

Backing Up a Downloaded Dictation File 

Encrypting and Decrypting a Dictation File 

Sorting Dictation Files 

Sharing a Dictation File with Transcriptionists 

Automatically Deleting Transcribed Dictation Files 

Searching for Dictation Files and Document Files 
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4.1 Editing a Folder in the Dictation Tray 
 
To edit a folder in the Dictation tray, follow the procedures below. 

 

 
Up to 20 one-byte characters can be used for a folder name (note that for a folder in a 
recorder, the maximum character count is 8). The following one-byte characters are 
unavailable: \ / : * ? " <=> | 

 

Creating a Folder 

Mounting a Folder 

Removing a Folder 

Renaming a Folder  

 

4.1.1 Creating a Folder 

 

To create a folder, perform the following steps. Folders can also be created with the [New] button in the 

Folder Design dialog box. 

 Procedure 

1. Select a folder in the Dictation Tree View and click [New Folder] on the context menu. 

Or select  in the Dictation Tree View. 
Or select [New Folder] from the File menu. 

 The Create New Folder dialog box will appear. 

2. Type in a folder name and click [OK]. 

 A subfolder will be created in the selected folder. 
 

4.1.2 Mounting a Folder 
 
This function adds a specified external folder path, as a custom folder, to the Dictation Tree View. As a result, 

it can be managed as a shortcut folder with Dictation Module. 

One can also be added with [Add] in the Folder Design dialog box. 

 Procedure 

1. Select the Dictation Tray in the Dictation Tree View and select [Add Folder] from the 

context menu. 

Or click  in the Dictation Tree View. 
Or select [Add Folder] from the [Folder] menu. 

 The Browse for Folder dialog box will appear. 
 

2. Select a folder name and click [OK]. 
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 The path to the specified folder will be registered as a shortcut folder in the Dictation tray. 
It can be managed with Dictation Module just like an actual folder. 

 

4.1.3 Removing a Folder 
 
To remove a shortcut folder previously created with [Add Folder], perform the following steps: 

 Procedure 

1. Select a shortcut folder in the Dictation Tree View and select [Remove Folder] from 

the context menu. 

Or select  from the Dictation Tree View. 
Or select [Remove Folder] from the [Folder] menu. 

 The selected shortcut folder will be removed. 
 

 
Only user-added shortcut folders can be deleted. Only the path to the registered folder 
is removed and the folder itself, including its dictation files, are not deleted. 

 

4.1.4 Renaming a Folder 
 
This function renames a folder. 

 

 
Folders whose context menus do not display [Rename] cannot be renamed. 

 

 Procedure 

1. Select a folder in the Dictation Tree View and select [Rename] from the context 

menu. 

Or select  from the Dictation Tree View. 
Or select [Rename Folder] from the [Folder] menu. 

 The folder name field will become editable. 

2. Type in a folder name and press [Enter]. 

 The folder name will be modified. 
 

 

� Up to 20 one-byte characters can be used for a folder name (note that for a folder in a 
recorder, the maximum character count is 8). The following one-byte characters are 
unavailable: \ / : * ? " <=> | 

� The method for renaming a device folder depends on the model.  
=> Configuring a Device of a Selected Model => [Device] 
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4.2 Editing the Properties of Audio and Document Files 
 

Dictation files and document files contain various types of information as their properties. To edit the 

properties of a file, the following methods are available. 

 

Editing in the Properties View 

In-line Editing 

Editing with the Job Data Dialog Box 

 

4.2.1 Editing in the Properties View 
 
To view the properties of a file, perform the following steps: 

 

 
The items displayed in gray cannot be edited.  

 

 Procedure 

1. Select a folder in the Dictation Tree View or Device Tree View. 

 Files in the folder will be listed in the Content List View. 

2. Select a file in the Content List View. 

 The properties of the selected file will be displayed in the Properties View. 

3. Modify the properties as needed. 

Items displayed in black can be edited. Click the edit box and select from the list or enter 
content. 

 Entered content will be reflected immediately. 

4.2.2 In-line Editing 
 
This function can edit the properties of a Dictation File directly in the Content List View. 

 Procedure 

1. Click  to change to . 

Or select [In-line Edit] from the View menu to change to . 

2. Right click the dictation file in the Content List View then select [Edit Item] from the 

context menu. 

Or select a Dictation file and click the cell to be modified. 
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 In editable items, text can be entered or a selectable Pull Down menu will appear. 

3. Edit the properties as needed. 

 Input data will be immediately reflected in the system. 
 

4.2.3 Editing with the Job Data Dialog Box 
 
This function can edit the job data (Author, Worktype ID, Option Items, and Comments) of a selected 

dictation file. 

 Procedure 

1. Right click a dictation file in the Content List View and select [Edit job Data] from the 

context menu. 

Or select  on the toolbar. 
Or select [Edit Job Data] from the File menu. 

 The Edit Job Data dialog box will appear. 

2. Edit the properties as needed. 

3. Click [OK]. 

 

Baltech Transponder 

Baltech Transponder Reader PAD allows use of its sensor inputs as text entries in the Edit Job Data dialog 

box. 

 Procedure 

1. Connect Baltech Transponder to a USB port on the PC. 

2. Select a dictation file in the Content List View and click  on the toolbar. 

Or select [Edit Job Data] from the File menu. 
 The Edit Job Data dialog box will appear. 

3. Select [Transponder is used] from the Options menu. 

  
 The Transponder Reader PAD will become available. 

4. Specify the target text entry box with the mouse. 
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If Baltech Transponder Reader PAD is disconnected and then reconnected, configure 
[Use Transponder] on the Options menu in step 3 again. 
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4.3 Backing Up a Downloaded Dictation File 
 
A dictation file can be backed up with either one of two methods: by automatic backup with backup 

configuration or by manual export to external media. 

 

Backing Up Automatically 

This method allows for automatic backup of Dictation files with pre-configuration. 

 Procedure 

1. Click  in the Dictation Tree View. 

Or select [Options] from the [Tool] menu. 
The Folder Design Dialog Box or the Folder Design Options tab will appear. 

2. Enable Backup under Actions in the Folder Properties box. 

 With this setting, each time a file is updated, its backup file will be created and stored in the 
Backup folder. 

 

 
Files in the Backup folder can be deleted after a certain length of time. To achieve this, 
set the Purge attribute of the Backup folder.  

=>[Folder Design] - Actions - Purge 
 

Backing Up Manually 

With operations such as copying, exporting, and dragging and dropping, a file can be manually backed up. 
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4.4 Encrypting and Decrypting a Dictation File 
 
Encryption ensures that important files are securely maintained. 

Encryption is applied per file or per folder. 

An encrypted file can only be played once the correct password has been entered. 

 

 
About Dictation File Encryption 
x Encryption of dictation files other than DSS Pro files uses the same Olympus 

proprietary format as that of DSS Player Pro R4/R5. They cannot be decrypted using 
another company's software, etc. 

x With DSS Pro, encryption is performed in accordance with DSS Pro specifications. 
They can be decrypted using another company's software if it supports DSS Pro 
format. In the case of Olympus software, DSS Pro format is supported by DSS Player 
Pro R5 and higher only. Decryption cannot be performed by DSS Player Pro R4. 

 
With the Encryption attribute set to [Yes] for a folder, files in that folder are 
automatically encrypted with the password set under Attribute. With a password not 
configured under Attribute, the Encryption Password dialog box will appear when a file 
is dropped into the folder.  

=>[Folder Design] - Attributes - Encryption/Password 

 

Encrypting per File 

Encrypting per Folder 

Decrypting a File 

 

4.4.1 Encrypting per File 
 
To encrypt a single file, follow the procedure below.  

Encrypting "filename.dss" changes its extension, turning the file name into "filename.$dss". Encrypting a 

DSS Pro file does not affect its extension. 

 Procedure 

1. Select an unencrypted Dictation file in the Content List View and click [Encrypt] on 

the context menu. 

Or click  on the standard toolbar. 
Or select [Encrypt] from the [File] menu. 

 The Encryption Password dialog box will appear. 
 

2. Type in a password in the Password and Confirm Password fields using 4 to 16 

alphanumeric characters. 

In the case of a DSS Pro format file, encryption format settings can also be 
configured. 
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z In the case of DSS Pro format, encryption format settings can be configured. Files are 

encrypted using a 128-bit encryption key in Standard mode, and a 256-bit encryption 
key in High mode. 

z The password is the same in Standard mode and High mode. An encryption key, 
suitable for the specified encryption mode, is generated from the password, with a 
key length that is in accordance with the encryption mode set within the program. 

3. Click [OK]. 

 The file will be encrypted. Clicking [Cancel] cancels the encryption. 
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4.4.2 Encrypting per Folder 
 
With a folder configured for encryption, files in the folder are automatically encrypted with the password set 

for the folder. An encrypted file is displayed with the Encryption icon ( ) in the Encrypted column ( ) in the 

Content List View. 

Encrypting "filename.dss" changes its extension, turning the file name into "filename.$dss". Encrypting a 

DSS Pro file does not affect its extension. 

 

 
When created under an encrypted folder, a subfolder automatically inherits the 
encryption setting from the parent folder. 

 

 Procedure 

1. Select a folder to be encrypted and click . 

Or select [Options] from the [Tool] menu and open the Folder Design tab to select a 
folder. 

 The Folder Settings dialog box or Folder Design dialog box in the Option Settings will appear. 

2. Enable the Encryption attribute in the Folder Properties dialog box. 

3. Click  next to “Password” in the Folder Properties dialog box. 

 The Encryption Password dialog box will appear. 
 

4. Type in a password in the Password and Confirm Password fields using 4 to 16 

alphanumeric characters. 

In the case of a DSS Pro format file, encryption format settings can also be 
configured. 

 
z Encryption format settings are used for auto encryption of DSS Pro format files. 

There is no difference in the encryption format when auto encrypting non-DSS Pro 
format files. 

z Files are encrypted using a 128-bit encryption key in Standard mode, and a 256-bit 
encryption key in High mode. 

z The password is the same in Standard mode and High mode. An encryption key, 
suitable for the specified encryption mode, is generated from the password, with a 
key length that is in accordance with the encryption mode set within the program. 

5. Click [OK]. 

 The folder will be encrypted. If there are any files already located in the folder, a message will 
appear asking the user whether or not to encrypt those files. Clicking [Yes] will encrypt all of the 
files currently located in the folder. 

 
For subsequent operations, files will be encrypted as soon as they are stored in the folder. 
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4.4.3 Decrypting a File 

 

To decrypt an encrypted file, perform the following steps: 

  

 Procedure 

1. Select an encrypted Dictation File in the Dictation Tree View and select [Decrypt] 

from the context menu. 

Or select the Dictation File and click  on the standard toolbar. 
Or select the Dictation File and select [Decrypt] from the File menu. 
 

 The Decryption Password dialog box will appear. If the password used when the file was 
encrypted has already been registered, the Decryption Password dialog box will not appear and 
decryption will start immediately. 

2. Type in the password used for encryption and click [OK]. 

 The file will be decrypted and can then be played. 
 

 
z The DSS Pro file encryption mode (Standard or High) is automatically determined by 

the Dictation Module for each file, and then the appropriate encryption process is 
performed. 

z The password is the same in Standard mode and High mode. An encryption key, 
suitable for the specified encryption mode, is generated from the password, with a 
key length that is in accordance with the encryption mode set within the program. 
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4.5 Sorting Dictation Files 
 
When dictation files are downloaded from a recorder, they can be sorted and routed to particular download 

destinations based on their Author ID or Worktype ID. Or dictation files from all of the folders on a device, 

regardless of the file properties, can be downloaded and collected into a single folder on a PC. Settings need 

to be pre-configured to sort downloaded files. 

 

With the following settings configured, dictation files are sorted by Author ID/Worktype ID into their 

specified folders when they are downloaded from the device. 

 

Configuring Automatic Sorting of Downloaded Files 

Registering the Author List with the Recorder 

Registering the Worktype ID with the Recorder 

 

4.5.1 Configuring Automatic Sorting of Downloaded Files 
 
This section describes how to define the rules on sorting downloaded or imported dictation files into different 

folders. 

The procedure you need to perform depends on auto sorting conditions. 

 Procedure A 
Use the following procedure to configure settings to download the file from the folders on a recorder and 

collect them into a single folder. 

1. Select [Option] from the Tool menu. 

 The Option Settings dialog box will appear. 

2. Click the Workflow tab. 

 The Option Settings Workflow dialog box will appear. 
 

3. On the menu tree, click [Advanced Download]. 

 The auto sort settings information screen will appear in the right frame. 

4. Select the [Download all dictations to..] check box. 

This enables the auto sort function. 

5. Select [Specific folder]. 

 This enables the  buttons. 

6. Click the  button and then use the Select Folder dialog box that appears to 
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specify the folder you want to use as the download destination to collect the files. 

 Procedure B 
Use the following procedure to configure settings when to route files to download destination folders 

based on their Author ID or Worktype ID. 

1. On the [Tools] menu, click [Options]. 

 The Option Settings dialog box will appear. 

2. Click the Workflow tab. 

 The Option Settings Workflow dialog box will appear. 

3. On the menu tree, click [Advanced Download]. 

 The auto sort settings information screen will appear in the right frame. 

4. Select the [Download all dictations to..] check box. 

This enables the auto sort function. 

5. Select [Routing according to the following conditions]. 

This enables the routing condition list. 

6. Click [Add]. 

 The Rule Settings dialog box will appear. 

7. In the Rule Settings dialog box, specify the Author ID/Worktype ID and the 

destination folder name, and then click [OK]. 

 
z When Author ID and Worktype ID are both specified, only dictation files that match 

both criteria are routed to the specified folder. 

z When either Author ID or Worktype ID is specified, the non-specified condition is 
interpreted as “unconditional”, which is interpreted as everything matching. In this 
case, routing is performed in accordance with the specified condition only. 

8. You can use the  buttons to change the application sequence of the routing 

conditions. Matching is performed proceeding through conditions from the top of the 

list. 

9. After all of the routing conditions are configured the way you want, click [OK]. 

Clicking the [Apply] button will apply the configured rules. 

 
z You can modify an existing rule by selecting it in the routing list and then clicking the 

[Modify] button.  An existing rule can be deleted by clicking the [Remove] button. 

 

4.5.2 Registering the Author List with the Recorder 
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The Author list can be registered with the recorder in the case of the following devices. 

x DS-7000 

x DS-5000/5000iD 

x DS-3500 

x DS-3400 
 

 
If required Authors are not registered, register them in the Workflow dialog box.  

=>[Workflow] - Author 

 

 Procedure 

1. Connect a supported device to a USB port on the PC. 

2. Switch on the device. 

 The Main window will automatically open. 
The Device Tree View will display the model of the recorder and file information. 

 

 
When connecting or disconnecting the device while the Main window is open, device 
information will be updated in the Device Tree View. 

3. Click  in the Device Tree View. 

Or select [Device Settings] from the Device menu. 
 The Device Settings dialog box for the supported model will appear. 

4. Select [Author List] from the menu tree. 

 The right frame will show the Author IDs registered with [Workflow] – [Author] on the Option 
Settings dialog box. 
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5. Check Author IDs to be registered with the recorder, and then click [Apply]. 

If you want to prompt for Author selection on the recorder whenever power is turned on, 
select the “Prompt for author ID at Power-on” check box. 

6. Click  and select [All pages] or [Only this page]. 

 The “Author IDs” and “Priority Level” will be transferred to the device. 
 

4.5.3 Registering the Worktype ID with the Recorder 
 
The Worktype ID list can be registered with the recorder in the case of the following devices. 

x DS-7000 

x DS-5000/5000iD 

x DS-3500 

x DS-3400 
 

 
If the required Worktype is not registered, use the Workflow dialog box to register it. 
=>[Workflow] - Worktype 

 Procedure 

1. Connect a supported device to a USB port on the PC. 

2. Switch on the device. 

 The Main window will automatically launch. 
The Device Tree View will display the model of the recorder and file information. 

 

 
When connecting or disconnecting the device while the Main window is open, device 
information will be updated in the Device Tree View. 

3. Click  in the Device Tree View. 

Or select [Device Settings] from the [Device] menu. 

 The Device Settings dialog box will appear. 

4. On the menu tree, click Worktype List. 

 The right frame will show the Worktype IDs registered with [Workflow] – [Worktype] on the 
Option Settings dialog box. 
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5. Select the check box next to the ID of the recorder you want to register and then 

click the [Apply] button. 

If you want to prompt for selection of the Worktype ID on the recorder whenever 
recording is performed, select the “Prompt for Worktype ID on new recordings” check 
box. 

6. Click  and then select [All pages] or [Only this page]. 

 The Worktype ID is transferred to the connected device. 
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4.6 Sharing a Dictation File with Transcriptionists 
 
A shared folder allows for file sharing with Transcriptionists. 

This section illustrates how to create a new custom folder and configure it for sharing. It explains the 

procedure for sharing dictation files by placing them into the folder. The shared folder is configured with 

access permission for both Transcriptionists and Authors. 

 

 
File sharing requires configurations on both Dictation Module and Transcription Module. 

 

 Procedure 

1. Create a shared network folder which can be accessed by Transcriptionists and 

Authors. 

2. Right-click the [Dictation Tray] in the Dictation Tree View and select [Add Folder] 

from the context menu. 

 The Browse For Folder dialog box will appear. 
 

3. Specify the folder created in step 1 and click [OK]. 

 A new custom folder will be created. 

4. Verify sharing for the folder created in step 1 to 3 is enabled. 

Both Transcriptionists and Authors should be able to access the shared folder. 
 

5. Drag and drop a dictation file to be shared into the folder created above. 

 Both Transcriptionists and Authors will be able to access the same Dictation File. 
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4.7 Automatically Deleting Transcribed Dictation Files 
 
With this function enabled, transcribed dictation files are automatically deleted. 

This function can automatically carry out a clean-up and purge of transcribed dictation files per folder after 

a specified length of time. 

 

The following procedure describes how to move a dictation file to the Recycle Box with the Cleaning setting 

after one month of storage in the Transcription Finished folder, and to eventually delete it permanently after 

two weeks of storage in the Recycle Box. 

 

 Procedure 

1. Select [Option] from the Tool menu. 

2. Click the Finished folder in the Folder tree in the Folder Design dialog box. 

3. Select the “Clean” and click . 

 The Cleaning Settings dialog box will appear. 
 

4. Check “Enable Cleaning”, select “1 Month(s)” for the interval, select “Move To 

Recycle Box” for the option setting, and then click [OK]. 

5. Click the Recycle Box folder. 

6. Select the “Purge” and click . 

 The Purge Settings dialog box will appear. 

7. Check “Enable Purge”, select “2 week(s)”, and then click [OK]. 
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4.8 Searching for Dictation Files and Document Files 
This function lets you locate a file in the content list view. This is useful for situations where there are many 

files in the list. 

 

Simple File Name Search 

Column Item Search 

 

4.8.1 Simple File Name Search 

You can easily search for a file name by using the following procedure. 

 Procedure 

1. Open the dictation or document list view. 

2. Use the keyboard to type the file name, of the file you want to find, from the 

beginning in order. 

 The files are searched using the text as you type it in incrementally, files that match the search 
conditions are selected. 

 

4.8.2 Column Item Search 

You can easily search for file names and columns of files by using the following procedure. 

 Procedure 

1. Press [Ctrl] + [F] on the keyboard. 

 The Search dialog box will appear. 

2. Type the text string, and select the column and search method, then press the [Next] 

button. 

 The list view is updated, and the focus moves to the files that match the search conditions. 
 
You can change the column being searched in Search Column. 
You can select whether to search for a target that starts with the text string or one 
that contains it. 
The [Next] button searches forward and the [Previous] button searches backward. 
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You can customize the short cut key used for searching columns in the User Setting 
dialog box. 

=>[User Setting] - Keyboard 
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55  Customizing Dictation Module 
 
This chapter describes how to make the module easier to use by modifying the window appearance and key 

assignments. 

 

The following functions are available. 

 

Customizing the Work Area 

Customizing the Content List View 

Assigning Hot Keys  
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5.1 Customizing the Work Area 
 
The work area of the Main window consists of the four parts listed in the following table. These views, except 

the Content List View, can be shown or hidden as needed. 

 

Name Hidden Default 

Dictation Tree View Yes Shown 
Device Tree View  Yes Shown 
Content List View Always shown Always shown 
Infomation View Yes Hidden 
Properties View Yes Hidden 
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5.2 Customizing the Content List View 
The display of files in the 5Content List View can be customized in various ways. 

The following methods are available. 

 

Interchanging Displayed Columns 

Sorting Displayed Files 

Changing the Columns Displayed in the Content List View  

Filtering Displayed Files  

 

5.2.1 Interchanging Displayed Columns 
 
To change the order of displayed columns, perform the following steps: 

 Procedure 

1. Select a column name, and then drag and drop it. 

 The order of the displayed columns will change. 
 

 
Changing the Columns Displayed in the Content List View 

 
 

5.2.2 Sorting Displayed Files 
 
To change the order of displayed files, perform the following steps: 

 Procedure 

1. Select [Sort by] from the View menu. 

 Files will be sorted from the selected column in ascending order. If the current sorting option is 
selected again, it will alternate between ascending and descending order. 

 

5.2.3 Changing the Columns Displayed in the Content List View 
 
To show or hide the columns in the Content List View, perform the following steps: 

 

 
The file name and priority cannot be hidden. 

 

 Procedure A 

1. Right-click on one of columns in the Content List View. 

 The list of column headers will be displayed as a context menu. 
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2. Click a column to show or hide it. 

 

 Procedure B 

1. Select [Columns to Display] from the View menu. 

 The Columns to Display dialog box will appear. 
 

  

2. Select the Folder type. 

3. Use [>>] and [<<] to move the columns. 

The columns placed in the [Columns to Display] box are displayed in the Content List 
View. 
To change the order of displayed columns, use [Up] and [Down]. 
Clicking [Reset] returns the displayed columns to the default setting. 

4. Click [OK]. 

 The window will close and the display of the Content List View will be updated. 
 

 
� Displayed Property List (Dictation File List View) 
� Displayed Property List (Document List View) 
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5.2.4 Filtering Displayed Files 
 
The filtering function for column headers can filter columns to display. 

 

 
� Displayed Property List (Dictation File List View) 
� Displayed Property List (Document List View) 

 

 Procedure 

1. Click  in the Content List View. 

Or select [Filter On/Off] from the [View] menu. 
 The filtering function will be enabled and  will be displayed for each column header. When a 

filtering condition has been set for a column, the button for the column turns to . 

  

2. Click  and select a condition from the list box. 

Selecting “All” disables the filter for the current column. 
For the columns whose date and time, number, or length can be specified, the Filters 
Option dialog box will appear when [Option] is pressed. Configure their conditions based 
on the instructions provided. 

 Only files that meet the configured conditions will be displayed in the Content List View. 
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5.3 Assigning Hot Keys 
 
The User Settings dialog box allows for verification and modification of key assignments for commands. 

Key assignments are configured in the User Settings dialog box.  

=>[User Settings] - Keyboard 

 

The functional scope of an assigned key depends on the Hot key settings, which are configured with [Hot key 

On/Off] on the Tool menu. 

With Hot key set to “Off”, the commands are executed only when the window is active. 

With Hot key set to “On”, the commands are executed regardless of whether or not the window is active. 

Commands assigned to keys are operational even if another window is open on the display on top of the 

Dictation Module screen. 

 

 
For information on default key assignments for each function, 
 refer to Default Key Assignments. 
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66  Configuring with the Device Connected 
 
This chapter describes how to control the functions provided by the device via Dictation Module. 

 

Switching the Device Mode 

Using the Device as a USB Speaker / Microphone 

Transferring the Date and Time 
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6.1 Switching the Device Mode 
 
Dictation Module automatically switches the recorder to Composite mode when the Direct Recording window 

opens. When returning to the Main window after a recording has been completed, the recorder will 

automatically switch back to Storage mode. Storage and Composite modes can also be switched manually. 

To manually switch the device mode, perform the following steps: 

 Procedure 

1. Right-click a device and select [Change Device Mode] from the context menu. 

Or select the device and click . 
 The mode of selected device will be changed. 

 
 



116 / 253 

6.2 Using the Device as a USB Speaker / Microphone 
 
A recorder connected to a PC as a USB audio device can be used as a microphone or speaker. 

 

 
USB speaker and USB microphone capabilities cannot be used simultaneously. 

 
For support for each device model, refer to Functional Support of Recorders. 

 

Using a Recorder as a USB Microphone 

A supported recorder can be used as a microphone when making a recording with Dictation Module. 

 Procedure 

1. Connect a recorder to the PC. 

 The Main window will automatically open. 
Displaying the Direct Recording window automatically enables use as a USB microphone. 

 

Using a Recorder as a USB Speaker 

A supported recorder can be used as a speaker when playing sound. When specified as a speaker with DSS 

Player, a digital voice recorder will be used as a speaker by other software on the PC as well. 

 Procedure 

1. Connect a recorder to the PC. 

 The Main window will automatically open. 

2. Switch the recorder to Composite mode by selecting [Change Device Mode] from the 

Device menu. 

3. Select [Select Speaker] - [Olympus Device Speaker] from the Tool menu. 

 The USB-connected recorder can now be used as a speaker. 
 

 
If several devices are connected, click [Change Device Mode] on the Device menu to 
display the Device Select Dialog Box. Select the device and click [OK]. 
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6.3 Transferring the Date and Time 
 

To transfer date and time data from the PC to a recorder, perform the following steps: 

 Procedure 

1. Right-click the device and select [Synchronize Date/Time] from the context menu. 

Or click  on the toolbar. 
 Date and time data will be transferred to the recorder. 

 

 
Transferring can be performed when the device mode is Storage mode, but not when it 
is Audio mode. 
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77  Configuring and Customizing the Device 
 
With device configuration, the settings of each device can be obtained, configured, read, and saved. 

The configurable setting items of a device are displayed in categorized tree form. Clicking an item in the tree 

switches the window to display the corresponding settings. 

 

Configuring for a Connected Device 

Configuring for a Selected Device Model 

 



119 / 253 

7.1 Configuring for a Connected Device 
 
To configure the settings of a connected device, perform the following steps: 

 Procedure 

1. Select a device in the Device Tree View and select [Device Settings] from the context 

menu. 

Or click  in the Device Tree View. 
 The Device Setting dialog box will appear. 

2. Edit the settings as needed. 

For details on the configuration, refer to ”Device”. 
[Load]: Clicking this button loads the settings of the connected device. 
[Update]: Clicking this button updates the settings of the connected device. 
[Reset]: Clicking this button returns the settings of the connected device to the default 

settings. 

[Set Job Number]: The job number can be set in the range of 0 to 9999. 
 

 
Only job numbers that are larger than the current number can be set. All 
the files in a device must be deleted before a smaller job number can be 
set. 

 

3. Click [OK]. 

 The settings will be saved and the window will close. 
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7.2 Configuring for a Selected Device Model 
 
The following procedure shows how to configure the settings for a selected device model, regardless of 

whether or not the device is connected: 

 Procedure 

1. Select [Options] from the Tool menu. 

2. Click the Device tab. 

 The Device dialog box will appear. It will display the same information as the Device Setting 
dialog box. 

3. Use the drop-down list in the upper left to select the model name of the device you 

want to configure. 

4. Configure option settings as required. 

For details on the configuration, refer to ”Device”. Connecting the model you selected in 
step 3 to the PC will enable updating of the settings of the connected device using the 
buttons listed below. 

[Load]: Clicking this button loads the settings of the connected device. 
[Update]: Clicking this button updates the settings of the connected device. 
[Reset]: Clicking this button returns the settings of the connected device to the default settings. 

[Set Job Number]: The job number can be set in the range of 0 to 9999. 
 

 
Only job numbers that are larger than the current number can be set. All 
the files in a device must be deleted before a smaller job number can be 
set. 

 

5. Click [OK]. 

 The settings will be saved and the window will close. 
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88  Option Settings on Operating Conditions 
 
This chapter describes how to configure the operating conditions of Dictation Module. 

 
When ODMS R6 is operated as a Workgroup system, the System Configuration Program manages the users 

on a per-Workgroup basis. The items with the lock icon  listed in the table below are managed by the 

System Configuration Program, prohibiting Authors from modifying them.  

To modify these items, contact the Administrator. 

 

Category Functions 

Folder Design Designs the folders used by an Author or Transcriptionist 
Workflow Configures the workflows performed by an Author or 

Transcriptionist 
User Settings Configures items related to usability 
E-mail / FTP Configures email or FTP for users 
Device Configures the devices used by an Author or 

Transcriptionist 
Updates Configures the updates for software or firmware 

 
Folder Design 

Workflow 

User Settings 

E-mail / FTP 

Device 

Updates 
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8.1 Folder Design 
 
This category is provided to customize the folders for storage of audio and document files. 

The items with the lock icon  can only be enabled or disabled by the Administrator. 

 Procedure 

1. Select [Options] from the Tool menu. 

2. Click [Folder Design]. 

 The Folder Design dialog box will appear. 

3. Select a folder to be configured from the folder tree on the left, and configure its 

settings in the Folder Properties box on the right. 

[OK]: Secures the settings 
[Cancel]: Exits without modifying the settings 
[Apply]: Reflects changes to the configuration file 

 

 
For information on applications and functions of the Dictation Tray and 
Document Tray, refer to How Folders Work. 

 
Folder Properties 

Attributes 

Actions  

 

8.1.1 Folder Properties 
 
The Folder Properties box displays the properties of a folder selected from the folder tree. 

Properties are configured for each folder. 

Configurable properties vary depending on the folder type. 

 
Attributes 

Enabled 

Name 

Synchronize Folder Name 

Path 

Encryption 

Password 

Ownership 

Document Type 

Actions 

Auto Download 

Format Conversion 
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Send via E-mail 

Send via E-mail (Alternate Profile) 

Send via FTP 

Send via FTP (Alternate Profile) 

Backup 

Clean 

Purge 

 

 
How to configure the properties 

The properties can be configured with either one of the following two 
methods: By clicking [+], or by clicking  to display a dialog box where 
they can be configured. Both ways allow for configuration of the 
properties. 

8.1.2 Attributes 

 

Enabled 

Name 

Synchronize Folder Name 

Path 

Encryption 

Password 

Ownership 

Document Type 

 

Enabled 

This attribute sets whether or not to display the folder in the folder tree. 

This setting works with the ON/OFF setting of the checkbox in the folder tree. 

With this attribute set to False (Hidden), the folder is not displayed in the application's folder tree, and files 

cannot be manipulated (downloaded, imported, moved, or copied) with the folder. 
 

Name 

This attribute sets the folder name. 

It can be entered by clicking on the cell. 
 

Synchronize Folder Name 

When this is enabled, the Name attribute will automatically change to the same name of the folder specified 

through the Path attribute. 
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Path 

This attribute sets the folder path. It can be configured using the Browse for Folder dialog box, which is 

displayed by clicking . 
 

Encryption 

With the Encryption attribute set to “Yes”, files in the folder are encrypted. Moving the folder does not affect 

the Encryption attribute. 
 

Password 

If the Encryption attribute is enabled, the encryption password for files stored in the folder needs to be 

specified. 

The password is set or modified in the Change Password dialog box, which is displayed by clicking . 

It can be specified using 4 to 16 one-byte alphanumeric characters. 

DSSPro Encryption Format configures the strength of security settings for encryption of files recorded with 

the DSS Pro format. “High” can implement a more secure encryption. 

 
z Files are encrypted using a 128-bit encryption key in Standard mode, and a 256-bit 

encryption key in High mode. 

z The password is the same in Standard mode and High mode. An encryption key, suitable 
for the specified encryption mode, is generated from the password, with a key length 
that is in accordance with the encryption mode set within the program. 

 

Ownership 

With the Ownership attribute set to “Yes”, a dictation file is not moved to the Transcription Module Finished 

folder even after it has been transcribed. 

The Ownership attribute can be set for the Download tray and custom folders. Their subfolders will also have 

the same Ownership attribute. 

 

Ownership Auto Collection Transcription Finished Dictation files  

Yes Moved to the Finished folder in Dictation 
Module (set as a rule) 

Yes 

No Not moved 
Yes Moved to the Finished folder in Transcription 

Module (set as a rule) 
No 

No Not moved 

 

 
For the fundamentals of the Ownership attribute, refer to Ownership 
Attribute. 

 

Document Type 

This is an attribute configured for the Document tray. It sets the supported types (extensions) of document 

files. 
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The extensions of document files are registered in the Supported Document Type dialog box, which is 

displayed by clicking . 

Up to 100 extensions can be configured. 
 

8.1.3 Actions 

The following folder actions can be configured. 

 
Auto Download 

Format Conversion 

Send via E-mail 

Send via E-mail (Alternate Profile) 

Send via FTP 

Send via FTP (Alternate Profile) 

Backup 

Clean 

Purge 

 

Auto Download 

This option sets whether or not to automatically download dictation files from the recorder. 

When this option is set to ”Yes”, dictation files are automatically downloaded from various storage media 

detected in the device. When they have been downloaded successfully, a completion message is temporarily 

displayed. 
 

Format Conversion 

This option sets automatic conversion of files stored in the folder. 

 

By clicking [+], format conversion can be configured. 

Enabled : Enables or disables auto format conversion 

Target Format : Selects the file format 

Format Attributes : Selects the audio format 

Original Dictation : Deletes the original file after conversion 

These settings can also be configured in the Convert Dictation Settings dialog box, which is displayed by 

clicking . 
 

Send via E-mail 

This option sets whether or not to automatically send the folder files via email. 

 

By clicking [+], automatic transmission via email can be configured. 
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Auto Send : Enables or disables automatic transmission via email 

Profile : Selects a profile for automatic transmission 

TO : The destination of an email 

CC : Additional destinations disclosed to the recipients 

BCC : Additional destinations not disclosed to the recipients 

Subject : The title of an email 

Message : The main message of an email 

Confirmation Dialog box : Shows or hides the confirmation dialog box when an email is 

automatically sent 

These settings can also be configured in the Set E-mail Destinations dialog box, which is displayed by 

clicking . 

 

x With multiple E-mail profiles configured, the “Select E-mail Profile” dialog box will appear. 

x With no email profiles configured, the confirmation dialog box will appear, allowing the creation of a 

new email profile. 

=>E-mail / FTP 

 
 

Send via E-mail (Alternate Profile) 

Setting the “Auto Send” attribute to [Yes] enables the alternate setting for “Auto Send via E-mail”. 

This profile is used for sending an email when it cannot be sent with the “Auto Send via E-mail” profile. 

If it cannot be sent with either "Auto Send via E-mail” or “Auto Send via E-mail (Alternate)”, a warning 

message will appear, allowing the user to decide which profile to use. 
 

Send via FTP 

This option sets whether or not to automatically send the folder files via FTP. 

 

By clicking [+] , automatic transmission via FTP can be configured. 

Auto Send : Enables or disables automatic transmission via FTP 

Profile : The profile used for automatic transmission 

Confirmation Dialog box : Shows or hides the confirmation dialog box when a file is 

automatically sent 

 
These settings can also be configured in the Set FTP Destinations dialog box, which is displayed by clicking 

. 

 
With no FTP profiles configured, the confirmation dialog box will appear, allowing the creation of a 

new FTP profile.  

=>E-mail / FTP 
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Send via FTP (Alternate Profile) 

Setting the “Auto Send” attribute to “Yes” enables the alternate setting for “Auto Send via FTP”. 

This profile is used to try sending a file via FTP when it cannot be sent with the “Auto Send via FTP” profile. 

If it cannot be sent with either “Auto Send via FTP” or “Auto Send via FTP (Alternate)”, a warning message 

will appear, allowing the user to decide which profile to use. 
 

Backup 

When “Backup” is enabled, the files in the folder are backed up to the Backup folder. 
 

Clean 

This option sets the retention period for the files in the folder. 

The settings include whether or not to move the files to the Recycle Box and whether or not to delete them 

permanently once the retention period has expired. 

Retention Period : Sets the length of time until file cleaning occurs after the files have been 

moved to the Finished/Sent Items folder 

Value : 1-99 

Unit : Month(s)/Week(s)/Day(s) 

 

By clicking [+] , the cleaning function can be configured. 

Enabled : Enables or disables the cleaning function 

Aging period : The minimum age of files to which cleaning is applied (Default: 1 month) 

Option : The conditions for deleting cleaned files 

 

These settings can also be configured in the Cleaning Settings dialog box, which is displayed by clicking . 
 

Purge 

This option is configured for the Backup folder or Recycle Box. When Purge is enabled, the files in the folder 

will be automatically deleted (purged) after the retention period has expired. 

 

By clicking [+] , the purge function can be configured. 

Enabled : Enables or disables the purge function 

Target : The minimum age of files to which purging is applied (Default: 1 month) 

Value : 1-99 

Unit : Month(s)/Week(s)/Day(s) 

 

These settings can also be configured in the Purge Settings dialog box, which is displayed by clicking . 
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8.2 Workflow 
 
The ODMS R6 provides a Workflow, a configured series of operations when downloading and editing a 

dictation file. 

The items with the lock icon  can only be enabled or disabled by the Administrator. 

 Procedure 

1. Select [Options] from the Tool menu. 

2. Click [Workflow]. 

 The Workflow dialog box will appear. 

3. Select an item from the tree on the left and configure it on the right. 

[OK]: Secures the settings 
[Cancel]: Exits without modifying the settings 
[Apply]: Reflects changes to the configuration file 

 
General 

Download 

Advanced Download 

Import 

Author 

Worktype 

Direct Recording 

Hands Free Recording 

Voice recognition - General 

Voice recognition – Real-time Voice Recognition 

Voice recognition – Background Voice Recognition 

Voice recognition – Text CorrectionHands Free Recording 

Voice recognition – Template 

Voice recognition – Dragon NaturallySpeaking 

Receive 

Notification 

Auto Collection 

Logging 

 

8.2.1 General 

 

This category configures the general settings for a workflow. 

The items with the lock icon  can only be enabled or disabled by the Administrator. 
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DSS Classic 

Delete Option 

Device Synchronization 

Filename Resolution 

Refresh Interval 

 

DSS Classic 

Select this checkbox only if accessing shared folders on the network using DSSPlayer Pro R4. 
 

Delete Option 

This option selects how to handle a dictation file when it has been deleted using [Delete] on the Edit menu 

or the [Ctrl+D] shortcut keys. 

x When “Move to Recycle Box” is selected, deleted files are moved to the Recycle Box. 

x When “Delete completely” is selected, deleted files are permanently deleted. 

 

 

� With “Move to Recycle Box” selected for “Delete Option”, pressing 
[Shift]+[Delete] executes “Delete completely”.  

� With “Delete completely” selected for “Delete Option”, pressing 
[Shift]+[Delete] executes “Move to Recycle Box”. 

� This option can only affect dictation files. Deleting a document file 
always executes “Delete completely”, resulting in permanent deletion. 

 

Device Synchronization 

This option sets whether or not to automatically synchronize the DVR (recorder) clock setting with the time 

on the PC when the DVR is connected to the PC. 

When “Do not display dialog” is enabled, the DVR clock will synchronize with the PC time settings without 

displaying a confirmation dialog. 
 

Filename Resolution 

This option sets whether or not to rename a dictation file when it is downloaded, imported, or dragged and 

dropped. 

x When “Automatic rename” is selected, the file is automatically renamed if there is a file with the same 

name in the destination folder. 

x When “Prompt user for Action” is selected, after receiving a message, the user can select overwriting 

or renaming of the file if there is a file with the same name in the destination folder. 
 

 

Refresh Interval 

This option configures refreshing of the current folder. 
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x When “Refresh folders automatically every” is enabled, the file information displayed in the Content 

List View is periodically refreshed. The refresh interval is configured with “Refresh interval” (1-999 

minutes).  
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8.2.2 Download 

This category configures operations when a dictation file is downloaded. 

For a downloaded file, the message displayed, file naming rule, and deletion criteria can be configured. 

The items with the lock icon  can only be enabled or disabled by the Administrator. 

 
Automatic Download 

Job Data Settings 

Rename 

Delete 

 

Automatic Download 

The automatic download option enables the PC to automatically receive audio data from the device after 

detecting it. 

The following settings can be configured only for automatic-download-enabled folders. 

Do not display the main window 

When this option is enabled, detection of a device auto starts the Dictation Module without 

displaying the Main window, performs auto download only, and then exits the Dictation Module. 

Prompt for selecting the file to be downloaded 

When “Prompt for selecting the file to download” is enabled, the dialog box for selecting the files to 

download appears when they are downloaded. Only the files you have selected will be downloaded. 
 
 

Job Data Settings 

If “Prompt for data every time a file is downloaded” is enabled, the Edit Job Data dialog box is displayed 

when downloading files. 

You can confirm the following settings as you download. 

x File name, Author ID, Worktype ID, Option Item, Comment  

x Attributes: High Priority, Priority Level, File Locked 

 
 

Rename 

When “Rename downloaded files with the set format” is enabled, a downloaded file is renamed according to 

a naming rule. 

The naming rule can be configured in the Format Options dialog box, which is displayed by clicking [Format]. 

The items to be included in a file name, with a separator between them, can be defined. 
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Delete 

This option sets how to delete a dictation file in the device after it has been downloaded. When “After 

downloading file(s), delete the original file(s)” is enabled, the original file is deleted after the file has been 

downloaded. 

x When “Display confirmation dialog” is enabled, a confirmation dialog box appears before the file can be 

deleted. 

x When “Delete locked file(s)” is enabled, even locked files are deleted after downloading. 
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8.2.3 Advanced Download 
 

Advanced download configures settings to route dictation files as they are downloaded to specific folders. 

Items that have a lock icon  can be configured and canceled by the system administrator only. 

 

Advanced Download 

Routing Rule Table 

 

Advanced download 

Downloads dictation files to specific folders or folders assigned the Author ID and Worktype ID. 

 
x [Download folder A-G] menus will be disabled when the option is enabled. Use 

[Download All] when downloading the files. 

x Auto download settings work in accordance with the [Auto Download] settings of the 
Download Tray. The [Auto Download] settings of individual folders (such as Folder A, 
etc.) are not displayed and are disabled. 

 

When the “Download all dictations to...” option is enabled, select the download method. 

x When “Specific folder” is selected, all dictation files in the device are downloaded into the specified 
folder. 

x When the “Routing according to the following conditions” option is selected, files are routed to each 
folder in accordance with routing rules. 

Routing Rule Table 

The routing rule table configures auto routing rules used when downloading and importing dictation files. 

Setting up storage destination folders in accordance with Author ID/Workforce ID combinations 

automatically routes dictation files to folders that conform to conditions during download and import. 

Routing rule table conditions are applied only when the “Routing according to the following conditions” 

option is selected. 

 

A maximum of 100 rules can be registered at any time. 

x To add a rule, click the [Add] button, and then make settings in the displayed Rule Settings dialog box. 

x To modify a rule, select it in the list and then click the [Modify] button. Modify rules on the Rule 
Settings dialog box. 

x To delete a rule, select it in the list and then click the [Remove] button. 
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8.2.4 Import 

  

This category configures operations when a dictation file is imported. 

The message to display and the file naming rule when the file is imported can be configured. 

The items with the lock icon  can only be enabled or disabled by the Administrator. 

 

Job Data Settings 

Rename 

Delete 

 

Job Data Settings 

When “Prompt for data every time a file is imported” is enabled, the Edit Job Data dialog box appears when 

a file is imported. 

Files can be imported after their Worktypes and Option Items are each verified and configured. 

Rename 

When “Rename imported files with the set format” is enabled, an imported file is renamed according to a 

naming rule. 

The naming rule can be configured in the Format Options Dialog Box, which is displayed by clicking [Format]. 

The items to be included in a file name, with a separator between them, can be defined. 
 

Delete 

This option sets how to delete a dictation file after it has been imported. 

When “After importing file(s), delete the original file(s)” is enabled, the original file is deleted after the file 

has been imported. 

x When “Display confirmation dialog” is enabled, a confirmation dialog box appears before the file can be 

deleted. 

x When “Delete locked file(s)” is enabled, even locked files are deleted after importing. 
 

 

8.2.5 Author 
 
This category configures Authors. 

Author ID and Priority Level registered here can be selected when creating a new dictation File with a 

function such as direct recording. 

 

Up to 10 Authors can be registered. 

x To add an Author, register it in the Author Property dialog box, which is displayed by clicking [Add]. 
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x To modify an Author, select the Author ID and click [Modify]. Then, make changes to the Author in the 

Author Property dialog box. 

x To delete an Author, select the Author ID and click [Remove]. 

x To change the order of Authors, select an Author ID and use the [Up] and [Down] buttons. 
 

 

� An Author ID can be specified using up to 16 characters. 
� The Priority Level can be configured in the range of 0 to 15. 

 

8.2.6 Worktype 

 

Multiple registered Worktype Lists can be transferred to the recorder. 

When recording a dictation file with direct recording or a recorder, selecting a Worktype ID enables 

information such as option items to be automatically recorded in the file. 

 
Up to 20 Worktype Lists can be registered. 

x To add a Worktype List, configure it in the Worktype Property dialog box, which is displayed by clicking 

[Add]. 

x To modify a Worktype List, select an Author ID and click [Modify]. Then, make changes to the Worktype 

List in the Worktype Property dialog box. 

x To delete a Worktype List, select an Author ID and click [Remove]. 

x To change the order of Worktype Lists, select an Author ID and use the [Up] and [Down] buttons. 
 
Set the captions for column titles in the file list of Dictation Module in Option Item Labels when option items 

are displayed. Up to 10 option items can be set for each Worktype ID, and they are numbered in order that 

they are registered as option items 1 to 10. Captions are set for the various option items 1 to 10 with Option 

Item Labels. If a caption is not set, option item 1 to 10 is displayed as is.  

Also, the captions set here are also used as the default value when an option item is added to Worktype ID. 

 

8.2.7 Direct Recording 

 

Direct recording parameters are configured here. 

These options are enabled for Direct Recording with an Olympus direct recording device. 

The items with the lock icon  can only be enabled or disabled by the Administrator. 

 

Basic Settings 

Prompt Option 

Button function 

Start option 

[New] button operation  

Voice comments 

VCVA 
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Basic Settings 

Recording Format 

This option sets the recording format for Direct Recording. 

The recording format can be selected in the Recording Format Setting dialog box, which is 

displayed by clicking [Format]. 

File Name Format 

This option defines the file naming rule for a new recording. 

The naming rule can be configured in the Format Options Dialog Box, which is displayed by clicking 

[Format]. 

The items to be included in a file name, with a separator between them, can be defined. 

(Default: Author ID leading four characters + Job No.) 

Destination folder 

This option specifies the default saving folder, which is displayed by clicking [Finished] in the Direct 

Recording window after performing Direct Recording. 

Clicking [Browse] displays the “Modify Destination Folder” dialog box for selecting a folder for 

saving. 
 

Prompt Option 

When “Prompt for job data when direct recording is started” is enabled, the Edit Job Data dialog box appears 

when Direct Recording is performed, which enables the user to verify and modify data, such as Worktype ID 

and Option Items, before starting recording. 

When “Prompt for confirmation when direct recording is finished” is enabled, the Dictation Finished dialog 

box appears when a dictation has been finished (Default: Enabled). 
 

Button function 

When ”Change the slide switch REV position to REW” is enabled, the [REV] button function for direct 

recording is changed to [REW].  

When “Recording while REC button is continuously pressed” is selected, recording is done while the [REC] 

button is pressed but stops when the [REC] button is released. If it is not selected, recording toggles on and 

off each time the [REC] button is pressed. This option is only enabled when an Olympus device which has the 

[REC] button is used as the recording microphone. 
 

Start Option 

This option configures operations when a direct recording device is used. 

When this option is enabled, the Direct Recording window, instead of the Main window, is opened in the 
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following cases: 

x Dictation Module is started via DirectRec button operations 

x If DirectRec connection is detected and Dictation Module is started 

Exiting the Direct Recording window displays the Main window. 
 

[New] button operation 

This option selects the type of window that is displayed when the [New] button of a direct recording device 

is pressed. 

x When [Direct Recording Window] is selected, the Direct Recording Window is displayed.  

x When [Voice Recognition Editor] is selected, the Voice Recognition Editor is displayed. 

 

Voice comments 

When “Verbal comment” is enabled, a verbal comment can be recorded. (Default: Enabled). 

When “Instruction Comment” is enabled, the [Switch Instruction Comment Mode] button is shown when 

Direct Recording is performed, which enables the user to record an instruction comment (Default: Enabled). 
 

VCVA 

VCVA (Variable Control Voice Actuator) can be turned OFF by setting the slider to Min. 

Moving the slider toward Max lowers the sound detection level. 

x When “Activate VCVA” is enabled, the VCVA level adjustment is applied. 

x The VCVA level can be adjusted to 10 different levels from 0 to 9. 
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8.2.8 Hands Free Recording 
 
If an Olympus foot switch or hand controller is connected to the PC, pedal/button operations can be used to 
perform dictation recording while the Direct Recording window is displayed, without doing button operations 
on the Direct Recording Window, microphone device, etc. 
 

Items Functions Default 

Pedal Operation Select the operation mode for the foot 
switch or the hand controller. 

Continuous 
Press 

Model Selects a sample image for a foot switch 
on the option dialog. 

RS-31 

 
The following table shows functions that can be assigned to each pedal. 

 

Pedal Operation Command Functions 

REV/PLAY Rewind (Review) is performed while the 
pedal/button is pressed. 

REC/STOP Recording is performed while the pedal/button is 
pressed. 

NEW Pressing the pedal/button creates a new dictation 
file. 

DISABLE Disables pedal/button operation. 
CUE/PLAY Fast forward (Cue) is performed while the 

pedal/button is pressed. 
INSERT/STOP Insert recording is performed at the indicator 

position while the pedal/button is pressed. 
STOP Pressing the pedal/button stops playback. 
EOF/BOF Pressing the pedal/button moves the indicator to 

the end of the file. 
INDEX Pressing the pedal/button inserts an index mark at 

the indicator position. 

Continuous Press 

PRIORITY Pressing the pedal/button switches the status of the 
dictation file being recorded to Priority. 
(High<->Normal) 

REW/STOP Pressing the pedal/button starts rewind. Pressing 
the pedal/button again stops rewind. 

PLAY/STOP Pressing the pedal/button starts playback from the 
indicator position. Pressing the pedal/button again 
stops playback. 

REC/STOP Pressing the pedal starts recording. Pressing the 
pedal again stops recording. 

NEW Pressing the pedal/button creates a new dictation 
file. 

DISABLE Disables pedal/button operation. No operation is 
performed when the pedal/button is pressed. 

FF/STOP Pressing the pedal/button starts fast forward. 
Pressing the pedal again stops rewind. 

INSERT/STOP Pressing the pedal/button starts insert recording 
from the indicator position. 

EOF/BOF Pressing the pedal/button moves the indicator to 
the end of the file. 

INDEX Pressing the pedal/button inserts an index mark at 
the indicator position. 

Short Press 

PRIORITY Pressing the pedal/button switches the status of the 
dictation file being recorded to Priority. 
(High<->Normal) 
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8.2.9 Voice recognition - General 
 
These are settings for configuring application general options that are applied when using voice recognition 

with the Dictation Module. 

Items that have a lock icon  can be configured and canceled by the system administrator only. 

 

Enable Voice Recognition 

Enables and disables voice recognition with the Dictation Module. 

When the “Enable Voice Recognition features” check box is selected, all voice recognition functions are 

enabled. When the check box is not selected, voice recognition functions are not displayed on the Dictation 

Module screen and no voice recognition functions are available for use. 

 

Adaptation 

With adaptation, the voice recognition software learns user corrections to the document generated by the 

voice recognition process, which improves future voice recognition. 

When the “Do adaptation” check box is selected, the file on which voice recognition is being performed is 

automatically added to the adaptation list when its status becomes Transcription.Finished. Or, it is added 

automatically to the Adaptation Data folder when a file of corrected voice recognition results is received via 

e-mail or FTP. 
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8.2.10 Voice recognition – Real-time Voice Recognition 
 
These are settings for configuring options used for real-time voice recognition with the Dictation Module. 

Items that have a lock icon  can be configured and canceled by the system administrator only. 

 

Basic Settings 

These are rules for generation of dictation files when running real-time voice recognition. 

File Name Format 

These are rules for naming files when performing real-time voice recognition. 

To configure a naming rule, click the [Format] button, and then configure settings on the Format 

Options dialog box that appears. You can specify items included in file names and the item 

delimiter character. 

Destination Folder 

This option specifies the default storage destination folder that is displayed when real-time voice 

recognition is complete. 

Clicking the [Browse] button displays a Modify Destination Folder dialog box, which can be used to 

select a storage folder. 

 

Prompt Option 

If “Prompt for job data when direct recording is started” is enabled, the Edit Job Data dialog box is displayed 

when real-time voice recognition starts. 

 

Voice Recognition Editor 

Selecting the “Change Voice Recognition Editor border color during recording” check box draws a border of 

the specified color around the Voice Recognition Editor text area while voice recognition is being performed. 

x You can select a color from the drop-down list. 

x By clicking [Custom], the color can be customized and added as a new color to the drop-down list. 
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8.2.11 Voice recognition – Background Voice Recognition 
 
These are settings for configuring options used when background voice recognition is executed with the 

Dictation Module. 

Items that have a lock icon  can be configured and canceled by the system administrator only. 

 

Queuing Control 

Completing a dictation file download operation, an import operation, or a direct record operation while “Add 

to recognition queue after downloading, importing and direct recording” is enabled will cause the dictation 

file to be automatically added to the voice recognition queue. 

While “Start recognition queue automatically when new files are added the queue” is enabled, background 

voice recognition starts automatically whenever a file is added to the voice recognition queue. If “Start 

recognition queue automatically when new files are added the queue” is disabled, background voice 

recognition does not start until the user executes the [Start Recognition Queue] command. 

 

Others 

Performing background voice recognition while “Use Noise Cancellation” is enabled will perform voice 

recognition with noise cancellation being performed on the recorded data. This reduces any noise introduced 

during recording and enables an improved voice recognition rate. 
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8.2.12 Voice recognition – Text Correction 
 
These are settings for configuring options used when correcting text generated by voice recognition with the 

dictation module. 

Items that have a lock icon  can be configured and canceled by the system administrator only. 

 

Focusing 

Enabling “Highlight words during the playback of voice file” will highlight (by reversing its background color) 

the text that corresponds to the current playback location during dictation playback. 

 

Finishing 

Enabling “Prompt for confirmation when text correcting is finished” will display a dialog box for confirming 

the dictation file output destination and other settings whenever real-time voice recognition or voice 

recognition result correction is complete. 

This setting is applied only when [Finished] is executed from the Voice Recognition Editor for real-time voice 

recognition processing or correction following voice recognition. Settings to be used after recording with the 

Direct Recording Window are configured on the Direct Recording screen. 

 

Enabling “Export document” will convert the text of a transcribed file to a specified file format and output it 

when [Finished] is executed from the Voice Recognition Editor. 

x Use [Output Format] to specify the output file format. 

x [Output Format] specifies the output destination folder for the converted document files. 

When “Prompt for confirmation when text correcting is finished” is enabled, export/do not export, output 

settings, and other settings can be configured on the confirmation dialog box. [Output Format] and other 

settings are used as initial values when the confirmation dialog box is displayed. 

When “Prompt for confirmation when text correcting is finished” is not checked, export is performed 

automatically using specified conditions. 

 



143 / 253 

8.2.13 Voice recognition – Template 
 
These are template file settings that are used during execution of voice recognition. A template file is a 

document pattern file that embeds, by default, formats that are always used by the user, such as a name 

input box. The voice recognition results of both real-time voice recognition and background voice recognition 

can be output to a template file. 

Items that have a lock icon  can be configured and canceled by the system administrator only. 

 

 

x Only Rich Text Format files are supported. Only Rich Text Format files can be specified as 
a template file. 

x Using the Windows-1252 code page as the template file is recommended. A warning 
message appears if any other code page is specified as the template. 

 

Templates 

Enabling “Use document templates in Voice Recognition” will automatically open a Rich Text Format file in 

the Voice Recognition Editor text area in accordance with the rules configured by the template whenever 

real-time voice recognition is started. Performing background voice recognition will cause the specified 

template file to be output for the voice recognition result. 

A maximum of 100 rules can be registered at any time. 

x Rules are created for Author ID and Worktype ID combinations. 

x When rules are created without specifying either of the IDs, the non-specified condition is 
interpreted as “unconditional”, which is interpreted as everything matching. For example, if 
“OLYMPUS” is specified for the Author ID and nothing is specified for the Worktype ID, any 
“OLYMPUS” Author ID is judged to be a match, regardless of the Worktype ID. 

x To add a rule, click the [Add] button, and then make settings in the displayed Rule Settings dialog 
box. 

x To modify a rule, select a template in the list and then click the [Modify] button. Modify rules on the 
Rule Settings dialog box. 

x To delete a rule, select a template in the list and then click the [Remove] button. 

 

Voice Recognition Result Starting Position 

Normally, voice recognition result text is output from the beginning of the Rich Text Format file. When using 

a template, however, there may be cases when you want to include the author name, voice recognition date, 

or other information before the voice recognition result. 

To do so, you can use a Rich Text editor such as the standard Windows WordPad to insert the 

“[VR_START_POSITION]” tag into the template file. Then when voice recognition is performed, voice 

recognition results are output starting from the position where [VR_START_POSITION] is located. The 

[VR_START_POSITION] tag itself is automatically deleted when voice recognition results are output. It does 

not remain as part of the voice recognition result. 

 

x The [VR_START_POSITION] tag is valid for both real-time voice recognition and 
background voice recognition. In the case of real-time voice recognition, the cursor is 
moved to the [VR_START_POSITION] location when the Voice Recognition Editor is 
started up. 
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Templates and Adaptation 

With adaptation, the Dragon NaturallySpeaking voice recognition engine learns by comparing voice 

recognized dictation data with the text data. 

In the case of voice recognition using a template file, the applicable audio is not in the part in the template 

where data is first inserted. When performing adaptation, any part of the template that does not contain 

audio is not used for adaptation. 

When voice recognition is performed, the Transcription Module automatically determines whether a 

template was used, and excludes anything in the text area at the beginning of the template from the 

adaptation process. In the example presented above, “AUTHOR NAME” and any other terms that are 

included before the [VR_START_POSITION] tag, as well as the date and other information in the template 

text area are not part of the adaptation process, and so they are not learned by the voice recognition engine. 

In order to use the adaptation function to teach particular terms to the voice recognition engine, the actual 

author must say the terms and they must be learned for voice recognition. Terms also can be learned directly 

by the voice recognition engine using functions such as Dragon NaturallySpeaking Train Word. 
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8.2.14 Voice recognition – Dragon NaturallySpeaking 
 
These are settings for configuring Dragon NaturallySpeaking. 

Items that have a lock icon  can be configured and canceled by the system administrator only. 

 

Dragon NaturallySpeaking User Profile 

When using Dragon NaturallySpeaking voice recognition, user profiles (files that record personal user 

settings and other information for voice recognition) that record author user information are required to 

improve the voice recognition rate. This setting specifies the management method for Dragon 

NaturallySpeaking user profiles (DNS user profiles). 

 

User Profile Location 

Dragon NaturallySpeaking has two methods that can be used for managing DNS user profiles. Though 

selection of the method is a Dragon NaturallySpeaking setting, the setting also can be configured from the 

Dictation Module. 

Use Local Profile 

When “Use Local Profile” is selected, DNS user profiles are managed on the local PC here Dragon 

NaturallySpeaking is installed. This method can be used only for voice recognition with DNS user 

profiles that are present on the local PC. 

This is a Dragon NaturallySpeaking standard operation. Use of “Use Local Profile” is recommended 

in an environment where the authors performing voice recognition do so on their own PCs. 

Use Dragon Roaming 

When “Use Dragon Roaming” is selected, share management of DNS user profiles is performed by 

the network folder specified by the [Roaming Folder Path] box. Dragon NaturallySpeaking can 

handle all of the DNS user profiles present in the specified shared folder the same way as DNS user 

profiles on a local PC. 

When a user is opened with Dragon NaturallySpeaking, it loads the DNS user profile located in the 

shared folder, reads in the personal setting information, and performs voice recognition. When 

adaptation or other methods are used to update personal setting information, the DNS user profile 

of the applicable author located in the shared folder is also updated. This means that all users that 

reference the shared folder are able to use the DNS user profiles for each author, which are 

automatically and constantly updated, without copying the DNS user profile each time. 

“Use Dragon Roaming” is recommended in an environment where multiple users are cooperating 

with each other to record dictation, perform voice recognition, make corrections, and perform 

other tasks. 

x When using “Use Dragon Roaming”, you need to prepare and specify a shared folder for 
managing DNS user profiles. Click the [...] button next to the [Roaming Folder Path:], and 
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then specify the shared folder for managing DNS user profiles. 

x DNS user profiles on the local PCs are not used while “Use Dragon Roaming” is being used. 
This means that DNS user profiles need to be exported from the local PCs to the shared folder. 
Changing from the “Use Local Profile” to the “Use Dragon Roaming” setting starts up the user 
profile Roaming User Wizard. The DNS user profiles to be exported can be selected in the 
Wizard. Completing the Roaming User Wizard causes the DNS user profiles selected for 
export to be copied to the specified shared folder. 
The DNS user profile export process can be re-executed after the Export Wizard is complete 
by pressing the [Export] button. 

 

Active User Profile 

Specifies the active DNS user profile to be used when using the Dragon NaturallySpeaking voice recognition 

function from the Dictation Module. 

Author ID 

Select if a DNS user profile is specified for each author when using a voice recognition type of 

function. Normally the author ID is not specified, the [User Name] specified for the DNS user 

profile to be used. When multiple authors are performing voice recognition with the Dictation 

Module on the same PC and as the same (Dictation Module) user, the DNS user profile 

corresponding to this Author ID specification is set. 

 

 

x The selected Author ID can be specified from the author IDs registered in Option 
settings [Workflow] - [Author]. 

=>[Workflow] - Author 

User Name 

When using voice recognition functions, the DNS user profile specified by [User Name] is 

automatically opened in the background and used during voice recognition. On the drop-down list, 

select DNS user profile name of the author who is recording the dictation. 

With Dictation Module, you can specify multiple DNS user profiles by combining specified Author 

IDs. 

 

 

x The drop-down list shows the names of all user profiles present in the location 
selected with [User Profile Location]. 

Vocabulary 

Vocabulary shows the user dialect, terminology, and other information (“U.S. English - General”, 

etc.) that was registered when a DNS user profile was created by Dragon NaturallySpeaking. 

Dictation source in real-time voice recognition feature 

This feature is used to select the microphone device to be used when performing real-time voice 

recognition. 

The DNS user profile selected by [User Name] will display an alert button next to “Train Profile” if 

training has not been performed for the selected microphone device. To improve the voice 

recognition rate, you need to train the DNS user profile using the same microphone that you will 

use for actual real-time voice recognition. If you use the microphone that actually will be used for 
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recording to perform training, the noise characteristics and other characteristics of the microphone 

device will be remembered by the DNS user profile, which can improve the voice recognition rate. 

Dictation source from external devices 

This setting is used to select the recorder or microphone devices for recording a file to be submitted 

for background voice recognition. When using a microphone device that is different from the one 

used for real-time voice recognition, register a real-time voice recognition device and a 

background voice recognition device, using Dragon NaturallySpeaking, for the user specified by 

the [User Name] box. 

Dragon Engine Configuration 

Enabling “Always restart Dragon NaturallySpeaking Engine” will force the Dragon NaturallySpeaking voice 

recognition engine to restart whenever the Dictation Module is started up. Restart is not performed if the 

voice recognition engine is not running when the Dictation Module is started up. 

Also, clicking the [Restart Now] button will immediately restart the voice recognition engine. 

 

When “Enable to run Dictation Module and Dragon NaturallySpeaking on same CPU core” is enabled, 

Dictation Module and the Dragon NaturallySpeaking voice recognition engine are controlled to work 

simultaneously on the same CPU core. 
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8.2.15 Receive 
 
This category configures operations when files are automatically received. 

It can configure profiles, document file types, receipt notifications, and dictation file expirations. 

The items with the lock icon  can only be enabled or disabled by the Administrator. 

 

Receive 

Overdue transcription 

 

Receive 

x When [E-mail] is enabled, files can be received via email. 

=>E-mail 

x When [FTP] is enabled, files can be received via FTP. 

An E-mail or FTP profile can be created and modified by clicking [Change the profile]. 

=>FTP 

Multiple FTP sites can be registered. They are added to the list after registration. 

When this is enabled, files can be downloaded from the specified FTP. 

x Only files of the file formats whose check box are selected under “Select the extension of document file 
to receive” are received by E-mail/FTP. 

x Clicking “Add/Remove support document type” will display the Folder Design dialog box. The 
Supported Document Type dialog box that appears when the  button displayed in the “Document 
Type” field of the [Document Tray] can be used to add and delete supported document types. 

 
 

Overdue transcription 

With this option enabled, a transcription expiration date can be set to a dictation file sent via email or FTP. 

If the file is not sent back before its expiration, it is marked with a different color. 

The length of time before expiration can be set in the range of 1 to 999 hours. 
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8.2.16 Notification 

 

This setting opens a Notification Window (pop-up) when a file is added to a folder and when mail arrives via 

e-mail/FTP. 

 

Enable notification for every new dictation received 

Author ID 

Notification high priority dictations only 

Pop-up Notification 

Sound Notification 

Support background notification when Dictation Module is not running 

 

Enable notification for every new dictation received 

If this item is enabled, then adding a file to the folder notifies users at the specified interval by sound and 

pop-up window. (Default: 10 minutes) 
 

Author ID  

Users are notified if the selected Author ID file is added to the folder. 

You can add author IDs from Option settings [Workflow] - Author. 
 

Notification for high priority dictations only 

Notification is done only for dictation files that are set as “High” priority. 
 

Pop-up Notification 

Only pop-up window notification is done for dictation files. 

You can set the content of the pop-up and the time it is displayed by enabling this setting and clicking on the 

[Customize] button and opening the Configure Notification dialog box. 
 

Sound Notification 

Set the notification sound. 

 button:  Plays the notification sound file. 

 button:  Stops the notification sound file. 

 button:  Sets the notification sound file. (Default: notify.wav) 
 

Support background notification when Dictation Module is not running 

Notification of new arrivals is done even if Dictation Module is not running. 
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8.2.17 Routing 

 

Set the routing rules. 

Opens a list of registered routing rules. (Maximum 100) 

The icon shown for E-mail ( ) and FTP ( ) changes. 

 

Sender:  Shows the sender of the dictation file. 

Destination:  Shows the path of the destination of the dictation file. 

Receiver:  Shows the person receiving the dictation file. 

 

x To add a routing rule, click the [Add] button, and then make settings in the displayed Routing Settings 

dialog box. 

x To change a routing rule, select the rule, click the [Modify] button, and then modify settings in the 

displayed Routing Settings dialog box. 

x To delete a routing rule, select a rule and then click the [Remove] button. 



151 / 253 

8.2.18 Auto Collection 

 

This function moves the dictation files with Transcription Finished status into a specified folder in the 

Download tray or into a custom folder. Using this option in combination with the Ownership attribute, the 

folder for saving the dictation files can be changed. 

The items with the lock icon  can only be enabled or disabled by the Administrator. 

 

Activate Automatic Collection Function 

When this option is enabled, the dictation files with Transcription Finished status are moved to a specified 

folder. 

Either of the following two methods is available: 

x Moving the files to the Finished folder 

x Moving the files to Author-ID specific folders according to a pre-defined rule. 
 
To define the rule, perform the following tasks: 

x To add a rule, configure it in the Rule Settings dialog box, which is displayed by clicking [Add]. 

x To modify a rule, select it and click [Modify]. Then, make changes to the rule in the Rule Settings dialog 

box. 

x To delete a rule, select it and click [Remove]. 
 
The Ownership attribute can be set for the Download tray and custom folders. Their subfolders will also have 

the same Ownership attribute. 

 

Using this attribute in combination with Auto Collection, the dictation files with Transcription Finished status 

can be automatically moved to the Finished folder. 

 

Ownership Auto Collection Transcription Finished Dictation Files  

Yes Moved to the Finished folder in Dictation 
Module (set as a rule) 

Yes 

No Not moved 
Yes Moved to the Finished folder in Transcription 

Module (set as a rule) 
No 

No Not moved 
 

 



152 / 253 

8.2.19 Logging 

Set the profile for log file output. 

For items marked with  (icon for locking), only the manager can change the settings. 

 

User Operations 

Items Functions Default 

Specify whether or not to 
output user actions to a log 
file 

Enable this item when outputting a log file 
in which user operations have been 
recorded. 

Off 

Location From the list, select a location to which a 
log file is to be output, or enter it directly. 

 

File Name Set a log file name. 
The format of a file name will be (prefix) 
computer name_yyyy-mm(suffix). Only 
the (prefix) and (suffix) portions can be 
changed. 
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8.3 User Settings 
 
This category provides user-customized settings for using Dictation Module. 

The items with the lock icon  can only be enabled or disabled by the Administrator. 

 Procedure 

1. Select [Options] from the Tool menu. 

2. Click [User Settings]. 

 The User Settings dialog box will appear. 

3. Select an item from the tree on the left and configure it on the right. 

[OK]: Secures the settings 
[Cancel]: Exits without modifying the settings 
[Apply]: Reflects changes to the configuration file 

 
General 

Keyboard 

Playback Control 

 

8.3.1 General 
 

Language Selection 

This option selects the language displayed by the application. 

If the setting has been modified, it comes into effect only after the application has been restarted. 

 

8.3.2 Keyboard 
 
Specific functions can be assigned to the keys on the keyboard. 

The items with the lock icon  can only be enabled or disabled by the Administrator. 

 

Category 

Selecting a category from the category list displays the command/key assignment list in the selected 

category. 

 

New Key 

x To add a key assignment, select a command with no key assigned, specify a key in the New Key box 

using the keyboard, and click [Assign]. [Alt], [Shift], and [Ctrl] can be combined with any other key. 
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x To modify a key assignment, select a command to be modified, specify another key in the New Key box 

using the keyboard, and click [Assign]. 

x To delete a key assignment, select a command with a key assigned, and click [Remove]. 

x To return key assignments to the default settings, click [Reset All]. 

 

 
For information on default key assignments, refer to Default Key 
Assignments. 

 

Current Key 

If the key entered under “New Key” has already been assigned, the currently assigned command will be 

displayed. 

 

 
For information on default key assignments, refer to Default Key 
Assignments.  

 

8.3.3 Playback Control 
 
This category configures the settings for audio playback. 

The items with the lock icon  can only be enabled or disabled by the Administrator. 

 

Control Indicators 

Auto backspace 

Position 

Winding speed 

 

Control Indicators 

This option manages control display switching as follows: 

x Shows/Hides the Speed control 

x Shows/Hides the Noise Cancel control 

x Shows/Hides the Tone control 

x Shows/Hides the Level Meter control 
 

Auto Backspace 

This option sets the length of time for Auto backspace in the range of 0.0 to 5.0 seconds, in steps of 0.1 

seconds. 
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Position 

When “Always on top” is enabled, the application window is always displayed on the foreground. 

 

 

� This option is applied only to the Playback Control window, the Direct 
Recording window, and the Voice Recognition Editor. 

� The Main window may not be displayed in the foreground. 
 

Winding speed 

The feed amounts of CUE/REVIEW and FF/REW can be configured in four levels. 

The horizontal axis represents the length of time that has elapsed since starting (3 seconds minimum, 60 

seconds maximum). 

The vertical axis represents the scaling factor relative to the standard playback speed (1.5x minimum, 50x 

maximum). 

Click any one of the four levels and adjust the scaling factor to the desired level. 

Note that it cannot be adjusted to levels less or equal to the scaling factor at the previous level. 

To make an adjustment, select the box displayed for each level. 

x Elapsed time can be adjusted using  and . 

x The playback scaling factor can be adjusted using and . 

Support playback audio during cue/review 

A typical CUE operation thins out audio data for playback. With this option enabled, however, when 

1.5x or 2.0x is selected, the Speed control is used to provide continuous playback without thinning 

out sound data. 
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8.4 E-mail / FTP 
 
This category configures email and FTP profiles. 

The items with the lock icon  can only be enabled or disabled by the Administrator. 

 Procedure 

1. Select [Options] from the Tool menu. 

2. Click [E-mail / FTP]. 

 The E-mail/FTP dialog box will appear. 

3. Select an item from the tree on the left and configure it on the right. 

[OK]: Secures the settings 
[Cancel]: Exits without modifying the settings 
[Apply]: Reflects changes to the configuration file 

 
E-mail 

FTP 

Send / Receive 

Proxy 
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8.4.1 E-mail 
 
This category can register and modify email profiles. Up to 100 profiles can be registered. 

The transmission/reception protocols listed below are supported. 

x Internet E-mail (POP3/SMTP) 

x IMAP 

x Microsoft Outlook 

x Novell GroupWise 

x Lotus Notes 
 

Selecting an E-mail Profile 

If some profiles have already been registered, select a profile for email transmission and reception from the 

Default Profile drop-down list. 
 

Registering an E-mail Profile 

To register a new email profile, perform the following steps: 

 Procedure 

1. Click [Add]. 

The E-mail Settings (Select) dialog box will appear. 

2. Select an email transmission/reception protocol and click [Next]. 

If Microsoft Outlook has been selected, the following settings are not necessary. Exit the setting 
procedure. 
Otherwise, the setting dialog box for the selected email profile will appear. 

 

x Internet E-mail (POP3/SMTP) =>E-mail Settings (POP/SMTP) Dialog Box 

x IMAP =>E-mail Settings (IMAP) Dialog Box 

x Novell GroupWise =>E-mail Settings (GroupWise) Dialog Box 

x Lotus Notes =>E-mail Settings (Lotus Notes) Dialog Box 

3. Configure settings. 

Advanced settings, such as port settings and SSL, can be configured only when using Internet 
email (POP3/SMTP) and IMAP protocols. To configure these settings, click [Advanced settings]. 

 

x Internet E-mail (POP3/SMTP) =>Advanced Settings (POP/SMTP) Dialog Box 

x IMAP =>Advanced Settings (IMAP) Dialog Box 

4. When configuration has been completed, click [Finish]. 

 
For more information on email settings, contact your service provider or 
system administrator. 
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Modifying a Profile 

To modify an email profile, select it and click [Modify]. Then, make changes to the profile in the dialog box. 

The displayed dialog box will vary depending on the selected email profile. 

 

x Internet E-mail (POP3/SMTP) =>E-mail Settings (POP/SMTP) Dialog Box 

x IMAP =>E-mail Settings (IMAP) Dialog Box  

x Novell GroupWise =>E-mail Settings (GroupWise) Dialog Box 

x Lotus Notes =>E-mail Settings (Lotus Notes) Dialog Box  
 

 

Deleting a Profile 

To delete a profile, select it from the Default Profile drop-down list and click [Remove]. 

 

Attachment 

With this option enabled, the upper limit for the total size of files attached to an email can be configured. If 

the limit is exceeded, a separate email will be created to accommodate the excess. The upper limit can be 

set in increments of 1 MB in the range of 1 to 100 MB. 
 

 

8.4.2 FTP 
 
This category configures an FTP profile. 

The items with the lock icon  can only be enabled or disabled by the Administrator. 

 

FTP Profile 

Registered FTP profiles are listed. Up to 100 FTP profiles can be registered. 

With multiple FTP profiles registered, files can be sent to and received from multiple registered FTP sites via 

FTP. 

x To add an FTP profile, configure it in the FTP Settings dialog box, which is displayed by clicking [Add]. 

x To modify an FTP profile, select it and click [Modify]. Then, make changes to the profile in the FTP 

Settings dialog box. 

x To delete an FTP profile, select it and click [Remove]. 

 

8.4.3 Send / Receive 
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This category configures the transmission and reception settings of email and FTP. 

Files are sent and received via email or FTP typically when [Send and Receive] is clicked on the module. They 

can also be automatically sent and received at regular intervals. 

The items with the lock icon  can only be enabled or disabled by the Administrator. 

 

Send Interval 

When “Automatically send files via E-mail/FTP” is enabled, Dictation files can be transferred automatically. 

x When “Send files in the Outbox immediately” is enabled, dictation files moved to the Outbox are sent 

immediately. 

x When “Send files in the Outbox every” is enabled, dictation files moved to the Outbox are sent 

automatically at the specified interval (Default: 10 minutes). 

  

Receive Interval 

When “Automatically receive files via E-mail / FTP” is enabled, files sent via E-mail or FTP can be received at 

the specified interval. (Default: 10 minutes) 

 

Management File 

When sending a file via E-mail/FTP, specifies whether or not a management file is attached. A management 

file is a system file used when sending a dictation file or document file with DSS Player Pro R5 or ODMS R6 

to share dictation file or document file related information, transcription date and time information, and 

other information with the sender/receiver. 

x When “Send management file with the file” is selected, a dictation file, management file, and 

instruction comment file (if present) are all sent together. Use this option only when the sent files are 

for use in DSS Player Pro R5 or ODMS R6. 

x When “Do not send management file with the file” selected, only a dictation file and instruction 

comment file (if present) are sent. Their management file is not sent. Use this option when the sent 

files are for use in a program other than DSS Player Pro R5 or ODMS R6. 

 

8.4.4 Proxy 
 
This category configures a proxy. 

The items with the lock icon  can only be enabled or disabled by the Administrator. 

 

x When [Use Internet Explorer settings] is selected, the module accesses the same proxy server as the 

one used by Internet Explorer. 

x When [Don't use the proxy server] is selected, no proxy server is configured. 

x When [Use this proxy server] is selected, the module accesses a proxy server with a specified address 

and port number 
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8.5 Device 
The device configuration allows for obtaining, configuring, initializing, and saving the settings of each device. 

Using [Set job Number], the job number can be set in the range of 0 to 9999 (Dictation Module only). 

The configurable setting items of a device are displayed in categorized tree form. Clicking an item in the tree 

switches the window to display the corresponding settings. 

 

The items with the lock icon  can only be enabled or disabled by the Administrator. 

 

x To return the device settings to default, click [Reset]. Note that in a window without [Reset], the 

settings cannot be returned to default. 

x To upload the device settings, click [Update]. 
 

 

� Lock/unlock settings are configured by the System Configuration 
Program. 

� The Device Configuration Program also can be used to assign direct lock 
settings to the device. 

 
� The setting items and values (ranges) of devices vary depending on the 

device model. For details, refer to the reference manual for each 
device. 

 
 
For information on device configuration, read the following descriptions. 

 
Devices with Device Configuration Support 

Device Settings for DS-7000/3500 

DS-5000/5000iD/3400 Device Configuration 

Device Settings for DR-2300/2200/2100/1200 
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8.5.1 Devices with Device Configuration Support 

Devices that can be configured via Dictation Module are listed below. This section describes the configuration 

of DS-7000/3500, DS-5000/5000iD/3400, and DR-2300/2200/2100/1200. 

 

 
� The setting items and values (ranges) of devices vary depending on the 

device model. For details, refer to the reference manual for each 
device. 

 
DS-7000 

DS-5000/5000iD 

DS-3500 

DS-3400 

DS-2800 

DS-2500 

DS-2400 

DR-2300/2200/2100/1200 

General Devices 

 

8.5.2 Device Settings for DS-7000/3500 
 
This section explains DS-7000/3500 setting items and functions. 

 

Stand Alone 
Common Settings  

 General  

 Recording  

 Display  

Administrative Settings  

 General  

 Display  

 Device Security  

 Author List  

 Worktype List 

 Device Folders  

 Recording 

 Programmable Buttons  

 Hands Free  

PC Link 
Programmable Buttons  
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Standalone Common Settings 

General 
Items Functions Default 

Beep Sound Selects beep ON/OFF. ON 
Power Save Selects power saving time. 10 min. 
USB Class Selects composite mode or storage mode as the USB 

connection mode. 
Composite 

Switches the card being accessed. SD Card Select 

Disable SD Card Slot 
Selecting this check box disabled SD Card Slot operation 
so it is no longer recognized from the PC. 

None 

Cue/Review 
Settings(Sound) 

Selects whether or not to play sound while 
fast-forwarding or rewinding during play back. 

OFF 

Cue/Review 
Settings(Speed) 

Sets the Cue/Review speed. Move the indicator to the 
left or right to decrease or increase the speed 
respectively. 

3 

Recording 
Items Functions Default 

Recording Mode Selects the recording mode. QP 
Microphone Sensitivity Selects microphone sensitivity. Dictation 
VCVA Mode Selects VCVA mode (voice-activated recording) ON/OFF. OFF 

Display 
Items Functions Default 

Backlight – 
Lighting Time 

Specifies the backlight illumination time when the 
device is operated. 

10 Seconds 

Backlight – 
Dim light time 

Specifies the dim backlight time after the “Lighting 
Time” elapses. 
When the dim light mode is entered while “Always ON” is 
selected, the backlight will remain lit in the dim light 
mode until the next device operation. 

Always ON 

Brightness Specifies backlight brightness. 
A larger value indicates a higher level of backlight 
brightness. 

2 

LED Mode Selects LED ON/OFF. ON 
Specifies the date display format. M.D.Y Date Format 
If synchronizing the recorder time with that of the PC, 
enable “Use PC Settings”. 

Not 
synchronize
d with the PC 

Clock Format Specifies either 12-hour or 24-hour time display format. 12h 
Language Switches the device display language. English 
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Stand Alone-Administrative Settings 

General 
Items Functions Default 

Disable Erase button 
When this option is enabled, a file cannot be deleted 
by pressing the device [ERASE] button. 

Disabled 

Disable Menu button 
When this option is enabled, the menu screen is not 
displayed when the device [MENU] button is pressed. 

Disabled 

Accessibility 

Disable Rewind button 
When this option is enabled, rewind is not performed 
when the device [Rewind] (|◀◀) button is pressed. 

Disabled 

Splash Message Configures settings for the splash messages displayed 
when the device is turned on. 
If you enter text with “Custom” enabled, the entered 
text will appear when the power is switched On. Up to 
32 characters can be entered. Both capital and 
lower-case letters are recognized. 

Time of day 
greeting 

Slide Switch Guide When [ON] is selected, the slider switch button is 
positioned on the right side of the LCD. 
* DS-7000 only 

OFF 

Main Button Guide When [ON] is selected, the main button allocation is 
displayed on the right side of the LCD. 
* DS-3500 only 

OFF 

Error 
Sounds a beep when an error occurs. 

ON 

Pre-end 
Sounds a beep when remaining recordable time runs 
low. An alarm sounds when remaining recordable 
time reaches 60 seconds, 30 seconds, and 10 
seconds. 

ON 

Notification 
After password validation is successful, a beep sounds 
if remaining battery power is low or to notify the user 
of certain other important operations or events. 

ON 

Button Operation 
Sounds a beep whenever a device button operation is 
performed. 

OFF 

Alarm 

Recording Start/Stop 
Sounds a beep whenever recording is started or 
stopped. 

OFF 
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Display 
Items Functions Default 

Upper Area Selects the contents displayed in the top information 
display area. 

Hidden 

Middle Area Selects the contents displayed in the middle 
information display area. 

Hidden 

Lower Area Selects the contents displayed in the lower 
information display area. 

Hidden 

Device Security 
Items Functions Default 

PIN code To enable the Security, click the [PIN Code change] 
button then enter the PIN code. 

 

Enable Device Lock function to prevent 
unauthorized access to the device 
This option can be enabled only when a PIN code 
setting is configured. When it is enabled, the following 
two items can be set. 

Disabled 

Prompt for device PIN code to authenticate 
user 
Select the device lock timing from [At power-on] or 
[At power-on and wake-up from stand-by]. 

At power-on 

Device Lock 

Limit the maximum number of device access 
attempts to 
Specifies how many unsuccessful consecutive PIN 
code authentication attempts are allowed before the 
devices locks up. 

Five times 

Author List 
Items Functions Default 

Author List Shows the Author List configured by Workflow. 
Enabled Authors are registered in the device’s Author 
List. 
Disabled Authors are removed from the device’s 
Author List. 

[Set as Default] 
Clicking [Set as Default] configures the Author 
selected from the Author List as the default Author. 

[Author of Workflow] 
Links to the Workflow-Author setting. 
=>Registering the Author List with the Recorder 

 

Author Selection Prompt for Author ID at Power-on.  
With this option enabled, the Author List is displayed 
when a recording is started using the recorder. 
(However, if only one Author has been registered, the 
list is not displayed.) 

 

Worktype List 
Items Functions Default 
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Worktype List Shows the Worktype List configured by Workflow. 
Enabled Worktypes are registered in the device’s 
Worktype. 
Disabled Worktypes are removed from the device’s 
Worktype. 

[Set as Default] 
Clicking [Set as Default] configures the Worktype 
selected with the Worktype List as the default 
Worktype. 

[Worktype of Workflow] 
Links to the Workflow-Worktype setting. 

 

Worktype Selection Prompt for Worktype ID on new recordings. 
With this enabled, Worktype List is shown when new 
recording is performed so that you can select 
Worktype to be set in a dictation file. Worktype List is 
not shown when only one item has been registered. 

Disabled 

Device Folders 

After you select a folder in the Folder Tree, you can configure its folder properties. 

Items Functions Default 

Enabled 
Enables/disables folders. 

Folders A to 
E, enabled 
Folders F and 
G, disabled 

Folder Name 
You can input up to 16 single-byte alphanumeric 
English characters for a folder name. 

Folders A to 
G 

Folder Property(General) 

Worktype 
Specifies the Worktype specified for dictation files 
recorded to this folder. 
Specifying a Worktype here always uses the 
Worktype specified for the folder without displaying 
the Worktype List, even if “Prompt for Worktype ID 
on new recordings.” is enabled for “Worktype 
selection” on the [Worktype] screen. 

 

Auto Lock 
Specifies whether dictation files recorded to the 
folder should be locked. 

No Folder Property(Security) 
 

Encryption 
Specifies whether dictation files recorded to the 
folder should be encrypted. This setting can be 
configured when the folder is enabled, and “DSS Pro” 
is selected for the “DSS Format” setting on the 
[Administrative Settings] - [Recording] screen. “DSS 
Classic” encryption is not supported by the device. 

Selections Description 
No Do not encrypt. 
Standard Encrypt using a 128-bit key. 
High Encrypt using a 256-bit key.  

No 
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Password 
Specifies the password to be used for encryption. 
Click the  button in the setting field, and use the 
displayed Encryption Password dialog box to make 
the setting. Enter a password in the [New password] 
and [Confirm password] fields using 4 to 16 one-byte 
alphanumeric characters. 
The password is the same as the password for the 
[Encryption] Standard mode and High mode. An 
encryption key, suitable for the specified encryption 
mode, is generated from the password, with a key 
length that is in accordance with the encryption mode 
set within the program. 

 

Folder Property(Action) Voice Recognition 
Specifies the initial value of ON/OFF for Background 
VR during recording. If it is ON, recorded dictation 
files in this folder are automatically added to the 
Voice Recognition Waiting List when downloaded to 
ODMS. 

Yes 

 

 
DS-7000/3500 Folder Settings 
 DS-7000/3500 have slots for both SD and Micro SD media, so either on can be 

used. The device menu can be used to specify which type of media is being 
recorded to. Both media have the same folder structure with “DSS_FLDA” to 
“DSS_FLDG” folders. This setting is enabled for both media. 

Recording 
Items Functions Default 

DSS Format Selects the DSS recording format. 
The default recording format for DSS Classic is DSS. 
The default recording format for DSS Pro is DS2. 
When DSS Classic mode is switched from “DSS Pro”, 
the following items are checked: 

• If the recording format is set to QP, it is changed to SP,
and QP is prevented from being selected. 
=>[Standalone] – [Common Settings] – [Recording] 

• The Encryption attribute is set to “NO” and is 
prevented from being modified. 
=>[Standalone] – [Administrative Settings] – 
[Folder] 

DSS Pro 

Record Function Selects the recording operation. Overwrite 
File download Specifies a file to be downloaded. All Files 

Programmable Buttons 
Items Functions Default 

New and Slide Switch 
Functions 

Selects Type A, Type B, or Type C as the functions 
assigned to each position of the slide switch and the 
buttons above the slide switch. 
* DS-7000 only 

Type A 

Main Button Functions Selects either Type A or Type B as the function 
assigned to the main switch button. 
* DS-3500 only 

Type A 

Programmable Buttons Customizes the functions that are assigned to the 
function buttons [F1], [F2], and [F3] on the device. 

 

Rec Mode Selects whether or not the REC button must be held 
down to record. 
* DS-3500 only 

Disabled 

 
The following table shows functions that can be assigned to function buttons F1 to F3. 
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 DS-7000 

Mode F1 F2 F3 

Folder Folder Folder 
Priority Priority Priority 
Information Information Information 
Rec Mode Rec Mode Rec Mode 
Mic.Sensitivity Mic.Sensitivity Mic.Sensitivity 
VCVA VCVA VCVA 
Folder Copy Folder Copy Folder Copy 
All Copy All Copy All Copy 

NEW Mode 

Disable Disable Disable 
Folder Folder Folder 
Priority Priority Priority 
Information Information Information 
Pending Pending Pending 
Lock Lock Lock 
Insert Insert Insert 
Mic.Sensitivity Mic.Sensitivity Mic.Sensitivity 
VCVA VCVA VCVA 
New New New 
File Copy File Copy File Copy 
Folder Copy Folder Copy Folder Copy 
All Copy All Copy All Copy 
Index Index Index 
Voice Recognition Voice Recognition Voice Recognition 

STOP Mode 

Disable Disable Disable 
Verbal Verbal Verbal 
Disable Disable Disable 

REC Mode 

Index Index Index 
Insert Insert Insert 
Speed Speed Speed 
Index Index Index 
Pending Pending Pending 
Priority Priority Priority 
Lock Lock Lock 
Voice Recognition Voice Recognition Voice Recognition 

PLAY Mode 

Disable Disable Disable 

 

 

 DS-3500 

Mode F1 F2 F3 

Folder Folder Folder 
Priority Priority Priority 
Information Information Information 
Rec Mode Rec Mode Rec Mode 
Mic.Sensitivity Mic.Sensitivity Mic.Sensitivity 
VCVA VCVA VCVA 
Folder Copy Folder Copy Folder Copy 
All Copy All Copy All Copy 

NEW Mode 

Disable Disable Disable 
Folder Folder Folder 
Priority Priority Priority 
Information Information Information 
Pending Pending Pending 
Lock Lock Lock 
Insert Insert Insert 
Mic. Sensitivity Mic. Sensitivity Mic. Sensitivity 
VCVA VCVA VCVA 

STOP Mode 

New New New 



168 / 253 

File Copy File Copy File Copy 
Folder Copy Folder Copy Folder Copy 
All Copy All Copy All Copy 
Index Index Index 
Voice Recognition Voice Recognition Voice Recognition 
Disable Disable Disable 
Verbal Verbal Verbal 
Disable Disable Disable 

REC Mode 

Index Index Index 
Insert Insert Insert 
Speed Speed Speed 
Index Index Index 
Pending Pending Pending 
Priority Priority Priority 
Lock Lock Lock 
Voice Recognition Voice Recognition Voice Recognition 

PLAY Mode 

Disable Disable Disable 

 



169 / 253 

Hands Free 

Connecting a foot pedal to the cradle of the recorder enables hands-free operations. 

 
Items Functions Default 

Operation Settings Selects hands free operations. Dictation 
Foot Pedal Settings Selects foot pedal press methods and the functions to 

be assigned to foot pedals. 
 

 

The following table shows functions that can be assigned to each pedal. 

x Continuous Press 
Function Name Description 

REV/PLAY Rewind (Review) is performed while the pedal is pressed. Releasing 
the pedal performs playback from the indicator position. 

REC/STOP Recording is performed while the pedal is pressed. Releasing the 
pedal stops recording. 

NEW Pressing the pedal creates a new dictation file. 
DISABLE Disables pedal operation. No operation is performed when the pedal 

is pressed. 
CUE/PLAY Fast forward (Cue) is performed while the pedal is pressed. 

Releasing the pedal performs playback from the indicator position. 
INSERT/STOP Insert recording is performed at the indicator position while the 

pedal is pressed. Releasing the pedal stops insert recording. 
STOP Pressing the pedal stops playback. 
EOF/BOF Pressing the pedal moves the indicator to the end of the file. If the 

indicator is already at the end of the file, pressing the pedal moves 
it to the beginning of the file. 

INDEX Pressing the pedal inserts an index mark at the indicator position. 
PRIORITY Pressing the pedal switches the priority of the dictation file being 

recorded. (High<->Normal) 

 

x Short Press 
Function Name Description 

REW Pressing the pedal performs rewind. 
PLAY/STOP Pressing the pedal starts playback from the indicator position. 

Pressing the pedal again stops playback. 
REC/STOP Pressing the pedal starts recording. Pressing the pedal again stops 

recording. 
NEW Pressing the pedal creates a new dictation file. 
DISABLE Disables pedal operation. No operation is performed when the pedal 

is pressed. 
FF Pressing the pedal performs fast forward. 
INSERT/STOP Pressing the pedal starts insert recording from the indicator 

position. Pressing the pedal again during insert recording stops 
insert recording. 

EOF/BOF Pressing the pedal moves the indicator to the end of the file. If the 
indicator is already at the end of the file, pressing the pedal moves 
it to the beginning of the file. 

INDEX Pressing the pedal inserts an index mark at the indicator position. 
PRIORITY Pressing the pedal switches the priority of the dictation file being 

recorded. (High<->Normal) 

 

PC Link 

Programmable Buttons 

Specifies the operations performed when the function buttons ([F1], [F2], [F3]) of the device 
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connected to the PC are pressed. 
 

Items Functions 

Main Window Specifies the operation while the Dictation Module main window is 
active. 

Direct Recording Window Specifies the operation while the Direct Recording window is active. 
Voice Recognition Specifies the operation while the Voice Recognition Editor is active. 
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8.5.3 DS-5000/5000iD/3400 Device Configuration 
 
This section describes the DS-5000/5000iD/3400 device setting items and their functions. 

 

Standalone 
Common Settings 

 General 

 Recording 

 Display 

Administrative Settings 

 General 

 Display 

 Device Security 

 Author List 

 Worktype List 

 Device Folders 

 Recording 

 Programmable Buttons 

 Hands-free 

PC Link 
Programmable Buttons 

 

Standalone Common Settings 

General 
Items Functions Default 

Beep Sound Selects ON or OFF for a beep sound ON 

Power Save Selects power saving time 10 min. 
USB Class Selects Composite or Storage mode as 

the USB connection mode 
Composite 

Selects the card to be accessed 
Only DS-5000/5000iD are supported.  
DS-3400 is not supported. 

SD Card Select 

Disable SD Card Slot 
When this is enabled, access to the SD 
card slot in a device is disabled and the 
connection is not recognizable. 
DS-5000/5000iD are supported.  
DS-3400 is not supported. 

None 

Cue/Review Setting 
(Sound) 

Selects whether or not to play sound 
while fast-forwarding or rewinding during 
play back. 

DS-5000/50
00iD:OFF 
DS-3400:ON 

Cue/Review Setting 
(Speed) 

Sets the Cue/Review speed. Move the 
indicator to the left or right to decrease or 
increase the speed respectively. 

3 

 



172 / 253 

Recording 
Items Functions Default 

Recording Mode Selects the recording mode QP 
Microphone Sensitivity Selects Microphone Sensitivity Dictation 
VCVA Mode Selects ON or OFF for VCVA (Variable 

Control Voice Actuator) mode 
OFF 

 

Display 
Items Functions Default 

Backlight Selects ON or OFF for backlight ON 

LED Mode Selects ON or OFF for the LEDs ON 

Contrast Adjusts the contrast (12 levels) 6 
Sets the display format of date M.D.Y. Date Format 
If synchronizing the recorder time with 
that of the PC, enables "Use PC Settings"

Not 
synchronize
d with the PC 

Clock Format Selects the 12-hour or 24-hour time 
display format 

12-hour 

Language Switches the displayed language for the 
device 

English 
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Standalone Administrative Settings 

General 
Items Functions Default 

Disable Erase button 
With this option enabled, pressing 
[ERASE] on the device will not delete the 
files. 

Disabled 

Disable Menu button 
With this option enabled, pressing 
[MENU] on the device does not display 
the menu window. 
DS-5000/5000iD are supported.  
DS-3400 is not supported. 

Disabled 

Accessibility 

Disable Rewind Button 
When it is checked, the file won't be 
rewound if the [Rewind] button of the 
device (|◀◀) is clicked. 

Disabled 

Splash Message Configures the splash message displayed 
when the device is powered on. 
If characters have been entered in the 
text box with [Custom] enabled, the 
entered characters are displayed when 
the device is powered on. Up to 32 
characters can be entered. They are 
case-sensitive. 

Time of day 
greeting 

Slide Switch Guide When [ON] is selected, the button layout 
of the slider switch is displayed on the 
right edge of the LCD. 
DS-5000/5000iD are supported.  
DS-3400 is not supported. 

OFF 

Main Button Guide When [ON] is selected, the main button 
allocation is displayed on the right side of 
the LCD. 
DS-3400 is supported.  
DS-5000/5000iD are not supported. 

OFF 

Alarm Produces an alarm sound when certain 
operations occur. Turn on the alarm for 
significant events 
(Error/Pre-end/Important/General). 

Error and 
Pre-end 
Notification 

 

Display 
Items Functions Default 

Upper Area Configures the items displayed on the 
upper portion of the device display. 
The following choices are provided: 
- Author ID 
- File Name 
- Worktype 

Author ID 

Lower Area Configures the items displayed on the 
lower portion of the device display. The 
items selected for Upper Area cannot be 
configured. 
- Level Meter 
- File Name 
- Worktype 
- Rec Time 

Level Meter 
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Device Security 
Items Functions Default 

PIN code To enable the Security, click the [PIN 
Code change] button then enter the PIN 
code. 

 

Enable Device Lock function to 
prevent unauthorized access to the
device 
It can be enabled only when the PIN code 
is set. When it is enabled, the followings 
can be set 

Disabled 

Prompt for device PIN code to 
authenticate user 
Select the device lock timing from [At 
power-on] or [At power-on and wake-up 
from stand-by]. 

At power-on 

Device Lock 

Limit the maximam number of 
dvice access to xx times 
Specifies the number of failed 
authentication of the PIN code which 
results to lock the device. 

5 times 

 
 

Author List 
Items Functions Default 

Author List The Author List configured in the 
Workflow is displayed. 
An enabled Author is registered in the 
Author List for the device. 
A disabled Author is removed from the 
Author List for the device. 

[Set as Default] 
Configures the Author selected from the 
Author List as the default Author. 

[Author of Workflow] 
Links to the setting items for the Author 
in the Workflow. 

 

Author Selection Prompt for Author ID at Power-on 
With this option enabled, the Author List 
is displayed when a recording is started 
using the recorder. (However, if only one 
Author has been registered, the list is not 
displayed.) 
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Worktype List 
Items Functions Default 

Worktype List The Worktype List configured in the 
Workflow is displayed. 
An enabled Worktype is registered as a 
Worktype of the device. 
A disabled Worktype is removed from the 
Worktype List for the device. 

[Set as Default] 
Configures the Worktype selected from 
the Worktype List as the default 
Worktype. 

[Worktype of Workflow] 
Links to the setting items for the 
Workflow-Worktype 

 

Worktype Selection Prompt for the Worktype ID on new 
recordings. 

 
With this option enabled, the Worktype 
List is displayed when a new recording is 
made, allowing a Worktype to be selected 
for the dictation File. However, if only one 
Worktype has been registered, the list is 
not displayed. 

Disabled 

 

Device Folders 

The properties can be configured for the folder selected in the [Folder Tree]. 

Items Functions Default 

Enabled 
Enables or disables a folder 

Folders A-E 
enabled, 
Folders F-G 
disabled 

Folder Name 
Specifies the folder name with up to 16 
one-byte alphanumeric characters 

Folders A-G 

Folder Properties (General) 

Worktype 
Specifies the Worktype to be configured 
for dictation files stored in the folder. 
With Worktype specified, the Worktype 
List is not displayed and the Worktype 
configured for the folder is always used, 
even if the [Prompt for Worktype ID on 
new recordings] option has been enabled 
for [Worktype selection]. 

 

Auto Lock 
Sets whether or not to lock dictation files 
stored in the folder 

No Folder Properties 
(Security) 
 

Encryption 
Selects whether or not to encrypt 
dictation files stored in the folder. This 
option can be set only when the folder 
has been enabled. 

No 
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Password 
Configures the password for encryption. 
It can be configured in the Change 
Password dialog box, which is displayed 
by clicking  in the setting box. Enter a 
password in the [New password] and 
[Confirm password] fields using 4 to 16 
one-byte alphanumeric characters. 

 

 

 
About folder configuration on DS-5000/5000iD 
 DS5000/5000iD offers two types of recording media: SD and Micro SD. 

Using the device menu, the user can select either one of the two for 
recording. Both media have the same folder structure with 
"DSS_FLDA" to "DSS_FLDG" folders. This setting is enabled for both 
media. 

About folder configuration on DS-3400 
 DS-3400 only has an SD media slot.                                   

Folder tree structure is the same as DS-500/5000iD.               
There are "DSS FLDA" to "DSS FLDG" folders.                  

 

Recording 
Items Functions Default 

DSS Format Selects the DSS recording format. 
The default recording format for DSS Classic 
is DSS. 
The default recording format for DSS Pro is 
DS2. 
Switches from “DSS Pro” to “DSS Classic” 
mode and checks the items below. 
� If the recording format is set to QP, it is 

changed to SP, and QP is prevented from 
being selected. 
=>[Standalone] – [Common Settings] – 
[Recording] 

� The Encryption attribute is set to "NO" and is 
prevented from being modified. 
=>[Standalone] – [Administrative Settings] 
– [Device Folders] 

DSS Pro 

Record Function Selects the recording operation Overwrite 
File Download Selects the file(s) to be downloaded All Files 

 

Programmable Buttons 

 

Items Functions Default 

New and Slide Switch 
Functions 

Customizes the slide switch locations and 
the functions that are assigned to the 
buttons at the top of the slide switch from 
Type A to C. 
DS-5000/5000iD are supported.  
DS-3400 is not supported. 

Type A 

Main Button Functions Selects the function, which is assigned to 
the main switch button, from Type A to C. 
DS-3400 is supported.  
DS-5000/5000iD are not supported. 

Type A 

Programmable Buttons Customizes the functions that are 
assigned to the function buttons [F1], 
[F2], and [F3] on the device 
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Rec Mode Selects whether or not the REC button 
must be held down to record.  
DS-3400 is supported.  
DS-5000/5000iD are not supported. 

disabled 

 
Functionalities which can be assigned to the function buttons are as follows. 

■DS-5000/5000iD 

Mode F1 F2 F3 

Folder Folder Folder 
Priority Priority Priority 
Information Information Information 
Rec Mode Rec Mode Rec Mode 
Mic.Sensitivity Mic.Sensitivity Mic.Sensitivity 
VCVA VCVA VCVA 

NEW Mode 

Disable Disable Disable 
Folder Folder Folder 
Priority Priority Priority 
Information Information Information 
Pending Pending Pending 
Lock Lock Lock 
Insert Insert Insert 
Mic.Sensitivity Mic.Sensitivity Mic.Sensitivity 
VCVA VCVA VCVA 
New New New 

STOP Mode 

Disable Disable Disable 
Verbal Verbal Verbal 
Index Index Index 
Display Display Display 

REC Mode 

Disable Disable Disable 
Insert Insert Insert 
Speed Speed Speed 
Index Index Index 
Pending Pending Pending 
Priority Priority Priority 
Lock Lock Lock 

PLAY Mode 

Disable Disable Disable 

 

■DS-3400 

Mode F1 F2 F3 

Folder Folder Folder 
Priority Priority Priority 
Menu Menu Menu 
Information Information Information 
Rec Mode Rec Mode Rec Mode 
Mic.Sensitivity Mic.Sensitivity Mic.Sensitivity 
VCVA VCVA VCVA 

NEW Mode 

Disable Disable Disable 
Folder Folder Folder 
Priority Priority Priority 
Menu Menu Menu 
Information Information Information 
Pending Pending Pending 
Lock Lock Lock 
Insert Insert Insert 
Mic.Sensitivity Mic.Sensitivity Mic.Sensitivity 
VCVA VCVA VCVA 
New New New 

STOP Mode 

Disable Disable Disable 
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Verbal Verbal Verbal 
Index Index Index 
Display Display Display 

REC Mode 

Disable Disable Disable 
Insert Insert Insert 
Speed Speed Speed 
Index Index Index 
Pending Pending Pending 
Priority Priority Priority 
Lock Lock Lock 

PLAY Mode 

Disable Disable Disable 
 

 

Hands-free 

Connecting a foot pedal to the cradle of the recorder enables hands-free operations. 

DS-5000/5000iD are supported. DS-3400 is not supported. 

 
Items Functions Default 

Operation Settings Selects hands-free operations Dictation 
Foot Pedal Settings Assigns functions to the foot pedal  

 
Assignable functions and default value (in bold) for each pedal are as follows. 

 
Pedal Operation Rew Pedal LISTEN Pedal FF Pedal 

REV/PLAY REV/PLAY REV/PLAY 
REC/STOP REC/STOP REC/STOP 

Continous Press 

NEW NEW NEW 
REW REW REW 
PLAY/STOP PLAY/STOP PLAY/STOP 
REC/STOP REC/STOP REC/STOP 

Short Press 

NEW NEW NEW 

 

PC Link 

Programmable Buttons 

Specifies the operations performed when the function buttons ([F1], [F2], [F3]) of the device 

connected to the PC are pressed. 

 

Items Functions 

Main Window Specifies the operation while the Dictation Module main window is 
active. 

Direct Recording Window Specifies the operation while the Direct Recording window is active. 
Voice Recognition Specifies the operation while the Voice Recognition Editor is active. 
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8.5.4 DR-2300/2200/2100/1200 Device Configuration 
 
This section describes the device setting items and their functions for DR-2300/2200/2100/1200 DirectRecs 

(digital microphone devices for dictation). 

 

Customize 

Application Control 

 

Customize 

The [Button] column in the Button list displays the actual buttons on DirectRec, and the [Function] column 

lists functions assigned to the buttons. Clicking the Function column for a button opens a pull-down menu, 

which lists functions that can be assigned to the button. Select a function to assign to the button from the 

list. 

User ID 

This option configures the user ID. 

Enable Beep Sound 

Checking this option enables a beep sound. You also can adjust the volume level of the beep sound. 

Enable Button Click Suppression 

Selecting the check box of this item suppresses the DirectRec device button click sound so it is less 

susceptible to pick up by the Directrec device microphone. 
 

Enable Track Ball 

Selecting the check box of this item enables track ball operations. You also can adjust track ball 

sensitivity (movement amount). 

 

The DR-2100 does not have a track ball so the “Enable Track Ball” setting cannot 
be configured. 

 

Application Control 

Assign functions to be performed when Directrec buttons are clicked while recording voice with Direct 

Recording Window or doing Real-time Voice Recognition with Voice Recognition Editor. 

 
Assigned function settings are applied both to the Direct Recording Window and the Voice Recognition Editor. 

 

Some functions, such as Insert Index Mark, are only for Direct Recording Window. 
Some functions, such as Send for Correction are only for Voice Recognition Editor. 
If the currently active window does not support the assigned function, that function is not 
executed on that window. 

 
In addition to Directrec buttons, functions can also be assigned to combinations that involve the PC keyboard 

[Shift] and [Ctrl] key. To execute a function assigned to a key combination, hold the [Shift] or [Ctrl] key on 
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the PC keyboard as you press the applicable Directrec button. 

 

Application Control settings can be saved in a file, so the same settings can be imported by other users. This 

means that the same settings can be setup in multiple user environments, which improves work efficiency. 

 

[Import] 
Imports key function assignments from a file. Click the [Import] button and 
then specify the file you want to import. 

[Export] 
Exports key function assignments to a file. Click the [Export] button and then 
specify the output destination and file name. 

 

Command DR VR Description 

<Empty>   No command is assigned. 
Launch Dictation Module   Starts up Dictation Module. 

Cancel / Exit Y Y 
Stops recording and returns to the Main Window. 
The Dictation Module is disabled while the Main Window is 
displayed. 

Record Verbal Comment Y  
While this button is pressed, verbal comment recording is 
performed from the position of the record indicator cursor. 

Switch between High and 
Normal Priority 

Y Y 
Changes the priority setting of the dictation file being 
recorded. 
(High<->Normal) 

Switch between Conference 
and Dictation 

Y  
Changes the recording sensitivity. 

Switch between Insert and 
Overwrite mode 

Y  
Changes the recording mode. 
(Insert <-> Overwrite) 

Pending Dictation Y Y 

In case of DR, saves the dictation file currently being recorded 
and assigns it Recording Pending status, and closes the Direct 
Recording Window. 
In case of VR, performs the same operation as the “Pending” 
menu item Voice Recognition Editor. 

Finish Dictation Y Y 

In case of DR, saves the dictation file currently being recorded 
and assigns it Recording Finished status, and closes the Direct 
Recording Window. 
In case of VR, performs the same operation as the “Finished” 
menu item Voice Recognition Editor. 

Delete Instruction Comment Y  Delete the instruction comment of the recording file. 
Undo Y Y Undo the last operation. 
Redo Y Y Redo the last undone operation. 
Volume Up Y Y Increases playback volume. 
Volume Down Y Y Decreases playback volume. 
Dictation/Instruction 
Comment mode 

Y  
Toggles between the Instruction Comment record and 
playback modes. 

Insert Index Mark Y  
Inserts an Index Mark at the playback indicator cursor 
position. 

Delete Index Mark Y  
Deletes the Index Mark at the playback indicator cursor 
position. 

Send For Correction  Y 
Performs the same operation as the [Send for Correction] 
menu item of the Voice Recognition Editor. 

Show Correction Dialog  Y 
Performs the same operation as the [Show Correction Dialog] 
menu item of the Voice Recognition Editor. 

Show Spell Dialog  Y 
Performs the same operation as the [Show Spell Dialog] menu 
item of the Voice Recognition Editor. 

Train Word  Y 
Performs the same operation as the [Train Word] menu item of 
the Voice Recognition Editor. 

Add New Word  Y 
Performs the same operation as the [Add New Word] menu 
item of the Voice Recognition Editor. 

Start Dragon Audio Setup 
Wizard 

 Y 
Performs the same operation as the [Start Dragon Audio Setup 
Wizard] menu item of the Voice Recognition Editor. 

Copy to Clipboard Y Y 
Performs the same operation as the [Copy to Clipboard] menu 
item of the Voice Recognition Editor. 
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x In the case of DR, the box displays commands that are enabled during recording with the Direct 
Recording Window. 

x In the case of VR, the box displays commands that are enabled when performing voice recognition 
with Real-time Voice Recognition. 
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8.6 Updates 
 
This category configures whether or not to check for the latest Updates. 

 Procedure 

1. Select [Options] from the Tool menu. 

2. Click [Update]. 

 The Update dialog box will appear. 

3. To configure automatic checking, select [Check for updates automatically] and set 

[Check Interval]. 

4. To check for Updates immediately, click [Check now]. 

5. Click [OK]. 

 The settings will be confirmed. 
 
[OK]: Secures the settings 
[Cancel]: Exits without modifying the settings 
[Apply]: Reflects changes to the configuration file 

 

Dictation Module 

To automatically check for the latest Updates, enable [Check for updates automatically] and set [Check 

Interval]. 

With automatic updating enabled, the Olympus download server is checked for updates at configured 

intervals. In the case of a Workgroup System, either the Olympus download server or the repository in the 

Workgroup System is checked, depending on administrative settings. 

When a newer version than the currently installed one is detected, the confirmation dialog box for upgrading 

appears. If upgrading is selected, the data is downloaded from the server and then updating of Dictation 

Module begins. 

If a proxy server needs to be configured, click [Proxy Settings] and configure the address and port number 

of the server. 
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99  Troubleshooting 
 

This chapter assists in solving problems with Dictation Module. 

 

The Dictation Module Does Not Start Up 

Cannot Perform Direct Recording Window Operations with Directrec 

The System Remains Silent 

DVR Is Not Recognized Updating 

Collecting Information with Log Tool 

Updating 

Changing a Workgroup environment 
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9.1 The Dictation Module Does Not Start Up 
 
If the Dictation Module does not start up, check for the following items. 
 

Other Olympus software is running 

Some Olympus software does not allow the Dictation Module to be started up while it is running. 

Check that none of the following software applications are running. If any one of the following applications 

is running, exit it and then start up the Dictation Module. 

x Olympus Dictation Management System 
Transcription Module / File Downloader 

x DSS Player Pro R5 
Dictation Module / Transcription Module 

x DSS Player Standard 
Dictation Module / Transcription Module 

x Olympus Sonority 
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9.2 Cannot Perform Direct Recording Window Operations 
with Directrec 
 
If the window does not respond when you perform Directrec button operation while you have an Olympus 

Directrec Series device connected to a PC and running the Direct Recording Window or Voice Recognition 

Window, check for the following items. 
 

Device Configuration Manager is running 

Device Configuration Manager is voice recognition support software that is available for free use by those 

who have purchased an Olympus Directrec Series device. A PC that has Device Configuration Manager 

installed starts up Device Configuration Manager whenever the PC is started up. 

While Device Configuration Manager is running, it manages all button operations of any Directrec device 

connected to the PC. At this time, other applications are unable to detect Directrec device button operations. 

Consequently, Direct Recording Window operations are not performed when Directrec buttons are pressed. 

If you want to use Directrec to perform Direct Recording Window operations, exit Device Configuration 

Manager. 
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9.3 The System Remains Silent 
 
If no sound is produced, verify the following items: 

Recorder Connection 

 Check that the device is connected to your PC and turned ON. 
 

Speakers 

 Check that the speaker volume is turned up to an audible level. 
 

Sound Card 

 Check whether or not your sound card features a manual volume control; if it does, try turning 
up the volume. 

 

Playback Volume 

To check this, perform the following steps: 

 Procedure 

1. Click [Settings] - [Control Panel] on the Start menu. 

2. Select [Sounds and Audio Devices] - [Audio], and then click [Volume]. 

3. Check that the volume of [Volume Control] and [Wave] are not set to the minimum 

level and that the [Mute] box is not checked. (Play WAV File) 

With Windows Vista/7, you can adjust the playback volume of each application. If the global system volume 

is set correctly, the Dictation Module specific volume may be turned off. To check this, perform the following 

steps. 

 Procedure 

1. Start up Dictation Module. 

2. On the [Start] menu, click [Control Panel]. 

3. Switch to the category view. Under the [Sound] category, click “Adjust system 

volume”. 

4. The “Volume Mixer” dialog box that appears shows the currently running applications. 

Check that the Dictation Module volume is set to an appropriate level. 
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When running a Terminal Services environment 

When running the Dictation Module under a Terminal Service environment, the client PC needs to have a 

Terminal Services Client Virtual Driver installed. The Terminal Services Client Virtual Driver supports 

playback under Terminal Services. 

Install a Terminal Services Client Virtual Driver that is the same version as the Dictation Module being used. 

The Terminal Service Client Virtual Driver is included on the ODMS R6 Administrators CD. 
 

Software Internal Error 

An internal error that occurs when installing the Dictation Module can cause incorrect installation of the 

playback program. This will cause the message “Run OlyCodecFilterSetup.exe.” to appear when the 

Dictation Module is started up. 

If this happens, run OlyCodecFilterSetup.exe, which is located in the Dictation Module installation folder. This 

will perform a repair setup of the playback module, and may enable proper operation of the playback 

program. 

If the same message appears after you run OlyCodecFilterSetup.exe, contact your Olympus Dealer where 

you purchased the product. 
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9.4 DVR Is Not Recognized 
 
If the recorder connected to the PC is not recognized, verify the following items: 

 Procedure 

1. After connecting the recorder to your PC using a USB cable, check that the LCD 

display of the Digital Voice Recorder reads REMOTE. 

2. If REMOTE is not displayed, remove the USB cable from the recorder and check that 

the Stop mode and the hold switch are not enabled. 

3. Reconnect the USB cable to the recorder and check that the LCD display reads 

REMOTE. 

4. If it still does not display REMOTE, try connecting the device to an alternative USB 

port. 
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9.5 Collecting Information with Log Tool 
 
Olympus Dictation Management System R6 provides the ability to trace and log a series of application 

operations. To perform logging, the modules to be logged have to be specified before the application is 

started. When a problem is encountered, it is recommended that the PC operating conditions and the log 

data of the problematic areas be sent to your dealer or distributor. 

 Procedure 

1. Open the Dictation Module installation folder with the Windows Explorer, and 

double-click ODMSLogTool.exe. 

 The ODMS Log Tool dialog box will appear. 
 

 
 

2. Check the Trace column of the modules to be logged. 

 
The log output generates a large amount of information, resulting in slower operations 
of Dictation Module. It is recommended to check only problematic modules. 

3. Click  next to the Output Path field to specify the log output path. 

4. Click [Set]. 

 will appear at the items configured for logging, setting the application to the log output 
mode. 
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When Dictation Module is started the next time, log outputs will begin for the specified items. 

5. Perform a problematic operation with Dictation Module, and then exit the 

application. 

6. Click [Reset all]. 

 A confirmation dialog box will appear. Clicking [OK] disables the log output configuration. 

7. Click [Copy Profiles] if needed. 

 A Dictation Module settings file will be generated into the folder specified in the [Profile Output 
Path] 

8. Click [Send log Files]. 

Mail software will start, creating an email with ODMSLog.zip, a compressed log file and settings 
information. 

9. Write the required information in the email and send it to your dealer or distributor. 
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9.6 Updating 
 
It is recommended to keep software up-to-date. 

Check for updates and update the software. 

 

Updating Dictation Module 

To update Dictation Module, perform the following steps: 

 Procedure 

1. Select [Check for Update] from the Help menu. 

The Olympus download server will be checked for updates. 
When a version newer than the currently installed one is detected, the confirmation 
dialog box for updating will appear.  

2. Select updating. 

 The data will be downloaded from the server and updating of Dictation Module will begin. 
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9.7 Changing a Workgroup environment 
 
You can change the license server and repository settings after installing the Dictation Module as a 

Workgroup system. 

 

 
Administrator privileges are required to change license server and repository settings 
with the Dictation Module. If you are running the Dictation Module on a computer that 
is running Windows Vista or Windows 7, you will be required to open the application by 
right-clicking the Dictation Module icon in the Start menu, and then clicking ” Run as 
administrator”. 

 

Changing a repository (automatic updating) 

If the previously used repository is left on the network or if repository service is still running, settings will be 

automatically reconfigured so the new repository is referenced, even if you do not change any settings with 

the Dictation Module. 

When the repository is moved in the case of a shared-folder repository, the System Configuration Program 

records information for a redirect to the new repository in the old repository folder. The Dictation Module will 

automatically redirect and update upon launch. 

In the case of a repository service configuration, the System Configuration Program switches the mode of 

the old repository service to notification of the new repository service location. When the Dictation Module 

is started up and receives redirect information from the old repository service, it automatically reconfigures 

settings to access the new repository service. 

If the old repository folder is deleted or if it cannot be accessed for some reason making automatic 

configuration of settings impossible, you should reconfigure settings manually. 

 

Changing a repository (manually) 

To change a repository manually, perform the following steps: 

 Procedure 

1. Select [Change Repository] from the [Workgroup] menu. 

 The “Change Repository” dialog box will appear. 

2. On the Change Repository dialog box, specify the new repository path, or the name 

and port number of the PC running the repository service. 

3. Click [OK]. 

 
In the case of a shared-folder configuration, logged in users need to have full-access 
rights to the network folder specified as the repository. Before changing the settings, 
verify that you have the proper access rights the new repository folder. 

It is impossible to implement the operation without the proper access rights, even if you 
click [OK] 
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Changing the License Server 

To change the license server, perform the following steps. 

 Procedure 

1. Select [Change License Server] from the [Workgroup] menu. 

 The “Change License Server” dialog box will appear. 

2. Enter the IP address for the new license server, or enter the PC name and port 

number. 

3. Click [OK]. 

 
When you click [OK], the Dictation Module will access the license server. 

Once access has been confirmed, setup is complete. If access cannot be confirmed, 
setup will remain incomplete. 

Before changing the settings, complete setup for the license server. 
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1100  Appendix 
 

Names and Functions of Window Components 

Menu List (Main Window) 

Menu List (Voice Recognition Editor/Real-time Voice Recognition) 

Menu List (Voice Recognition Editor/Text Correction) 

File Property Lists 

Default Key Assignments 

Names and Functions of the Option Settings Dialog Boxes Components 
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10.1 Names and Functions of Window Components 
 
This section describes the names and functions of Dictation Module screens. 

 

Main Window 

Playback Control Window 

Direct Recording Window 

Voice Recognition Editor 

Dictation Tree View (Main Window) 

Device Tree View (Main Window) 

Content List View (Main Window) 

Information View (Main Window)  

Properties View (Main Window) 

 

Main Window 

 

This is the main window of Dictation Module. It is used to organize and play files. The Direct Recording 

window and Playback Control window are opened via the Main window. 

The names and functions of the Main window components are described here. 
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Title Bar 
Displays the standard Windows title bar 

 

Menu Bar 
Displays the menu used with Dictation Module 

 

Toolbar 
Displays toolbar buttons, which are divided among four groups: Standard, Editing, Mail/FTP, Voice 
Recognition. Displayed buttons vary depending on the settings. Dragging a toolbar button with the 
[Alt] key pressed can change the display order of the buttons. Right-clicking the toolbar displays 
the context menu, which can be used to show or hide the buttons. 

 

Playback Control Bar 
Used to play the dictation File selected in the Content List View. The Playback Control bar provides 
functions and ways of use similar to the Playback Control window. 

 

Dictation Tree View 
Displays various folders storing audio and document files managed by Dictation Module. 
Organization and properties of the folders can be configured based on the user's needs. Selecting 
a folder displays audio and document files in the folder in the Content List View. 

 

Device Tree View 
Displays folders in connected devices and cards. Selecting a folder displays the dictation files in the 
folder in the Content List View. 

 

Content List View 
Lists audio or document files in the folder selected in the Dictation Tree View or Device Tree View 

 
Information View 
Displayed by clicking [Restore] in the Content List View. This view displays information on content 
in the Content List View, including the content of a document file and the message of a sent email. 
In addition, voice recognition information is also displayed in the information view. 

 

Properties View 
Displays the properties of the file or folder that is currently being focused on 

 

Status Bar 
Displays the following information: 

First Area (Operating state display): 
Displays the current operating state. In the halt condition, the number of content items listed in 
the Content List View and the number of selected content items among them are displayed. 

Second Area (Icon display): 
Displays the progress of files being automatically sent via email or FTP. Double-clicking this area 
with an icon displayed shows the Status dialog box, where you can see the progress of 
transmission. When an error occurs, an icon appears. By double-clicking the icon, the details of the 
error can be checked. 

 Third Area: 
Displays Author ID. If no Author ID has been registered, the Windows logon ID is displayed. 
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Playback Control Window  

 

The names and functions of the Playback Control window components are described here. 

The Playback Control window is displayed by clicking [Switch to Playback Control Window] on the View menu 

in the Main window. This window is specialized for playing a file. It is used to perform tasks like writing a 

document while listening to a recorded file. Exiting the window brings the user back to the Main window. 

 

 

 
Title Bar 
Displays the name of the file that is currently being played and the name of the folder in 
which the file is stored. 

 
Control Panel 

Priority Button 
This mark indicates the priority of the file. A red mark means that the file is assigned high 
priority. 

 Audio/Instruction Comment Mode Switching Button 
Switches between audio playback and Instruction Comment playback. In Instruction 
Comment mode, the icon turns to green and the Play bar is surrounded by a green line. 

 Information Button 
Clicking this button displays property information of a file. The Main window does not 
have this button. 

 User Settings Button 
Clicking this button displays the User Settings dialog box. Playback condition and 
Transcribe Bar settings can be changed. 

Show Status Bar Button 
Shows or hides the status bar. The Main window does not have this button. 

 Play Bar and Position Slider 
Graphically displays which part of the current file is being played. The range, from the 
beginning to the currently played position, is represented with , and 
verbal-commented ranges are represented with . 

Index Mark 

Clicking  inserts an index mark at the point of the Position control.  

Displayed Area Slider 
Indicates the currently displayed range in the file with . Dragging the slider shifts the 
displayed range. 
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Control Buttons 
Pressing these buttons moves the Playback Position control. 

: Moves to the beginning of a file 

: Moves to the previous index mark or to the edge of a verbal comment 

: Rewinds a file. Holding the button speeds up rewinding. 

 / : Starts playback. Pressing this button during playback stops it. 

: Fast-forwards a file. Holding the button speeds up fast-forwarding. 

: Moves to the next index mark or to the beginning (or end) of a verbal comment 

: Moves to the end of a file 

 Playback Position/Recording Time Length 
Displayed on the immediate right of the Play bar in the format of HH:MM:SS. The 
playback position of a file is displayed in blue, and the total recording time length is 
displayed in white. 

 
 Timescale Control 

Displays the timescale of the Play bar. The time frame can be changed in the range of a 
1-minute width to full scale. Clicking  or  changes the timescale. 

 
Volume Adjustment Control 

Adjusts output sound volume. This function is not available with an older sound board 
that does not have electronic volume adjustment capability. If that is the case, adjust the 
volume manually. 

 
Audio Output Display 

Displays the current state of audio playback. In the case of monoral recording, the L and 
R outputs are displayed at the same height. 

 
Playback Speed Adjustment Control 

Clicking  and  or dragging the slider adjusts the playback speed without changing 
the voice pitch (sound pitch).This control is hidden by default. 

 
Noise Cancellation Control 

Clicking  and  or dragging the slider adjusts the noise cancellation effect in four 
levels of 0, 1, 2, and 3.This control is hidden by default. 

 
Tone Adjustment Control 

Clicking  and  or dragging the slider adjusts the tone in increments of 1% from 
100% on the B side to 100% on the T side.This control is hidden by default. 

 
Status Bar 
Displays the following information: 
First Area: The current operating state (Play, Stop, Fast-forward, Rewind, QUE, REVIEW) 
Second Area: Author ID 
Third Area: Worktype 
Fourth Area: Comment 
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Direct Recording Window  

 

The names and functions of the Direct Recording Window components are described here. 

The Direct Recording Window is displayed by clicking  or  in the Main window, or by clicking [New 

Dictation] or [Edit Dictation] on the [File] menu. This window is used to create (record) and edit a file with 

a supported device. Exiting the window brings the user back to the Main window. 

 

 
Title Bar 
Displays the name of the file that is currently being edited and the name of the folder in 
which the file is stored 

 
Toolbar 
Displays the toolbar buttons. Displayed buttons vary depending on the settings. 
Dragging a toolbar button with the [Alt] key pressed can change the display order of the 
buttons. 

 
Control Panel 

Priority Button 
This mark indicates the priority of the file. A red mark means that the file is assigned high 
priority. 

Audio/Instruction Comment Mode Switching Button 
Switches between audio playback and Instruction Comment playback. In Instruction 
Comment mode, the icon turns to green and the Play bar is surrounded by a green line. 

Information Button 
Clicking this button displays the property information of the file. The Main window does 
not have this button. 

 Recording Mode 
Switches between Insert and Overwrite recording modes 

 Microphone Sensitivity 
 indicates the sensitivity for dictation recording and  represents the sensitivity 

for conference recording. This is available with DS-5000/5000iD/3400 or DirectRec. 

 User Settings Button 
Clicking this button displays the User Settings dialog box. Playback condition and 
Transcribe Bar settings can be changed. 

 Show Toolbar Button 
Shows or hides the Toolbar. The Main window does not have this button. 

 Show Status Bar Button 
Shows or hides the status bar. The Main window does not have this button. 

 Select Speaker  
Selects the speaker supplied with a PC or the one provided by a connected digital voice 
recorder. 
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Select Microphone 
Selects the microphone supplied with a PC or the one provided by a connected digital 
voice recorder. 

 
Play Bar and Position Slider 
Graphically displays which part of the current file is being played. The range, from the 
beginning to the currently played position, is represented with , and 
verbal-commented ranges are represented with . 

Index Mark 

Clicking  inserts an index mark at the Position control point. 

Displayed Area Slider 
Indicates the currently displayed range in the file with . Dragging the slider shifts the 
displayed range. 

 
Control Buttons 
Pressing these buttons moves the Playback Position control. 

: Moves to the beginning of a file 

: Recording will begin 

: Record a verbal comment only while this button is being pressed. 

: Moves to the previous index mark or to the edge of a verbal comment 

: Rewinds a file. Holding the button speeds up rewinding. 

 / : Starts playback. Pressing this button during playback stops it. 

: Fast-forwards a file. Holding the button speeds up fast-forwarding. 

: Moves to the next index mark or to the beginning (or end) of a verbal comment 

: Moves to the end of a file 

 

Status Bar 
First Area: The current operating state (Play, Stop, Fast-forward, Rewind, CUE, REVIEW) 
Second Area: Author ID 
Third Area: Worktype 
Fourth Area: Comment 

 
Playback Position/Recording Time Length 

Displayed on the immediate right of the Play bar in the format of HH:MM:SS. The 
playback position of a file is displayed in blue, and the total recording time length is 
displayed in white. 

 
 Timescale Control 

Displays the timescale of the Play bar. The time frame can be changed in the range of a 
1-minute width to full scale. Clicking  or  changes the timescale. 

 Volume Adjustment Control 
Adjusts output sound volume. This function is not available with an older sound board 
that does not have electronic volume adjustment capability. If that is the case, adjust the 
volume manually. 

 
Audio Output Display 

Displays the current state of audio playback. In the case of monoral recording, the L and 
R outputs are displayed at the same height. 

 
Playback Speed Adjustment Control 

Clicking  and  or dragging the slider adjusts the playback speed without changing 
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the voice pitch (sound pitch). 

 
Noise Cancellation Control 

Clicking  and  or dragging the slider can adjust the noise cancellation effect in four 
levels of 0, 1, 2, and 3. 

 
Tone Adjustment Control 

Clicking  and  or dragging the slider adjusts the tone in increments of 1% from 
100% on the B side to 100% on the T side. 

 
[Finished] 
Stops and exits a recording. The file can then be transcribed. 

[Pending] 
Closes the window in Pending state. The file will be stored in Pending status in the 
Recording tray. 
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Voice Recognition Editor 

This is the screen that appears for text editing when performing real-time voice recognition or after doing 

voice recognition with Dictation Module. 

In the case of a dictation file that has been transcribed without using voice recognition, the application 

associated with the file format of the text file is started up. As the same when voice recognition is performed 

with DSS Player Pro R5: the application that matches the file format of the text file is started up (but not 

displayed in this window). 

 

 
Title Bar 
Shows the folder name and file name currently being recorded or played back. 

 
Menu Bar 
Displays menus of various commands used for voice recognition and text correction. 
Command availability depends on the status of the file. 
For information about the functions of each menu, refer to “Menu List (Voice Recognition 
Editor/Real-time Voice Recognition)” or “Menu List (Voice Recognition Editor/Text Correction)”. 

 
Toolbar 
Displays buttons that execute various commands used for voice recognition and text 
correction. 
A large variety of different commands including dictation record, playback, stop and other 
commands, and font operation and other text editing commands. 
Command availability depends on the status of the file. 
For information about the functions of each button, refer to “Menu List (Voice Recognition 
Editor/Real-time Voice Recognition)” or “Menu List (Voice Recognition Editor/Text Correction)”. 

 
Text Display Area 
This area show text that is output by voice recognition. 
When using real-time voice recognition, text is output in sequence from passages for which 
Dragon NaturallySpeaking voice recognition processing is complete. 
When editing voice recognition results, text editing can be performed while operating the 
toolbar playback controls to playback the dictation. When performing real-time voice 
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recognition, use of both manual input and Dragon NaturallySpeaking editing functions is 
supported. For text editing after voice recognition is complete, only manual text editing is 
available. 
When playing back dictation, the text that corresponds to the current playback location is 
highlighted in order to give you an idea of the location of the text that is playing back. 

 
Status Bar 

The left area of the status bar shows the dictation playback/recording status, and other 
information. 
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Dictation Tree View (Main Window) 

 

The Dictation Tree View is displayed on the left side of the Main window. 

 

 
Title 
Displays the name of the view 

 Pin Button 
Switches the display mode of the view between automatically hidden and always 
displayed 

 (On): Always displayed 

 (Off): Automatically hidden when not in use. To display the view again, press  in 
the Content List View. 

 
Toolbar 
Displays the tool buttons for working with a file. 
For information on the functions, refer to the Folder menu section in Menu List. 

 
The folder structure is displayed under the Dictation tray. 
For information on each folder, refer to How Folders Work. 

 
[Hide/Restore] button 

Pressing  hides the Device Tree View. 

Pressing  shows the Device Tree View again. Note that if no device is connected, 
pressing this button does not show any view. 
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Device Tree View (Main Window) 

 

The Device Tree View is displayed on the left side of the Main window. 

This view is displayed when the device is connected. It displays, with icons, the devices supported by 

Dictation Module. 

 

 
Toolbar 
Displays the tool buttons for working with a file. 
For information on the functions, refer to the Device menu section in Menu List. 

 
 
The folder structure under Device Manager is displayed. 
For information on each folder, refer to How Folders Work. 
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Content List View (Main Window) 

 

The Content List View is displayed in the center of the Main window. It cannot be hidden. 

 

 
, : Shows or hides the Dictation Tree View 

Title 
Displays the name of the list view (either the Dictation List or Document List) displayed 
in the view area 

: Switches the Filter of the list view on or off 

: Switches the in-line editing function of the list view on or off 

, : Shows or hides the Properties view 

 
View Area 
Displays audio or document files in the folder selected in the Dictation Tree or Device 
Tree View 

 
[Hide/Restore] button 

Pressing  hides the Information View. 

Pressing  shows the Information View again. 
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Information View (Main Window) 

 

The Information view is displayed at the bottom center of the Main window. The default setting hides this 

view. 

 

 
Title 
Shows the screen title displayed by the information view. 

: Switches the displayed view 

 Pin Button 
Switches the display mode of the view between automatically hidden and always 
displayed 

 (On): Always displayed 

 (Off): Automatically hidden when not in use. To show the view again, press . 

 
View Area 

Document List 
Lists all the document files under the Document tray when the contents of the Dictation 
folder are displayed in the Content List View. Dragging one of the document files to a 
dictation file in the Content List View can link the document file with the dictation File. 

Mail Preview 
Displays the content of email. When sending a dictation file selected in the Content 
List View via email, its content is displayed. 

Voice Recognition Waiting List 

Shows the background voice recognition file queue and a progress bar of the current 
ongoing background voice recognition process. (Buttons are displayed only when the 
“Use voice recognition” option is selected on the Option Settings dialog box.) 

Voice Recognition Result List 

Displays a list of background voice recognition results. If voice recognition fails for some 
reason, the reason for the failure is also displayed. (Buttons are displayed only when the 
“Use voice recognition” option is selected on the Option Settings dialog box.) 

Adaptation Wating List 
Shows the adaptation (function for feeding back voice recognition corrections) file 
queue. (Buttons are displayed only when the “Use voice recognition” option is 
selected on the Option Settings dialog box.) 
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Properties View (Main Window) 

 

The Properties view is displayed on the right side of the Main window. The default setting hides this view. 

 

 
Title 
Displays the name of the view, either "Property" or "Job History." 

  : Switches the displayed view 

 Pin Button 
Switches the display mode of the view between automatically hidden and always 
displayed 

 (On): Always displayed 

 (Off): Automatically hidden when not in use. To display the view again, press  in 
the Content List View. 

 Property View 
Displays the properties of the selected file or folder. The items displayed in black 
characters can be edited. 

: Displays the properties by category 

: Displays all properties in alphabetical order 

: Displays the history of the dictation file 

Job History View 
Displayed only when Dictation is selected in the Content List View. It displays the history 
from the creation of the selected dictation File to the completion of its transcription (or to 
the completion of transmission if the dictation File has been sent via email or FTP). 
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10.2 Menu Lists (Main Window) 
 
This section describes the menus provided by Dictation Module. 

 

[File] Menu 

[Folder] Menu 

[Edit] Menu 

[View] Menu 

[Play] Menu 

[Tool] Menu 

[Device] Menu 

[Voice Recognition] Menu 

[Workgroup] Menu 

[Help] Menu 

 

10.2.1 [File] Menu 
 

Command Name Button Functions 

New Dictation 
 

Opens the Direct Recording window and 
creates a new dictation File 

Edit Dictation 
 

Displays a selected dictation File in the 
Direct Recording window, allowing file 
editing 

Convert Dictation 
 

Converts a selected dictation File into a 
specified file format 

Import Dictation 
 

Imports an external dictation File not 
managed by Dictation Module so that 
Dictation Module can manage it 

Export Dictation 
 

Converts a selected dictation File into 
external media 

Split 
 

Splits a selected file at a specified 
position into two files 

Join 
 

Joins multiple files into a single file 

Encrypt 
 

Encrypts a selected file 

Decrypt 
 

Decrypts a selected encrypted file 

Open Document 
 

Opens a selected document file. When 
running this operation with a dictation file 
specified, the linked document file will 
also open. 

Associate with 
Document   

Associates a selected dictation File with a 
specified external document file. The 
associated document file will be copied to 
My Documents and managed with the 
link. 

Remove Association 
with Document  

Dissociates a dictation file from its linked 
document file 

Edit Job Data 
 

Edits the job data of a selected dictation 
File. Job data refers to several editable 
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settings: Author ID, Worktype ID, Option 
Items, and Comments. 

Change Status 
 

Changes the status of a selected 
dictation File 

Exit Ctrl+W Exits Dictation Module 

 

10.2.2 [Folder] Menu 
 

Command Name Button Functions 

New Folder 
 

A subfolder will be created in a highlighted 
folder in the Download tray. 

Add Folder 
 

Opens the Select Folder dialog box, with 
which, at the same tier as the Download 
tray, you can create a shortcut folder for a 
path to a specified external folder 

Remove Folder 
 

Deletes the subfolder created with [New 
Folder] and removes the shortcut folder 
created with [Add Folder]. 

Rename Folder 
 

Renames a selected folder. 
The folders in the Download tray and 
custom folders are shortcut folders 
maintained internally by DSS Player.  
When renaming is applied to these folders, 
only the shortcuts are renamed, not their 
actual folders. Subfolders are real folders 
and can be renamed. 

Folder Settings 
 

Starts the Folder Design dialog box, with 
which you can configure the attributes of a 
folder 

 

10.2.3 [Edit] Menu 
 

Command Name Button Functions 

Cut 
 

Copies a selected dictation File to the 
clipboard. Pasting the dictation File after 
cutting it moves the file to the specified 
folder. 

Copy 
 

Copies a selected dictation File to the 
clipboard  

Paste 
 

Moves or copies the dictation File, which was 
copied to the clipboard with the Cut or Copy 
command, into a specified folder 

Delete 
 

Deletes a selected audio or document file 

Select All - Selects all the files in the Content List View 

Copy to Folder 
 

Copies the dictation File selected in the 
Content List View to a specified folder 

Move to Folder 
 

Moves the dictation File selected in the 
Content List View to a specified folder 
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10.2.4 [View] Menu 
 

Command Name Button Functions 

Switch to Playback 
Control Window  

Switches from the Main window to the Playback 
Control window. The dictation File selected in 
the Main window begins playing. 

Folder Navigation - 
Shows or hides the Dictation Tree View or 
Device Tree View 

Property Window - Shows or hides the Properties View 

Information Window - Shows or hides the Information View 

Toolbar - 
Toggles the toolbar between show and hide. 
“Customize” can be used to specify the buttons 
to appear on each toolbar. 

Status Bar - Shows or hides the status bar 
Playback Control Bar - Shows or hides the Playback Control bar 

Gridlines - 
Shows or hides the grid lines in the Information 
View 

Columns to Display - 
Shows or hides the columns in the Dictation 
Tree View and configures their displayed order 

Sort by - 
Sorts files in alphabetical order by the columns 
selected in the Information View 

Filter On/Off  

 

Enables or disables the filtering function 

In-line Editing  

 

Enables or disables direct editing of the items 
displayed in the Dictation Tree View. Clicking a 
configurable item in the list makes the field 
editable. 

Refresh 
F5 

 

Refreshes the Dictation Tree View in the Main 
window. The Dictation Tree View refers to 
cached data for speeding up the display. Since 
refreshing the list causes the cached data to be 
rebuilt, it may take a while to display a large 
list. 
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10.2.5 [Play] Menu 
  

Command Name Button Functions 

Play/Stop  

 

Plays a selected file or the first file on the list 
in the Content List View from the Position 
control point on the Play bar. Clicking this 
menu during playback stops it. 

Fast Forward  
Fast-forwards a file. Holding the button 
speeds up fast-forwarding. 

Rewind  
Rewinds a file. Holding the button speeds up 
rewinding. 

Next Index Mark  
 

Moves the Position control to the next index 
mark or to the beginning (or end) of a verbal 
comment 

Previous Index Mark 
 

Moves the Position control to the previous 
index mark or to the beginning (or end) of a 
verbal comment 

Volume  Adjusts output sound volume 

Speed 
 

Speeds up or slows down playback 

Tone 
 

Configures the tone, placing an emphasis on 
the high or low pitch areas 

Noise Cancellation 
 

Selects the level of noise cancellation from 0, 
1, 2, and 3. A larger number means a higher 
effect of noise cancellation. 

Insert Index Mark 
 

Inserts an index mark at the Position control 
point 

Delete Index Mark 
 

Deletes an index mark at the Position control 
point 

View All Index Marks 
 

Displays the View All Index Marks dialog box 

Next Verbal Comment  
The Position control moves to the next index 
mark or to the beginning (or end) of a verbal 
comment 

Previous Verbal 
Comment 

 
The Position control moves to the previous 
index mark or to the beginning (or end) of a 
verbal comment 

Dictation/Instruction 
Comment Mode 

F10 

 

Switches between Dictation File mode and 
Instruction Comment mode if an Instruction 
Comment has been recorded in the currently 
selected dictation File 

Intro Scan  

Sequentially plays only the first five seconds 
of the files selected or displayed in the 
Content List View 
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10.2.6 [Tool] Menu 
 

Command Name Button Functions 

Select Speaker  

 

Selects the speaker supplied with a PC or the 
one provided by a connected digital voice 
recorder when playing a file 

Send Via E-mail 
 

Manually moves a selected dictation File to the 
email sending box. If multiple email profiles 
have been registered, select a profile for 
transmission with the pop-up menu. 

Send Via FTP 
 

Manually sends a selected dictation File via 
FTP 

Send and Receive 
 

The Send command sends an email in the 
sending box or a file via FTP to the server. 
When the transmission successfully 
completes, the dictation File will move to Sent 
Items. The Receive command initiates the 
reception of document files. 

Hot keys On/Off  

 

Enables or disables Hot keys 

Keyboard Settings 

- Displays the user-configured keyboard 
options. It enables the user to assign Hot keys 
to Dictation Module commands, and to delete 
or modify the assignments. 

OLE Settings - 

Selects the way to handle audio data, when 
dropping a DSS or DSS Pro file selected in the 
Content List View to an OLE-enabled 
application, from the following: 
� Embedding the dictation File in a document 
file 
� Embedding only the link information in a 
document file 

Options 
 

Displays the Option Settings dialog box for 
Dictation Module 

Show Setup Wizard - 
Displays Setup Wizard.  
Only displayed if Dictation Module is installed 
in a Standalone System. 
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10.2.7 [Device] Menu 
 

Command Name Button Functions 

Download Folders A-G - 

Downloads all files in Folders A-G in the device 
displayed in the Device Tree View (recorder, 
PCMCIA card, or removable drive) into the 
corresponding Folders A-G in the Download tray 
in the Dictation Tree View 

Download Selected 
Files 

- 
Downloads only selected files into the Download 
tray in the Dictation Tree View 

Download All 
 

Downloads all files in the device displayed in the 
Device Tree View into the corresponding Folders 
A-G in the Download tray. Files in the removable 
drive that have no folder are downloaded into 
Folder A. 

Upload Selected Files 
 

Uploads the files selected in the Dictation Tree 
View into the device displayed in the 8Device Tree 
View  

Change Device Mode 
 

Switches device mode of a connected device to 
Audio mode or Storage mode 

Change Storage Media  
 

This command is available only for models that 
support two types of storage media. This 
command specifies the contents of which media 
is displayed when the device is connected via 
USB to the PC. It is impossible to display the 
contents of both media simultaneously. 

Synchronize 
Date/Time  

Synchronizes the date and time of the recorder 
with those of the PC. The device can also be 
automatically synchronized with the PC when 
connected. 

Device Settings 
 

With this menu, the functions of a connected 
device can be configured via the PC. 

 

10.2.8 [Voice Recognition] Menu 
 

Command Name Button Functions 

Do Real-time Voice 
Recognition  

Starts up the Voice Recognition Editor and 
executes real-time voice recognition. 

Add to Recognition 
Queue  

Registers the dictation file that is selected in the 
content list view into the Recognition Queue. 

Start Recognition 
Queue  

Executes background voice recognition. 
Voice recognition of dictation files registered in 
the voice recognition queue is performed in 
sequence. 

Stop Recognition 
Queue  

Stops ongoing background voice recognition. 

Move to the Top 
Position - 

Moves the dictation file that is selected in the 
voice recognition queue up in the queue to the 
position following the dictation file on which 
background voice recognition is currently being 
performed. In the displayed voice recognition 
queue, the file is moved so it is directly under the 
dictation file on which background voice 
recognition is currently being performed. 

Requeue 
 

Re-registers the dictation file that is selected in 
the voice recognition result list into the queue. 
Only a dictation file whose voice recognition has 
failed for some reason can be requeued. A file 
whose voice recognition was successful cannot 
be requeued. 
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Details - 
Shows detailed information about the voice 
recognition result of a dictation file that is 
selected in the voice recognition result list. 

Add to Adaptation 
Waiting List  

Registers the dictation files and text corrections 
that are managed in the adaptation folder in the 
Adaptation queue. 

Adapt All Files 
 

Performs adaptation on all of the dictation files 
registered in the adaptation queue. Users can 
select to do either vocabulary adaptation or 
acoustic adaptation, or both vocabulary 
adaptation and acoustic adaptation. 

Do Vocabulary 
Adaptation  

Performs vocabulary adaptation only on the 
dictation file selected in the adaptation queue. 
If a selected dictation file has already had 
vocabulary adaptation performed, that file will 
be ignored. 

Do Acoustic 
Adaptation  

Performs acoustic adaptation only on the 
dictation file selected in the adaptation queue. 
Vocabulary adaptation needs to be performed 
first before performing acoustic adaptation. If a 
selected dictation file has not yet had vocabulary 
adaptation performed, that file will be ignored. 

Remove from the 
Queue  

Deletes the selected dictation file from the voice 
recognition queue or other displayed voice 
recognition function list. 

Clear the Queue 
 

Deletes all of the files from the voice recognition 
queue or other displayed voice recognition 
function list. 

Check All Items 
 

Selects ON for all dictation files registered in the 
voice recognition queue. 

Uncheck All Items 
 

Selects OFF for all dictation files registered in the 
voice recognition queue. 

Voice Recognition 
Settings 

- 

Displays the page that appears when the 
following operation is performed on the Option 
Settings dialog box: [Workflow] – [Voice 
Recognition] – [General]. 

 

10.2.9 [Workgroup] Menu 
 

Command Name Button Functions 

Change Repository - 
Configure settings for repository. 
Administrative privileges are needed to 
modify the settings. 

Change License 
Server 

- 
Configure settings for license server. 
Administrative privileges are needed to 
modify the settings. 

   

 
The [Workgroup] menu will appear only when the Dictation Module is installed in 
Workgroup mode.  
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10.2.10 [Help] Menu 
 

Command Name Button Functions 

Contents F1 Displays the Help for Dictation Module 

Check for Updates - 
Checks the Olympus download server for 
the latest Updates and downloads them if 
present 

Device Manual 
Download Site - 

Starts up your Web browser and displays 
the Olympus Website that publishes device 
instruction manuals. 

About Dictation 
Module 

- 
Displays the version information of 
Dictation Module 
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10.3 Menu List (Voice Recognition Editor/Real-time Voice 
Recognition) 
This section explains the Voice Recognition Editor menu that is displayed during real-time voice recognition. 

 
[File] Menu 

[Edit] Menu 

[View] Menu 

[Dictation] Menu 

[Dragon Commands] Menu 

[Voice Information] Menu 

[Help] Menu 

 

10.3.1 [File] Menu 
 

Command Name Button Functions 

Copy to Clipboard 
 

Copies text files that have text formatting to the clipboard. 
After copying, the text with the text formatting can be pasted 
into MS word or some other application. 

Send for correction 
 

Saves dictation data and the text file and changes the file status 
to VoiceRecognition.Finished. 
Files are handled as: “recording and voice recognition complete, 
text file to be corrected”. Though subsequent add-on recording 
to the dictation file is not possible, the text can be edited. 
Use this command to request correction and other tasks of the 
typists after author recording is complete. 

Finished 
 

Saves dictation data and the text file and changes the file status 
to Transcription.Finished. 
Files are handled as: “dictation recording and text file editing 
complete”, and subsequent add-on recording and text editing is 
not possible. 

Pending 
 

Saves dictation data and the text file and changes the file status 
to Transcription.Pending. 
Add-on recording and text editing can be restarted later. 

Cancel 
 

Cancels changes and closes the Voice Recognition Editor. 

 

10.3.2 [Edit] Menu 
 

Command Name Button Functions 

Undo 
 

Undoes the last operation. 

Redo 
 

Redoes the last undone operation. 

Cut 
 

Copies the text currently selected in the text display area to the 
clipboard. Executing Cut and then Paste will move the cut text to 
the cursor position. 

Copy 
 

Copies the text currently selected in the text display area to the 
clipboard. 

Paste 
 

Moves text put on the clipboard with Cut or copies text put on 
the clipboard with Copy to the cursor location. 

Select Next Word - Selects the next word relative to the cursor position in the text 
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display area. 

Select Previous Word - 
Selects the previous word relative to the cursor position in the 
text display area. 

Capitalize Word - 
Capitalizes the first letter of each sentence in the text selected in 
the text display area. 

 

10.3.3 [View] Menu 
 

Command Name Button Functions 

Toolbar - 
Toggles toolbars between show and hide, specifies the buttons 
displayed in toolbars, etc. 

Status Bar - Toggles the status bar between show and hide. 

 

10.3.4 [Dictation] Menu 
 

Command Name Button Functions 

Record 
 

Starts dictation recording and auto voice recognition using 
Dragon NaturallySpeaking. Voice recognition results are 
automatically added from the cursor position in the text display 
area. Dictation recording is also inserted from the location that 
corresponds to cursor location in the text. 

Play/Stop  

 

Restarts dictation recording from the cursor position in the text 
display area. Pressing this button again stops playback. 
During playback, the text that corresponds to the playback 
position is highlighted. 

Home 
 

Returns the cursor to the beginning of the text. 

Rewind 
 

Rewinds a file. 

Fast Forward 
 

Fast-forwards a file. 

End 
 

Moves the cursor to the end of the text. 

Volume 
 

Adjusts output volume. 

 

10.3.5 [Dragon Commands] Menu 
 

Command Name Button Functions 

Show Correction Dialog 
 

Displays the Dragon NaturallySpeaking Correction dialog box. 
Correction suggestions for the text where the cursor is located 
are displayed and can be selected in the text display area, and 
they can be used to correct the voice recognition results. 

Show Spell Dialog 
 

Displays the Dragon NaturallySpeaking Spell dialog box. 

Train Word 
 

Displays the Dragon NaturallySpeaking Train dialog box. 
This is used to teach Dragon NaturallySpeaking particular terms 
in the author's voice (training). This help to improve voice 
recognition accuracy for the trained terms. 

Add New Word 
 

Displays the Dragon NaturallySpeaking Add New Word dialog 
box. 
This can be used by Dragon NaturallySpeaking to learn terms it 
does not know. 

Start Dragon Audio Setup 
Wizard  

Starts up the Dragon NaturallySpeaking Dragon Audio Setup 
Wizard. This allows the Dragon NaturallySpeaking engine to 
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learn the characteristics and other information about the 
microphone device to be used for voice recognition. 

 

10.3.6 [Voice Information] Menu 
 

Command Name Button Functions 

Change Priority  

 

Change the priority of the dictation file. 

Show Information Window 
 

Displays detailed information about a dictation file. 

Show Edit Job Data Dialog 
 

Displays the Edit Job Data dialog box. 

 

10.3.7 [Help] Menu 
 

Command Name Button Functions 

Contents  Opens Help. 
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10.4 Menu List (Voice Recognition Editor/Text Correction) 
This section explains the Voice Recognition Editor menu that is displayed during voice recognition. 

After a dictation file transitions to a status that does not allow further add-on recording, the menus change 

to text correction only menus. Menus that can be used vary depending on the status of the dictation file. 

 
[File] Menu 

[Edit] Menu 

[View] Menu 

[Dictation] Menu 

[Voice Information] Menu 

[Help] Menu 

 

10.4.1 [File] Menu 
 

Command Name Button Functions 

Copy to Clipboard 
 

Copies text files that have text formatting to the clipboard. 
After copying to the clipboard, the text with the text formatting 
can be pasted into MS word or some other application. 

Save 
 

Saves a text file. The file status is unchanged. 

Finished 
 

Saves the text file and changes the file status to 
Transcription.Finished. 
Files are handled as: “dictation recording and text file editing 
complete”, and subsequent text editing is not possible. 

Pending 
 

Saves the text file and changes the file status to 
Transcription.Pending. 
Files are handled as: “text editing temporarily interrupted, but 
will be resumed later”, and text editing can be resumed with the 
Voice Recognition Editor. 

Print 
 

Prints text. 

Print Preview 
 

Displays a text print preview. 

Cancel 
 

Cancels changes and closes the Voice Recognition Editor. 

 

10.4.2 [Edit] Menu 
 

Command Name Button Functions 

Undo 
 

Undoes the last operation. 

Redo 
 

Redoes the last undone operation. 

Cut 
 

Copies the text currently selected in the text display area to the 
clipboard. Executing Cut and then Paste will move the cut text 
to the cursor position. 

Copy 
 

Copies the text currently selected in the text display area to the 
clipboard. 

Paste 
 

Moves text put on the clipboard with Cut or copies text put on 
the clipboard with Copy to the cursor location. 
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Find 
 

Displays a text search dialog box, which searches for the text 
string specified in the text display area. 

 

10.4.3 [View] Menu 
 

Command Name Button Functions 

Toolbar - 
Toggles toolbars between show and hide, specifies the buttons 
displayed in toolbars, etc. 

Status Bar - Toggles the status bar between show and hide. 

 

10.4.4 [Dictation] Menu 
 

Command Name Button Functions 

Play/Stop  

 

Playback the dictation file from the cursor position in the text 
display area. Pressing this button again stops playback. 
During playback, the text that corresponds to the playback 
position is highlighted. 

Home 
 

Returns the cursor to the beginning of the text. 

Rewind 
 

Rewinds a file. 

Fast Forward 
 

Fast-forwards a file. 

End 
 

Moves the cursor to the end of the text. 

Volume 
 

Adjusts output volume. 

Speed 
 

Adjusts the dictation playback speed. 

Tone 
 

Configures the tone, placing an emphasis on the high or low 
pitch area. 

 

10.4.5 [Voice Information] Menu 
 

Command Name Button Functions 

Show Information Window 
 

Displays detailed information about a dictation file. 

 

10.4.6 [Help] Menu 
 

Command Name Button Functions 

Contents  Opens Help. 
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10.5 File Property Lists 
 
This section explains the dictation file and document file properties that are displayed in the Content List 

View. 

 

R/W: Read and Write attributes. The items that have the W attribute are user-editable. 

The Filter column indicates whether or not the filter is set. The Option column shows the option setting for 

filtering. 

 

Displayed Property List (Dictation File List View) 

Displayed Property List (Document List View) 

 

Displayed Property List (Dictation File List View) 

 

The following table lists the properties and their descriptions displayed in the Dictation File List View. 

 

Property Description R/W Filter Option 

Priority Level A numeric value representing the priority 
level, ranging from 0 to 15 

R/W Yes Value 

Priority Priority 
(High/Normal)  

R/W Yes No 

Voice 
Recognition 

Whether or not the dictation File has been 
voice-recognized 

R Yes No 

Instruction 
Comment 

Whether or not the dictation File is 
instruction-commented 

R Yes No 

Encrypted Whether or not the dictation File is 
encrypted 

R Yes No 

Locked Whether or not the dictation File is locked R Yes No 

File Name The name of the dictation File R/W No --- 
Author The Author name R/W Yes No 
Worktype The Worktype name R/W Yes No 
Created The date and time of when the dictation File 

was started 
R Yes Date 

Completed The date and time of when the dictation File 
was finished 

R Yes Date 

Downloaded The date and time of when the dictation File 
was downloaded 

R Yes Date 

Deletion Date The date and time of when the dictation File 
was deleted 

R Yes Date 

Backed up Date The date and time of when the dictation File 
was backed up 

R Yes Date 

Transcriptionist The name of the Transcriptionist R Yes No 
Transcription 
Started 

The date and time of when a transcription 
was started 

R Yes Date 

Transcription 
Completed 

The date and time of when a transcription 
was finished 

R Yes Date 
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Process/Status The Process/Status of the dictation File 

：Process Recording 

：Process Transcription 

：Process Voice Recognition 

：Process Export 

：Process Archive 

R/W Yes No 

Duration The recording time length of the dictation 
File (HH:MM:SS) 

R Yes Value 

File Size The size of the dictation File (KB) R No --- 
Option Item 1 The content of Option Item 1 R/W Yes No 
Option Item 2 The content of Option Item 2 R/W Yes No 
Option Item 3 The content of Option Item 3 R/W Yes No 
Option Item 4 The content of Option Item 4 R/W Yes No 
Option Item 5 The content of Option Item 5 R/W Yes No 
Option Item 6 The content of Option Item 6 R/W Yes No 
Option Item 7 The content of Option Item 7 R/W Yes No 
Option Item 8 The content of Option Item 8 R/W Yes No 
Option Item 9 The content of Option Item 9 R/W Yes No 
Option Item 10 The content of Option Item 10 R/W Yes No 
Comment Comments for a dictation file R/W Yes No 
Document The name of a document file linked with the 

dictation File 
R No --- 

File Format The extension of the dictation File R Yes No 
Audio Format The format of the dictation File R Yes No 
Original Location The folder in which the dictation File was 

originally stored 
R Yes No 

Receiver The receiver of the dictation File R Yes No 
Sent Date The date and time of when the dictation File 

was sent 
R Yes Date 

Location The location of where the dictation File is 
stored (full path) 

R No --- 

DSS License The name of the vendor that supplies the 
codec for the dictation File 

R Yes No 
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Displayed Property List (Document List View) 

 

The following table lists the properties and their descriptions displayed in the Document List View. 

 

Property Description 

Priority Level A numeric value representing the priority level, 
ranging from 0 to 15 

Priority Priority (High/Normal)  

Voice Recognition Whether or not the associated dictation file has 
been voice-recognized 

Instruction Comment Whether or not the associated dictation file is 
instruction-commented 

Encrypted Whether or not the document file is encrypted 

Locked Whether or not the document file is locked 

File Name The name of the document file 
Author The Author name 
Worktype The Worktype name 
Transcriptionist The name of the Transcriptionist 
Transcription Started The date and time of when a transcription was 

started 
Transcription Completed The date and time of when a transcription was 

finished 
Process/Status The Process/Status of the dictation File 

：Process Recording 

：Process Transcription 

：Process Voice Recognition 

：Process Export 

：Process Archive 
Option Item 1 The content of Option Item 1 
Option Item 2 The content of Option Item 2 
Option Item 3 The content of Option Item 3 
Option Item 4 The content of Option Item 4 
Option Item 5 The content of Option Item 5 
Option Item 6 The content of Option Item 6 
Option Item 7 The content of Option Item 7 
Option Item 8 The content of Option Item 8 
Option Item 9 The content of Option Item 9 
Option Item 10 The content of Option Item 10 
File Format The extension of the document file 
File Size The size of the document file (KB) 
Dictation The name of the associated Dictation file 
Sender The sender of the document file 
Received Date The date and time of when the document file 

was received 
Location The location of where the document file is stored 

(full path) 
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10.6 Default Key Assignments 
 
This section lists the initial default key assignments. 

 

Default Key Assignments 

 

Default Key Assignments 

 
Playback Control Key Assignments 

Direct Recording Key Assignments 

General Key Assignments 

Key Assignments for Voice Recognition 

Function Assignments for Programmable Buttons 

 

Playback Control Key Assignments 

 

Command Default Key 

Play/Stop F9 
Stop - 
Fast-forward F8 
Rewind F7 
Next Index Mark Ctrl+Right 
Previous Index Mark Ctrl+Left 
Next Verbal Comment Ctrl+Shift+Right 
Previous Verbal Comment Ctrl+Shift+Left 
Jump to Top - 
Jump to End - 
Volume Up Ctrl+Up 
Volume Down Ctrl+Down 
Speed Up Ctrl+Shift+Up 
Speed Down Ctrl+Shift+Down 
Tone Up Ctrl+Alt+Up 
Tone Down Ctrl+Alt+Down 
Noise Cancellation Level*1 - 
Insert Index Mark Ctrl+Alt+I 
Delete Index Mark - 
Dictation/Instruction Comment Mode F10 

*1: Each command execution cyclically switches levels in the order of Off, 1, 2, 3, and then back to Off 

again. 

 

Direct Recording Key Assignments 

 

Command Default Key 

Record Ctrl+Alt+F1 
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Record Verbal Comment Ctrl+Alt+F2 
Switch between High and Normal priority Ctrl+Alt+F3 
Switch between Conference and Dictation Ctrl+Alt+F4 
Switch between Insert and Overwrite mode Ctrl+Alt+F5 
Pending Dictation Ctrl+Alt+F6 
Finish Dictation Ctrl+Alt+F7 
Change Saving Folder*2 Ctrl+Alt+F8 
Send / Don’t Send Finished Dictation*3 Ctrl+Alt+F9 
Delete Instruction Comment Ctrl+Alt+D 
Undo Ctrl+Alt+Z 
Redo Ctrl+Alt+Y 

*2: Finishing a dictation displays the Save As dialog box. With this dialog box, you can specify the file 

name, change the saving destination, and select whether or not to automatically send the file. 

This command is for changing the save destination. Each execution of this command changes the 

save destination to the next folder. 

*3: Finishing a dictation displays the [Save As] dialog box. With this dialog box, you can specify the 

file name, change the saving destination, and select whether or not to automatically send the file. 

Each execution of this command toggles between auto send and do not set. 

 

General Key Assignments 

 

Command Default Key 

New Dictation Ctrl+N 
Edit Dictation Ctrl+O 
Start Voice Recognition Ctrl+R 
Property View  
Hotkeys On/Off F11 
Download All Ctrl+Shift+M 
Show List Search Dialog Ctrl+F 

 

Key Assignments for Voice Recognition 

Command Default Key 

Send For Correction Ctrl+Shift+F1 
Show Correction Dialog Ctrl+Shift+F2 
Show Spell Dialog Ctrl+Shift+F3 
Train Word Ctrl+Shift+F4 
Add New Word Ctrl+Shift+F5 
Start Dragon Audio Setup Wizard Ctrl+Shift+F6 
Copy to Clipboard Ctrl+Shift+C 

 

Function Assignments for Programmable Buttons 

 
Programmable Button Windows Standard DSS Player Pro 

[F1] Display Help Display Help 
[F2] Edit Item Edit Item 
[F3] Search --- 
[F4]   
[Ctrl]+[F4] Close Window  
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[Alt]+[F4] Exit Application Exit Application 
[F5] Refresh Window Refresh Window 
[F6]  Move Pane 
[F7]  Rewind 
[F8]  Fast-forward 
[F9]  Play/Stop 
[F10]  Switch Dictation/Instruction Comment Mode 
[Shift]+[F10] Show Context Menu Show Context Menu 
[F11]  Hotkey On/Off 
[F12]   
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10.7 Names and Functions of the Option Settings Dialog 
Boxes Components 
 

This section describes the names and functions of the components comprising the Option Settings dialog 

boxes, which are used for configuring various options. 

 
Advanced Settings (IMAP) Dialog Box 

Advanced Settings (POP/SMTP) Dialog Box 

Author Property Dialog Box 

Browse For Folder Dialog Box 

Cleaning Settings Dialog Box 

Configure Notification dialog box 

Convert Dictation Settings Dialog Box 

Decryption Password Dialog Box 

Device Select Dialog Box 

Edit Job Data Dialog Box 

Encryption Password Dialog Box 

E-mail Settings (GroupWise) Dialog Box 

E-mail Settings (IMAP) Dialog Box 

E-mail Settings (Lotus Notes) Dialog Box 

E-mail Settings (POP/SMTP) Dialog Box 

E-mail Settings (Select) Dialog Box 

Format Options Dialog Box 

Folder Design Dialog Box 

FTP Settings Dialog Box 

Notification Window 

Option Item Property Dialog Box 

Purge Settings Dialog Box 

Recording Format Settings Dialog Box 

Rule Settings Dialog Box 

Routing Settings Dialog Box 

Set E-mail Destinations Dialog Box 

Set FTP Destinations Dialog Box 

Supported Document Type Dialog Box 

Worktype Property Dialog Box 

 

Advanced Settings (IMAP) Dialog Box 
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Specify the settings and click [OK]. 

Advanced Settings (POP/SMTP) Dialog Box 

 
 
Specify the settings and click [OK]. 
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Author Property Dialog Box 

 

 

 

Configure the Author ID and Priority Level, and then click [OK]. 

 

Browse For Folder Dialog Box 

 

 

 
Select a folder and click [OK]. 

 

Cleaning Settings Dialog Box 
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Enable Cleaning, specify the retention period, and click [OK]. 

 

Configure Notification dialog box 

 

  

 

x “Select Items” 

Enable items in pop-ups. 

Priority level (Always enabled) 

File name (Always enabled) 

Author ID (Default: Enabled) 
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Work type ID (Default: Disabled) 

Folder (Default: Enabled) 

Received (Default: Enabled) 

Sender (Default: Disabled) 

Option item 1 to 10 (Default: Disabled) 

Comment (Default: Disabled) 

Automatic closing 

To change the order items are displayed, select an item, and then click the [Up] or [Down] button. 

Click [Reset] to return to the defaults. 

x “Automatic Closing” 

Enabling “Close the notification window automatically” allows you to set how long notification 

windows are open before they close automatically. 

The length of time that the window is displayed is set in a range from 3 to 30 seconds in “Automatic 

closing time given in seconds”. (Default: 10 seconds) 

 

Convert Dictation Settings Dialog Box 

 

 

 

Specify the settings and click [OK]. 

 

Decryption Password Dialog Box 
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Enter the password then click [OK]. 

 

Device Select Dialog Box 

 

When the device menu is selected with multiple devices connected, this dialog box appears. 

 

 

 

Specify a device or device folder, and click [OK]. 

 

Edit Job Data Dialog Box 
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Specify the settings and click [OK]. 

 

Encryption Password Dialog Box 

 

x Dictation Files and Dictation File Folders 

 
x Document Files and Document File Folders 

 

 

Enter a password in the New Password and Confirm Password fields and click [OK]. 

 
If a dictation file or a dictation file folder has an encryption password configured, settings can be configured 

to specify the encryption strength (password length). 

x The “Standard” setting encrypts using a 128-bit key. The “High” setting encrypts using a 256-bit key. 

x The encryption strength setting is reflected only for files recorded in DSS Pro format. This setting is 
not applied to the encryption of file recorded in DSS Classic format, WAV/WMA format, or any other 
non-DSS Pro recording format. 

x The encryption strength cannot be specified in the case of an encryption password setting configured 
for a document file or document file folder. 

x The password is the same in Standard mode and High mode. An encryption key, suitable for the 
specified encryption mode, is generated from the password, with a key length that is in accordance 
with the encryption mode set within the program. 

E-mail Settings (GroupWise) Dialog Box 
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Specify the settings and click [Finish]. 

 

E-mail Settings (IMAP) Dialog Box 

 

 
 

x Pressing [Test settings] initiates a test to determine whether or not an email can successfully be 

sent and received with the current settings in the dialog box, and then displays the results. 

x To configure advanced settings, use the Advanced Settings (IMAP) dialog box, which is displayed 

by clicking [Advanced Settings]. 

x Specify the settings and click [Finish]. 
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E-mail Settings (Lotus Notes) Dialog Box 

 

 
 

Specify the settings and click [Finish]. 

 

E-mail Settings (POP/SMTP) Dialog Box 

 

 
 

x To configure advanced settings, use the Advanced Settings (POP/SMTP) dialog box, which is 

displayed by clicking [Advanced Settings]. 

x Pressing [Test settings] initiates a test to determine whether or not a file can successfully be 

uploaded and downloaded with the current settings in the dialog box, and then displays the results. 
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x Specify the settings and click [Finish]. 

 

E-mail Settings (Select) Dialog Box 

 

 

 

x Select an email transmission/reception protocol for registration and click [Next]. 

 The E-mail Settings dialog box for the selected protocol will appear. 

 

Format Options Dialog Box 
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x By selecting the checkbox of an item, its setting is applied to the file name. Note that [File Name] 

is a required item. 

x To change the order of items, select an item and use the [Up] and [Down] buttons to change its 

position. 

x Setting a separator inserts it between selected items. 

The separator is selected from a drop-down list. 

[none] 

 [space] 

 - [hyphen] 

 . [period] 

 _ [underscore] (Default) 

x [Preview] displays the format of a file name resulting from renaming. 

 

Folder Design Dialog Box 

 

This dialog box is used to configure folder-related settings. 
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Category Bar 
Selects the category of the profile. The currently selected category is highlighted. 
The setting information included in the profile falls into the following categories. 

 
Folder Tree 
Configures the folders in the Dictation tray and Document tray.  
Turning the checkbox on or off enables or disables the corresponding folder. 

 
Folder Properties 
Displays the properties of the folder selected from the folder tree. 
Properties are configured for each folder. 
Configurable properties vary depending on the folder type. 

: Sorts properties by category 

: Lists the properties in alphabetical order 

 
Create Folder Buttons 
[New]: Creates a new folder. 
[Add]: Adds a specified external folder path as a custom folder to the Dictation Tree View 
[Remove]: Removes a shortcut folder previously created with [Add] 

 
[OK]: Secures the settings 
[Cancel]: Exits without modifying the settings 
[Apply]: Reflects changes to the configuration file 

 

 

FTP Settings Dialog Box 
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x Pressing [Test settings] initiates a test to determine whether or not a file can successfully be 

uploaded and downloaded with the current settings in the dialog box, and then displays the results. 

x Specify the settings and click [Finish]. 
 

Notification Window 

 

Notification Window (Default) 

 

 

 

x Clicking the [Details>>] button will display the Notification Window (detailed display). 

 

Notification Window (Detailed display) 

 



241 / 253 

 

 

x Click the [Details<<] button to return to the default display. 

x Click  to close the dialog box. 

 

Option Item Property Dialog Box 

 

This dialog box is used to configure an Option Item. 

 

 

x For the “Label”, any string can be entered using up to 16 characters. 

x The “Default value” will be used as the initial value for options which appears in the dialog boxes, 

such as “Edit Job Data”, when the “Initial Value” is set to “Default”.  

x The “Default value” can be set in the range specified in “Starting/ending decimal place value of bar 

code scanning”. 

x For the “Initial Value”, the initial value type of the label when making a recording with a recorder 

is selected by default. 
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Default: Uses the specified default value. 

Blank: The initial value has not been set.  

Last input value：Uses the last value input by the user as the [Initial Value] for the next recording. 

x For the “Starting/ending decimal place value of bar code scanning”, the string range extracted 

from scanned data is specified with the starting and ending digits. 

 
Limitations on the Label 

When using the DSS recording format, only up to eight characters in a 
registered Label name string can be used. Subsequent characters are not 
recorded in a file. 

Purge Settings Dialog Box 

 

 

 

Specify the settings and click [OK]. 

 

Recording Format Settings Dialog Box 

 

 

 

x Select the recording format from the “Format” drop-down list. 

x Select the bit rate and stereo/monaural settings for a specified recording format from the 

“Attributes” drop-down list. 
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Rule Settings Dialog Box 

 

 

x Configure the Author ID/Worktype ID and destination folder of a dictation file, and then click [OK]. 

Routing Settings Dialog Box 

 

 

 

Enter items and then click [OK]. 

 

Dictation Sender 

Specify the E-mail address or FTP profile of a sender for routing dictations.  
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Select E-mail or FTP in Protocol, and then specify the E-mail addresses or FTP profiles using [Address book] 

in Sender. This setting cannot be registered unless an E-mail profile or FTP profile is first configured with the 

Option Settings dialog box. 

Destination for Dictation 

 Specify the folders used for routing dictations by clicking . 

Automatic Document Creation and Sending 

When “Use automatic document creation and sending function” is enabled, starting up the Transcription will 

automatically create a document, and exiting the Transcription will automatically cause the document to be 

sent to the specified addressee. The document is created in accordance with the “Open word processor” 

setting on the [Transcription] tab. 

Set E-mail Destinations Dialog Box 

 

 

 

x Click [To], [CC], and/or [BCC] to specify the addresses. 

x Type in a title and body in the “Subject” and “Message” boxes, respectively. 

 

Specify the settings and click [OK]. 

 

Set FTP Destinations Dialog Box 
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Specify the settings and click [OK]. 

 
 

Supported Document Type Dialog Box 

 

 
 

x To register an extension, type it in the Supported document extension box and click [Add]. 

x To delete an extension, select it from the Supported document list and click [Remove]. 

x When the configuration has been completed, click [OK]. 

 

Worktype Property Dialog Box 

 

This dialog box is used to configure Worktype ID, Option Items, and the bar code input option. 
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Option Item 

Worktype ID and Option Items are configured. 

Worktype ID can be entered using up to 16 characters. 

Up to 10 Option Items can be registered. 

x To add an Option Item, configure it in the Option Item Property dialog box, which is displayed by 

clicking [Add]. To enable an Option Item when making a recording on the recorder side, select the 

checkbox of its Label. 

x To modify an Option Item, select its Label and click [Modify]. Then, make changes to the Option 

Item in the Option Item Property dialog box. 

x To delete an Option Item, select its Label and click [Remove]. 

x To change the order of Option Items, select a Label and use the [Up] and [Down] buttons to 

change the item's position. 

 

 

Limitations on Option Items 
 When creating a dictation file, up to 10 Option Items are registered 

using the DS2 recording format, while only three of them are 
registered using the DSS recording format. 

 

Bar Code Input Option 

This option configures the input method when using bar codes to input values to the Option Items registered 
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in the Option Item list. 

x With the bar code input option set to [Batch scanning] in the Worktype Property dialog box, one 

bar code scanning fills multiple Option Items with data. The starting and ending digits for scanning can 

be set in the Option Item Property dialog box. 

x With the bar code input option set to [lndividual scanning], one bar code scanning fills a single 

Option Item with data. If multiple Option Items have been registered, lndividual bar code scannings 

sequentially fill the Option Items with scanned data. 

Description 

The description of the Worktype is registered. Up to 100 characters can be entered. 

 



248 / 253 

1111  Support Contacts 
 
 

For Purchasing License Keys 

To purchase the following license keys, please contact your dealer or distributor. 

 

x Dictation Module multi-license key 

x Transcription Module multi-license key 
 

Asking about Malfunctions 

When submitting a query, the information below needs to be provided to our support staff along with the 

details of your problem. Please keep the following data handy: 

x Type of PC (manufacturer and model) 

x Amount of memory 

x Hard disk space 

x Name and version of the OS 

x Connected peripheral devices 
 

For assistance in solving a problem such as a malfunction, please contact your dealer or distributor. 

 

Other Support 

Various types of information, including product specifications, PC connections, support for OSes, and FAQs, 

are available on our Web site. For the latest information, please visit the Olympus Web site at 

http://www.olympus-global.com/en/global/ 

 

 
These descriptions are subject to change. 

 
 

http://www.olympus-global.com/en/global/
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1122  Glossary 
 

Backup 
After a folder's backup settings are configured, any file saved in the folder will be automatically 
backed up to the other specified folder. 

Citrix XenApp/XenDesktop 
Product name of a client/server system that is called a virtual environment enabling operation 
of applications running on a server or of the server PC desktop itself from a remote client PC on 
the network. Diverse client operating systems are supported, including Windows, Macintosh, 
Linux, etc. A Windows server can also be remotely operated from a smartphone or other 
portable device is Citrix client software supports. 

Clean 
A folder attribute and a way to delete files. Old dictation files can be deleted through one of two 
methods: by directly deleting them or by moving them to7 the Recycle Box and then deleting 
them with the delete option. Setting the Clean attribute enables automatic clean-up of old 
dictation files. 

Composite Mode 
Mode that simultaneously runs multiple standard USB classes when a recorder is connected to 
a PC. Supported USB classes depend on the model. With the DS-7000/3500, three classes 
(Audio, HID, Storage) are operated simultaneously. Audio class supports function as a PC 
microphone and/or speaker, HID class supports button operations, and Storage class supports 
operation as a removable disk. Leaving the device USB connection mode set in Composite mode 
enables smooth operation of Dictation Module and Transcription module functions. 

Direct Record 
A recording method that enables connection of a microphone device to a PC and recording of 
dictation data directly to the PC. Dictation can be directly recorded to a PC using an Olympus 
Directrec Series or other specialized direct record device, or a recorder microphone connect to 
the PC USB port. 

DRM 
This stands for Digital Rights Management. It is a general term for the technologies that protect 
the copyrights of digitally created contents, and regulate the use and replication of them.  

DSS 
This stands for Digital Speech Standard. 

This voice encoding standard has been developed by Olympus and two other companies. It can 
downsize audio data while maintaining sound quality. All of Olympus recorder models support 
DSS. DSS-compliant dictation files have the "DSS" extension. 

DSS Pro 
An audio standard enhanced from the classic DSS. 

Key differences from the DSS standard include QP (Quality Play) mode for high-grade recording, 
an increase from 16 to 32 in the number of settable index marks, support for dictation File 
encryption, and support for verbal comment recording. DSS-compliant dictation files have the 
"DS2" extension. 
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FTP 
This stands for File Transfer Protocol. This is a protocol used for transferring a file over the 
TCP/IP network. 

Hot Key 
A function that allows an application or button operation on the device to be assigned to a key 
on the keyboard and to be executed simply by pressing that key. It can be customized and 
enables the user to work more efficiently by registering frequently used functions. 

HTTPS 
A protocol that integrates SSL (Secure Sockets Layer) encrypted communication into HTTP. 

Instruction Comment 
An Instruction Comment is an instruction or other message recorded for a Transcriptionist. It 
can be recorded only with Direct Record and cannot be created when making a recording with 
a stand-alone recorder. It is maintained as a file separately from a dictation file and is recorded 
to provide a Transcriptionist with instructions. 

Job Data 
A general term to refer to the Author ID, worktype, option item, comment, or other data that 
can be specified for a dictation file by the Dictation Module or Transcription Module. 

Such specified data items serve as keys for dictation file management, classification, and other 
management. 

Noise Cancellation 
An operation that reduces noise output by extracting and filtering out noise components from a 
dictation file. The cancellation effect can be adjusted to three different levels. 

MP3 
An MPEG-1-based audio compression method. Like other major audio compression techniques, 
it uses a lossy compression method that achieves a high compression rate by deducting less 
audible portions from sound data. Dictation Module/Transcription Module supports it only for 
playback. The file extension is .MP3. 

MSI Package 
A Windows Installer-compliant package for installation. 

OLE 
When dragging and dropping a dictation file onto a document file, it can be configured to be an 
embedded object or a linked object. 

Embedding causes audio data to be stored as-is, which results in a large volume of data. 
However, even if the stored data is ported to another PC, it can be played back on the 
destination PC as long as the PC has a player installed that can play back the applicable audio 
format. In the case of a link, only the file name and path of the audio file is stored which means 
a smaller volume of data, but playback cannot be performed if the document file is ported to a 
location from which the audio data embedded in the file cannot be accessed. 

Option Item 
An item associated with a Worktype. Up to 10 items can be registered with combinations of 
values. 

Option Items can be input with such tools as Baltech Transponder and a bar code reader. 
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Ownership 
An attribute that, based on Author privileges, prevents a dictation file from moving to the 
Finished folder in Transcription Module after the file has been transcribed. With this attribute 
configured, the file is not moved to the Finished folder in Transcription Module the moment 
transcription has been completed. 

Priority Level 
This is represented by the 16 priority levels of 0 to 15, and allows the user to prioritize 
dictations. 

Proxy 
This is a boundary that separates an internal network from the external Internet. It is a 
computer or software that connects to the Internet on behalf of an internal computer that 
cannot directly access the external network. A proxy centrally controls the access traffic 
between the Internet and the internal network, and blocks unauthorized accesses. 

Repository 
A shared location for storing shared data under management by the System Configuration 
Program. The Olympus Dictation Management System allows selection of two repository types: 
a shared-folder configuration and a service program configuration. Internally, a repository 
stores each user's and group's profile (application setup information), the software and device 
firmware update programs, etc. 

Standalone System 
The basic system of Olympus Dictation Management System. It represents a system 
environment in which Dictation Module and Transcription Module run on local PCs, and 
management tools such as System Configuration Program are not used. 

Storage Mode 
An operating mode that causes recorder built-in memory or a memory card to be recognized as 
a removable drive when the recorder is connected to a PC. Normal removable disk operations 
are supported, the same as with USB memory and other types of removable memory. 
However, the recorder cannot be used as a PC microphone or speaker when it is connected in 
Storage Mode. When using the recorder for direct recording, you need to switch to Audio mode, 
Composite, mode, or some other operating mode in which the normal USB Audio class is 
supported. 

Terminal Service 
This is a client service provided by Windows Server. It can execute applications and services 
provided by the server on the client side. A separate license such as TS-CAL is required to use 
this function. 

VCVA 
A capability that enables sound-initiated recording (called Variable Control Voice Actuator) in 
order to improve usability and efficiency for prolonged recording. It halts recording after a 
certain period of silence and resumes it in response to sound. The sound level to initiate 
recording can be adjusted. Level settings optimized for different recording environments ensure 
efficient recording. For recording intended for voice recognition, it is recommended to disable 
the VCVA function. 

Verbal Comment 
A voice comment that is embedded in dictation File data. A verbal comment can be recorded 
with a supported recorder. It is provided to transcribe audio data immediately after commentary. 
A verbal comment is recorded at any position in a dictation file based on the need for 
instructions. 
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WAV 
A standard dictation File format for Windows. It is also referred to as the WAVE format. The 
specifications include the saving format for recording a digitally converted audio signal. The file 
extension is .WAV. 

WMA 
A standard audio format for Windows. This technology is a component of Windows Media, a 
multimedia technology incorporated in Windows, and is a standard audio compression 
technique. The file extension is .WMA. 

Workgroup System 
It is one of the operating modes in ODMS which operates DM/TM remotely from some 
administration software.  The System Configuration Program can be used for remote Dictation 
Module/Transcription Module setting configuration and updating. License Manager can be used 
for central management of multiple user licenses. 

Worktype 
This is the data used to classify dictations. The user can classify the types and Authors of 
dictations with the application by selecting a Worktype on the recorder when making a new 
recording. 

Using Option Items associated with a Worktype, additional attributes can be provided. 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Copyright© 2008-2013 OLYMPUS IMAGING CORP. 


	1 Introduction
	1.1  Olympus Dictation Management System Outline
	1.1.1  System Configurations of ODMS R6
	1.1.2  Modules and Tools

	1.2  Licenses
	1.3  Devices Connectable to Dictation Module
	1.4  Supported File Formats
	1.5  Dictation Module Capabilities

	2 Fundamentals of Olympus Dictation Management System
	2.1  Dictation File Name and Author ID
	2.2  Process and Status
	2.3  How Folders Work
	2.3.1  Folder Descriptions
	2.3.2  Folder Functions

	2.4  Worktypes and Option Items
	2.5  Direct Recording
	2.6  Ownership Attribute
	2.7  Local Mode and Network Mode
	2.8  Clean
	2.9  Voice Comments
	2.10  Storage Mode and Composite Mode
	2.11  Backing Up
	2.12  Debugging Option

	3 Basic Operations
	3.1  Starting and Exiting Dictation Module
	3.2  Downloading a Dictation File
	3.2.1  Downloading All Files
	3.2.2  Downloading Files into a Specified Folder
	3.2.3  Downloading Specified Files

	3.3  Importing a File
	3.4  Copying or Moving a Dictation File
	3.4.1  Copying a File in the Dictation Tree View
	3.4.2  Moving a File in the Dictation Tree View
	3.4.3  Copying a File to a Specified Location
	3.4.4  Uploading a Dictation File to the Device
	3.4.5  Exporting a File

	3.5  Playing a Dictation File
	3.5.1  Starting and Stopping Playback
	3.5.2  Shifting the Playback Position
	3.5.3  Adjusting Playback Conditions
	3.5.4  Intro-Scanning

	3.6  Creating a Dictation File
	3.6.1  Making a New Recording
	3.6.2  Adding a Recording to a File
	3.6.3  Partially Deleting a File
	3.6.4  Inserting an Index Mark
	3.6.5  Exiting the Recording Window

	3.7  Editing a Dictation File
	3.7.1  Converting the File Format
	Format and Attributes of the Resulting File

	3.7.2  Splitting a Dictation File into Two Files
	3.7.3  Joining Multiple Dictation Files into One
	3.7.4  Recording a Verbal Comment
	3.7.5  Recording an Instruction Comment
	3.7.6  Changing the Status of a Dictation File

	3.8  Sending a Dictation File via E-mail
	3.8.1  Automatic Transmission via E-mail
	3.8.2  Manual Transmission via E-mail
	3.8.3  Registering an E-mail Address

	3.9  Sending a Dictation File via FTP
	3.9.1  Automatic Transmission via FTP
	3.9.2  Manual Transmission via FTP

	3.10  Managing Document Files
	3.10.1  Adding a Managed Document File Type
	3.10.2  Associating a Document File with a Dictation File
	3.10.3  Dissociating a Document File from a Dictation File

	3.11  Receiving a Document File via E-mail
	3.11.1  Automatic Reception via E-mail
	3.11.2  Manual Reception via E-mail

	3.12  Receiving a Document File via FTP
	3.12.1  Automatic Reception via FTP
	3.12.2  Manual Reception via FTP

	3.13  Voice Recognition
	3.13.1  Getting Ready for Voice Recognition
	3.13.2  Settings to Share Adaptations
	3.13.3  Performing Real-time Voice Recognition
	3.13.4  Performing Background Voice Recognition
	3.13.5  Correcting Voice Recognition Results (Corrected by Voice Recognition Editor)
	3.13.6  Correcting Voice Recognition Results (Corrected by Transcriptionist)
	3.13.7  Correction Feedback


	4 Managing Files and Folders
	4.1  Editing a Folder in the Dictation Tray
	4.1.1  Creating a Folder
	4.1.2  Mounting a Folder
	4.1.3  Removing a Folder
	4.1.4  Renaming a Folder

	4.2  Editing the Properties of Audio and Document Files
	4.2.1  Editing in the Properties View
	4.2.2  In-line Editing
	4.2.3  Editing with the Job Data Dialog Box

	4.3  Backing Up a Downloaded Dictation File
	4.4  Encrypting and Decrypting a Dictation File
	4.4.1  Encrypting per File
	4.4.2  Encrypting per Folder
	4.4.3  Decrypting a File

	4.5  Sorting Dictation Files
	4.5.1  Configuring Automatic Sorting of Downloaded Files
	4.5.2  Registering the Author List with the Recorder
	4.5.3  Registering the Worktype ID with the Recorder

	4.6  Sharing a Dictation File with Transcriptionists
	4.7  Automatically Deleting Transcribed Dictation Files
	4.8  Searching for Dictation Files and Document Files
	4.8.1  Simple File Name Search
	4.8.2  Column Item Search


	5 Customizing Dictation Module
	5.1  Customizing the Work Area
	5.2  Customizing the Content List View
	5.2.1  Interchanging Displayed Columns
	5.2.2  Sorting Displayed Files
	5.2.3  Changing the Columns Displayed in the Content List View
	5.2.4  Filtering Displayed Files

	5.3  Assigning Hot Keys

	6 Configuring with the Device Connected
	6.1  Switching the Device Mode
	6.2  Using the Device as a USB Speaker / Microphone
	6.3  Transferring the Date and Time

	7 Configuring and Customizing the Device
	7.1  Configuring for a Connected Device
	7.2  Configuring for a Selected Device Model

	8 Option Settings on Operating Conditions
	8.1  Folder Design
	8.1.1  Folder Properties
	8.1.2  Attributes
	8.1.3  Actions

	8.2  Workflow
	8.2.1  General
	8.2.2  Download
	8.2.3  Advanced Download
	8.2.4  Import
	8.2.5  Author
	8.2.6  Worktype
	8.2.7  Direct Recording
	8.2.8  Hands Free Recording
	8.2.9  Voice recognition - General
	8.2.10  Voice recognition – Real-time Voice Recognition
	8.2.11  Voice recognition – Background Voice Recognition
	8.2.12  Voice recognition – Text Correction
	8.2.13  Voice recognition – Template
	8.2.14  Voice recognition – Dragon NaturallySpeaking
	8.2.15  Receive
	8.2.16  Notification
	8.2.17  Routing
	8.2.18  Auto Collection
	8.2.19  Logging

	8.3  User Settings
	8.3.1  General
	8.3.2  Keyboard
	8.3.3  Playback Control

	8.4  E-mail / FTP
	8.4.1  E-mail
	8.4.2  FTP
	8.4.3  Send / Receive
	8.4.4  Proxy

	8.5  Device
	8.5.1  Devices with Device Configuration Support
	8.5.2  Device Settings for DS-7000/3500
	8.5.3  DS-5000/5000iD/3400 Device Configuration
	8.5.4  DR-2300/2200/2100/1200 Device Configuration

	8.6  Updates

	9 Troubleshooting
	9.1  The Dictation Module Does Not Start Up
	9.2  Cannot Perform Direct Recording Window Operations with Directrec
	9.3  The System Remains Silent
	9.4  DVR Is Not Recognized
	9.5  Collecting Information with Log Tool
	9.6  Updating
	9.7  Changing a Workgroup environment

	10 Appendix
	10.1  Names and Functions of Window Components
	Main Window
	Playback Control Window 
	Direct Recording Window 
	Voice Recognition Editor
	Dictation Tree View (Main Window)
	Device Tree View (Main Window)
	Content List View (Main Window)
	Information View (Main Window)
	Properties View (Main Window)

	10.2  Menu Lists (Main Window)
	10.2.1  [File] Menu
	10.2.2  [Folder] Menu
	10.2.3  [Edit] Menu
	10.2.4  [View] Menu
	10.2.5  [Play] Menu
	10.2.6  [Tool] Menu
	10.2.7  [Device] Menu
	10.2.8  [Voice Recognition] Menu
	10.2.9  [Workgroup] Menu
	10.2.10  [Help] Menu

	10.3  Menu List (Voice Recognition Editor/Real-time Voice Recognition)
	10.3.1  [File] Menu
	10.3.2  [Edit] Menu
	10.3.3  [View] Menu
	10.3.4  [Dictation] Menu
	10.3.5  [Dragon Commands] Menu
	10.3.6  [Voice Information] Menu
	10.3.7  [Help] Menu

	10.4  Menu List (Voice Recognition Editor/Text Correction)
	10.4.1  [File] Menu
	10.4.2  [Edit] Menu
	10.4.3  [View] Menu
	10.4.4  [Dictation] Menu
	10.4.5  [Voice Information] Menu
	10.4.6  [Help] Menu

	10.5  File Property Lists
	Displayed Property List (Dictation File List View)
	Displayed Property List (Document List View)

	10.6  Default Key Assignments
	Default Key Assignments

	10.7  Names and Functions of the Option Settings Dialog Boxes Components
	Advanced Settings (IMAP) Dialog Box
	Advanced Settings (POP/SMTP) Dialog Box
	Author Property Dialog Box
	Browse For Folder Dialog Box
	Cleaning Settings Dialog Box
	Configure Notification dialog box
	Convert Dictation Settings Dialog Box
	Decryption Password Dialog Box
	Device Select Dialog Box
	Edit Job Data Dialog Box
	Encryption Password Dialog Box
	E-mail Settings (GroupWise) Dialog Box
	E-mail Settings (IMAP) Dialog Box
	E-mail Settings (Lotus Notes) Dialog Box
	E-mail Settings (POP/SMTP) Dialog Box
	E-mail Settings (Select) Dialog Box
	Format Options Dialog Box
	Folder Design Dialog Box
	FTP Settings Dialog Box
	Notification Window
	Option Item Property Dialog Box
	Purge Settings Dialog Box
	Recording Format Settings Dialog Box
	Rule Settings Dialog Box
	Routing Settings Dialog Box
	Set E-mail Destinations Dialog Box
	Set FTP Destinations Dialog Box
	Supported Document Type Dialog Box
	Worktype Property Dialog Box


	11 Support Contacts
	12 Glossary
	Backup
	Citrix XenApp/XenDesktop
	Clean
	Composite Mode
	Direct Record
	DRM
	DSS
	DSS Pro
	FTP
	Hot Key
	HTTPS
	Instruction Comment
	Job Data
	Noise Cancellation
	MP3
	MSI Package
	OLE
	Option Item
	Ownership
	Priority Level
	Proxy
	Repository
	Standalone System
	Storage Mode
	Terminal Service
	VCVA
	Verbal Comment
	WAV
	WMA
	Workgroup System
	Worktype


